Getting Started with Ubuntu 11.10






74ANN
& ‘e ] D

A\ /4

Getting Started with Ubuntu 11.10

The Ubuntu Manual Team






Copyright © 2010-2012 by The Ubuntu Manual Team. Some rights reserved.

GlOC)

This work is licensed under the Creative Commons Attribution-Share
Alike 3.0 License. To view a copy of this license, see Appendix A, visit
http://creativecommons.org/licenses/by-sa/3.0/, or send a letter to Creative
Commons, 171 Second Street, Suite 300, San Francisco, California, 94105,
USA.

Getting Started with Ubuntu 11.10 can be downloaded for free from http://
ubuntu-manual.org/. We permit and even encourage you to distribute a
copy of this book to colleagues, friends, family, and anyone else who might
be interested.

http://ubuntu-manual.org

Revision number: 177 Revision date: 2012-03-23 09:00:44 +0100


http://creativecommons.org/licenses/by-sa/3.0/
http://ubuntu-manual.org/
http://ubuntu-manual.org/
http://ubuntu-manual.org




Contents

Prologue 7
Welcome 7
Ubuntu Philosophy 7
A brief history of Ubuntu 8
Is Ubuntu right for you? 9
Contact details 10
About the team 10
Conventions used in this book 10

1 Installation 11
Getting Ubuntu 11
The Live CD/USB stick 12
Installing Ubuntu 13
Ubuntu installer for Windows 20

2 The Ubuntu Desktop 21
Understanding the Ubuntu desktop 21
Unity 21
The Dash 23
Browsing files on your computer 24
Using Launcher 25
Workspaces 25
Managing windows 26
Nautilus file manager 27
Searching for files and folders on your computer 30
Customizing your desktop 30
Accessibility 31
Session options 32
Getting help 33

3 Working with Ubuntu 35
All the applications you need 35
Getting online 37
Browsing the web 44
Reading and composing email 53
Using instant messaging 57
Microblogging 62
Viewing and editing photos 65
Watching videos and movies 68
Listening to audio and music 70
Burning CDs and DVDs 74
Working with documents, spreadsheets, and presentations 77
Ubuntu One 78
Getting started with Ubuntu One 79
Using Ubuntu One 81

4 Hardware 89
Using your devices 89



4 GETTING STARTED WITH UBUNTU 11.10

Hardware identification 89

Displays 89

Connecting and using your printer 91
Sound 92

Using a webcam 93

Scanning text and images 93

Other devices 94

5  Software Management 97
Software management in Ubuntu 97
Using the Ubuntu Software Center 97
Managing additional software 100
Manual software installation 102
Updates and upgrades 103

6  Advanced Topics 105
Ubuntu for advanced users 105
Introduction to the terminal 105
Ubuntu file system structure 106
Securing Ubuntu 108
Why Ubuntu is safe 108
Basic security concepts 108
Users and groups 109
System updates 111
Firewall 111
Encryption 112

7  Troubleshooting 113
Resolving problems 113
Troubleshooting guide 113
Getting more help 118

8 Learning More 119
What else can I do with Ubuntu? 119
Open source software 119
Distribution families 119
Choosing amongst Ubuntu and its derivatives 120
Finding additional help and support 121
The Ubuntu community 123
Contributing to this manual 124

A License 125
Creative Commons Attribution-ShareAlike 3.0 Legal Code 125
Creative Commons Notice 130

Glossary 133

Credits 135

Team leads 135
Authors 135

Editors 135
Designers 135
Developers 135
Translation editors 136



CONTENTS §

Special thanks 136
Past contributors 136

Index 137






Prologue

Welcome

Welcome to Getting Started with Ubuntu, an introductory guide written to
help new users get started with Ubuntu.

Our goal is to cover the basics of Ubuntu (such as installation and work-
ing with the desktop) as well as hardware and software management, work-
ing with the command line, and security. We designed this guide to be
simple to follow, with step-by-step instructions and plenty of screenshots,
allowing you to discover the potential of your new Ubuntu system.

Please bear in mind that this guide is still very much a work in progress
and always will be. It is written specifically for Ubuntu 11.10, and although
we have aimed to not limit our instructions to this version, it is unavoidable
that some things will change over the life of Ubuntu. Whenever a new
version of Ubuntu is released, we will incorporate updates and changes into
our guide, and make a new version available at http://www.ubuntu-manual.
org.

Getting Started with Ubuntu 11.10 is not intended to be a comprehensive
Ubuntu instruction manual. It is more like a quick-start guide that will get
you doing the things you need to do with your computer quickly and easily,
without getting bogged down with technical details. As with prior versions,
Ubuntu 11.10 incorporates many new features, including enhancements to
the Unity shell. More about the Unity shell and what it means can be found
in Chapter 2: The Ubuntu Desktop.

For more detailed information on using Unity and the Ubuntu desktop,
see the “Ubuntu Desktop Guide,” which can be obtained in the following
ways:

» in the Dash, type yelp;
» in the desktop menubar, click Help » Help with Ubuntu; or
» go to https://help.ubuntu.com, Ubuntu 11.10 » Ubuntu Desktop Help.

The Internet is also an excellent resource. For example, on https://help.
ubuntu.com you will find documentation on installing and using Ubuntu,
and at the Ubuntu Forums (ubuntuforums.org) you find answers to many
Ubuntu related questions.

If something isn’t covered in this manual, chances are you will find the
information you are looking for in one of those locations. We will try our
best to include links to more detailed help wherever we can.

Ubuntu Philosophy

The term “Ubuntu” is a traditional African concept that originated from
the Bantu languages of southern Africa. It can be described as a way of
connecting with others—living in a global community where your actions
affect all of humanity. Ubuntu is more than just an operating system: it is
a community of people that come together voluntarily to collaborate on
an international software project that aims to deliver the best possible user
experience.

More information about Ubuntu’s online

and system documentation can be found in
Chapter 8: Learning More. Popular forums

for Ubuntu discussion and support are the
Ubuntu Forums, http://ubuntuforums.org, and
Askubuntu at http://askubuntu.com.


http://www.ubuntu-manual.org
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The Ubuntu Promise

» Ubuntu will always be free of charge, along with its regular enterprise
releases and security updates.

» Ubuntu comes with full commercial support from Canonical and hun-
dreds of companies from across the world.

» Ubuntu provides the best translations and accessibility features that the
free software community has to offer.

» Ubuntu’s core applications are all free and open source. We want you to
use free and open source software, improve it, and pass it on.

A brief history of Ubuntu

Ubuntu was conceived in 2004 by Mark Shuttleworth, a successful South
African entrepreneur, and his company Canonical. Shuttleworth recognized
the power of Linux and open source, but was also aware of weaknesses that
prevented mainstream use.

Shuttleworth set out with clear intentions to address these weaknesses
and create a system that was easy to use, completely free (see Chapter 8:
Learning More for the complete definition of “free”), and could compete
with other mainstream operating systems. With the Debian system as a
base,Shuttleworth began to build Ubuntu. Using his own funds at first,
installation cps were pressed and shipped worldwide at no cost to the end
user. Ubuntu spread quickly, the size of the community rapidly increased,
and it soon became the most popular Linux distribution available.

With more people working on the project than ever before, Ubuntu con-
tinues to see improvement to its core features and hardware support, and
has gained the attention of large organizations worldwide. One of IBM’s
open source operating systems is based on Ubuntu. Additionally, in 2005,
the French Police began to transition their entire computer infrastructure to
a variant of Ubuntu—a process which has reportedly saved them “millions
of euros” in licensing fees for Microsoft Windows. By the year 2012, the

French Police anticipates that all of their computers will be running Ubuntu.

Canonical profits from this arrangement by providing technical support and
custom-built software.

While large organizations often find it useful to pay for support services,
Shuttleworth has promised that the Ubuntu desktop system will always
be free. As of 2011, Ubuntu is installed on an estimated 2% of the world’s
computers. This equates to millions of users worldwide, and is growing
each year. Because of a lack of registration, the percentage of Ubuntu users
should be treated as an estimate.

What is Linux?

Ubuntu is built on the foundation of Linux, which is a member of the Unix
family. Unix is one of the oldest types of operating systems and has pro-
vided reliability and security in professional applications for almost half a
century. Many servers around the world that store data for popular web-
sites (such as YouTube and Google) run some variant of a Unix system.
The Linux kernel is best described as the core, or almost the brain, of the
operating system.

The Linux kernel is the controller of the operating system; it is responsi-
ble for allocating memory and processor time. It can also be thought of as
the program which manages any and all applications on the computer itself.

Canonical is the company that provides financial
and technical support for Ubuntu. It has
employees based around the world who work
on developing and improving the operating
system, as well as reviewing work submitted by
volunteer contributors. To learn more about
Canonical, go to http://www.canonical.com.

Debian is the Linux operating system that
Ubuntu is based upon. For more information
visit http://www.debian.org/.

For information on Ubuntu Server Edition, and
how you can use it in your company, visit http://
www.ubuntu.com/business/server/overview.


http://www.canonical.com
http://www.debian.org/
http://www.ubuntu.com/business/server/overview
http://www.ubuntu.com/business/server/overview

Linux was designed from the ground up with security and hardware
compatibility in mind, and is currently one of the most popular Unix-based
operating systems. One of the benefits of Linux is that it is incredibly flex-
ible and can be configured to run on almost any device—from the smallest
micro-computers and cellphones to larger super-computers. Unix was en-
tirely command line-based until graphical user interfaces (Guis) began to
emerge in the early 1990s.

These early cuis were difficult to configure, clunky, and generally only
used by seasoned computer programmers. In the past decade, however,
graphical user interfaces have come a long way in terms of usability, reli-
ability, and appearance. Ubuntu is just one of many different Linux distri-
butions, and uses one of the more popular graphical desktop environments
called GNOME.

Is Ubuntu right for you?

New users to Ubuntu may find that it takes some time to feel comfortable
when trying a new operating system. You will no doubt notice many sim-
ilarities to both Microsoft Windows and Mac os x, and some differences.

Users coming from Mac os x are more likely to notice similarities due to the

fact that both Mac os x and Ubuntu originated from Unix.

Before you decide whether or not Ubuntu is right for you, we suggest
giving yourself some time to grow accustomed to the way things are done
in Ubuntu. You should expect to find that some things are different from
what you are used to. We also suggest taking the following into account:

Ubuntu is community based. That is, Ubuntu is developed, written, and
maintained by the community. Because of this, support is probably
not available at your local computer store. Fortunately, the Ubuntu
community is here to help. There are many articles, guides, and manuals
available, as well as users on various Internet forums and Internet Relay
Chat (1rc) rooms that are willing to assist beginners. Additionally, near
the end of this guide, we include a troubleshooting chapter: Chapter 7:
Troubleshooting.

PROLOGUE ¢

While modern graphical desktop environments
have generally replaced early command-line
interfaces, the command line can still be a
quick and efficient way of performing many
tasks. See Chapter 6: Advanced Topics for
more information, and Chapter 2: The Ubuntu
Desktop to learn more about gnome and other
desktop environments.

A desktop environment is a sophisticated and
integrated user interface that provides the
basis for humans to interact with a computer
using a monitor, keyboard and a mouse.

To learn more about Linux distributions, see
Chapter 8: Learning More.

Many applications designed for Microsoft Windows or Mac os x will not run on Ubuntu.

For the vast majority of everyday computing tasks, you will find suitable
alternative applications available in Ubuntu. However, many profes-
sional applications (such as the Adobe Creative Suite) are not developed
to work with Ubuntu. If you rely on commercial software that is not
compatible with Ubuntu, yet still want to give Ubuntu a try, you may
want to consider dual-booting. Alternatively, some applications devel-
oped for Windows will work in Ubuntu with a program called Wine. For
more information on Wine, go to http://www.winehq.org.

Many commercial games will not run on Ubuntu. If you are a heavy gamer,
then Ubuntu may not be for you. Game developers usually design games
for the largest market. Since Ubuntu’s market share is not as substantial
as Microsoft’s Windows or Apple’s Mac os x, most game developers
will not allocate resources towards making their games compatible with
Ubuntu. If you just like to play a game every now and then, there is
active game development within the community, and many high quality
games can be easily installed through the Ubuntu Software Center.

To learn more about dual-booting (running
Ubuntu side-by-side with another operating
system), see Chapter 1: Installation.

See Chapter 5: Software Management to learn
more about Ubuntu Software Center.


http://www.winehq.org
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Contact details

Many people have contributed their time to this project. If you notice any
errors or think we have left something out, feel free to contact us. We do
everything we can to make sure that this manual is up to date, informative,
and professional. Our contact details are as follows:

The Ubuntu Manual Team

Website: http://www.ubuntu-manual.org/
Email: ubuntu-manual@lists.launchpad.net
IRC: #ubuntu-manual on irc.freenode.net
Bug Reports: http://bugs.ubuntu-manual.org

About the team

Our project is an open source volunteer effort to create and maintain qual-
ity documentation for Ubuntu and its derivatives.

Our mission is to provide a wide range of quality educational materi-
als to lower the Linux barrier to entry for new users and in turn increase
Ubuntu’s market share.

Want to help?

We are always looking for talented people to work with, and due to the size
of the project we are fortunate to be able to cater to a wide range of skill
sets:

» Authors, editors

» Programmers (Python or TgX)

» User interface designers

» Icon and title page designers

» Event organizers and ideas people
» Testers

» Web designers and developers

» Translators and screenshotters

» Bug reporters and triagers

To find out how you can get started helping, please visit http://ubuntu-manual.
org/getinvolved.

Conventions used in this book
The following typographic conventions are used in this book:

» Button names, menu items, and other GuI elements are set in boldfaced
type.

» Menu sequences are sometimes typeset as File » Save As..., which means,
“Choose the File menu, then choose the Save As...”

» Monospaced type is used for text that you type into the computer, text
that the computer outputs (as in a terminal), and keyboard shortcuts.


http://www.ubuntu-manual.org/
ubuntu-manual@lists.launchpad.net
irc.freenode.net
http://bugs.ubuntu-manual.org
http://ubuntu-manual.org/getinvolved
http://ubuntu-manual.org/getinvolved

1 Installation

Getting Ubuntu

Before you can get started with Ubuntu, you will need to obtain a copy of
the Ubuntu installation image for cp or usB. Some options for doing this are
outlined below.

Minimum system requirements

Ubuntu runs well on most computer systems. If you are unsure whether it
will work on your computer, the Live cD is a great way to test things out
first. Below is a list of hardware specifications that your computer should
meet as a minimum requirement.

» 1 GHz x86 processor (Pentium 4 or better)

» 1 GB of system memory (RAM)

» 5 GB of disk space (at least 15 GB is recommended)
» Graphics card capable of 1024 X768 resolution

» Sound card

» A network or Internet connection

Downloading Ubuntu

The easiest and most common method for getting Ubuntu is to download
the Ubuntu cp image directly from http://www.ubuntu.com/download.
Choose how you will install Ubuntu:

» Download and install
» Try it from a cD or usB stick
» Run it with Windows

For the Download and install, or Try it from a cD or UsB stick options, se-
lect whether you require the 32-bit or 64-bit version (32-bit is recommended
for most users), then click “Start download.”

Installing and run alongside Windows

For the Run it with Windows option, simply select “Start download,” and
then follow the instructions for the Ubuntu installer for Windows.

32-bit vs 64-bit

Ubuntu and its derivatives are available in two versions: 32-bit and 64-bit.
This difference refers to the way computers process information. Comput-
ers capable of running 64-bit software are able to process more information
than computers running 32-bit software; however, 64-bit systems require
more memory in order to do this. Nevertheless, these computers gain per-
formance enhancements by running 64-bit software.

» If your computer has a 64-bit processor install the 64-bit version.
» If your computer is older, a netbook, or you do not know the type of
processor in the computer, install the 32-bit version.

Many companies (such as Dell and System76)
sell computers with Ubuntu preinstalled. If
you already have Ubuntu installed on your
computer, feel free to skip to Chapter 2: The
Ubuntu Desktop.

The majority of computers in use today will
meet the requirements listed here; however,
refer to your computer documentation or
manufacturer’s website for more information.

32-bit and 64-bit are types of processor
architectures. 64-bit is newer, and most recent
computers will come with a 64-bit capable
processor.


http://www.ubuntu.com/download
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If your computer has a 64-bit processor, click on the “64-bit” option
before you click “Start download.”

Downloading Ubuntu as a torrent

When a new version of Ubuntu is released, the download servers can get
“clogged” as large numbers of people try to download or upgrade Ubuntu
at the same time. If you are familiar with using torrents, you may wish to
download the torrent file by clicking “Alternative downloads,” and then
“BitTorrent download” to obtain your copy of the cD image this way in-
stead. You may see significant improvements to your download speed, and
will also be helping to spread Ubuntu to other users worldwide.

Burning the CD image

Once your download is complete, you will be left with a file called ubuntu-
11.10-desktop-i386.iso or similar (i386 here in the filename refers to the 32-bit
version. If you had downloaded the 64-bit version, the filename would
contain amdé4 instead). This file is a cD image—a snapshot of the contents
of a co—which you will need to burn to a cp.

Creating a bootable USB drive

If your pc is able to boot from a UsB port, you may prefer to use a UsB
memory stick instead of burning a cp. Scroll down to “Burn your cp or
create a UsB drive,” select cD or USB stick, choose the 0s you are using to
create the usB drive, and then click Show me how. If you select the “UsB
Stick” option, your installation will be running from the uss memory stick.
In this case, references to Live cD, will refer to the usB memory stick.

The Live CD/USB stick

The Ubuntu cp and usB stick function not only as installation media, but
also allow you to test Ubuntu without making any permanent changes to
your computer by running the entire operating system from the cb or uss
stick.

Your computer reads information from a cp at a much slower speed than
it can read information off of a hard drive. Running Ubuntu from the Live
cD also occupies a large portion of your computer’s memory, which would
usually be available for applications to access when Ubuntu is running from
your hard drive. The Live cb/UsB experience will therefore feel slightly
slower than it does when Ubuntu is actually installed on your computer.
Running Ubuntu from the cD/UsB is a great way to test things out and
allows you to try the default applications, browse the Internet, and get a
general feel for the operating system. It’s also useful for checking that your
computer hardware works properly in Ubuntu and that there are no major
compatibility issues.

To try out Ubuntu using the Live cp/uUsB stick, insert the Ubuntu cp into
your cD drive, or connect the UsB drive and restart your computer.

After your computer finds the Live cp/uUsB stick, and a quick loading
screen, you will be presented with the “Welcome” screen. Using your
mouse, select your language from the list on the left, then click the but-
ton labeled Try Ubuntu. Ubuntu will then start up, running directly from
the Live cp/usB drive.

Torrents are a way of sharing files and informa-
tion around the Internet via peer-to-peer file
sharing. A file with a .torrent extension is made
available to users, which is then opened with a
compatible program such as uTorrent, Deluge,
or Transmission. These programs download
parts of the file from other people all around
the world.

While the 64-bit version of Ubuntu is referred
to as the “AMD64" version, it will work on Intel,
AMD, and other compatible 64-bit processors.

In some cases, your computer will not recognize
that the Ubuntu CD or USB is present as it
starts up and will start your existing operating
system instead. Generally, this means that

the priority given to boot devices when your
computer is starting needs to be changed. For
example, your computer might be set to look
for information from your hard drive, and then
to look for information on a CD or USB. To run
Ubuntu from the Live CD or USB, we want the
computer to look for information from the
appropriate device first. Changing your boot
priority is usually handled by BIOS settings; this
is beyond the scope of this guide. If you need
assistance with changing the boot priority, see
your computer manufacturer’s documentation
for more information.
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Welcome

)
Asturianu
Bahasa Indonesia L
Bosanski
Catala
Ceitina
Dansk
Deutsch
Eesti
Espanol
Esperanto
Euskara Try Ubuntu Install Ubuntu
Frangais
Gaeilge You can try Ubuntu without making any changes to your computer, directly
Galego From this CD.
Hrvatski
. rvatskl Or if you're ready, you caninstall Ubuntu alongside (or instead of) your
Islenska current operating system. This shouldn't take too long.
Italiano
Kurdi

. ‘You may wish to read the release notes.

Once Ubuntu is up and running, you will see the default desktop. We
will talk more about how to actually use Ubuntu in Chapter 2: The Ubuntu
Desktop, but for now, feel free to test things out. Open some applications,
change settings and generally explore—any changes you make will not be
saved once you exit, so you don’t need to worry about accidentally breaking
anything.

When you are finished exploring, restart your computer by clicking the
“Power” button in the top right corner of your screen (a circle with a line
through the top) and then select Restart. Follow the prompts that appear on
screen, including removing the Live cD and pressing Enter when instructed,
and then your computer will restart. As long as the Live cD is no longer in
the drive, your computer will return to its original state as though nothing
ever happened!

Installing Ubuntu

The process of installing Ubuntu is designed to be quick and easy. To help
you get started, we have included step-by-step instructions below, along
with screenshots so you can see how things will look along the way.

At least 5GB of free space on your hard drive is required in order to
install Ubuntu; however, 15 GB or more is recommended. This will ensure
that you will have plenty of room to install extra applications later on, as
well as store your own documents, music, and photos.

Getting started

To get started, place the Ubuntu cp in your cp drive and restart your com-
puter. Your computer should load Ubuntu from the cb. When you first start
from the cp, you will be presented with a screen asking you whether you
want to first try out Ubuntu or install it. Select the language you want to
view the installer in and click on the Install Ubuntu button. This will start
the installation process.

If you have an Internet connection, the installer will ask you if you
would like to “Download updates while installing” We recommend you
do so. The second option, “Install this third-party software,” includes the
Fluendo MP3 codec, and software required for some wireless hardware. If

INSTALLATION 13

Figure 1.1: The “Welcome” screen allows you to
choose your language.

Alternatively, you can also use your mouse to
double-click the “Install Ubuntu 11.10" icon that
is visible on the desktop when using the Live
CD. This will start the Ubuntu installer.

Clicking on the underlined “release notes” link
will open a web page containing any important
information regarding the current version of
Ubuntu.
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you are not connected to the Internet, the installer will help you set up a
wireless connection.

The “Preparing to install Ubuntu” screen will also let you know if you
have enough disk space and if you are connected to a power source (in case
you are installing Ubuntu on a laptop running on battery). Once you have
selected your choices, click Continue.

Internet connection

If you are not connected to the Internet, the installer will ask you to choose
a wireless network (if available).

1. Select Connect to this network, and then select your network from the
list.

2. If the list does not appear immediately, wait until a triangle/arrow ap-
pears next to the network adapter, and then click the arrow to see the
available networks.

3. In the Password field, enter the network wep or wra key (if necessary).

4. Click Connect to continue.

Install

Wireless

Connecting this computer to a wi-fi netwerk allows you to install third-party software, download updates,
automatically detect your timezone, and install full support for your language.

Idon't want ko connect to a wi-fi network right now
@® Connect to this network
I Broadcom Corporation BCM4322 802.11a/b/g/n Wireless LAN Controller

% 2WIREZZ
3 2WIREDS
S b
a SOL Network
Password: Display password

Quit Back | Connect ‘

Allocate drive space

This next step is often referred to as partitioning. Partitioning is the process
of allocating portions of your hard drive for a specific purpose. When you
create a partition, you are essentially dividing up your hard drive into sec-
tions that will be used for different types of information. Partitioning can
sometimes seem complex to a new user; however, it does not have to be. In
fact, Ubuntu provides you with some options that greatly simplify this pro-
cess. The Ubuntu installer will automatically detect any existing operating
system installed on your machine, and present installations options based
on your system. Not all of the options listed below may appear:

Install alongside other operating systems
Upgrade Ubuntu ... to 11.10

Erase ... and install Ubuntu

Something else

i o

We recommend that you connect during install,
though updates and third-party software can be
installed after installation.

Figure 1.2: Set up wireless.

If you are installing on a new machine with no
operating system, you will not get the Ffirst
option. The upgrade option is only available if
you are upgrading from a previous version of
Ubuntu.



Install alongside other operating systems.

If you are a Windows or Mac user and you are trying to install Ubuntu for
the first time, select the Install alongside other operating systems option.
This option will enable you to choose which operating system you wish to
use when you computer starts. Ubuntu will automatically detect the other
operating system and install Ubuntu alongside it.

For more complicated dual-booting setups, you will need to configure the parti-
tions manually.

@ Install

Installation type

This computer currently has Ubuntu oneiric on it. What would you like to do?

Install Ubuntu 11.10 alongside Ubuntu oneiric

® © Documents, music, and other personal files will be kept.
You can choose which operating system you want each
time the computer starts up.

Upgrade Ubuntu oneiric to 11.10

Documents, music, and other personal files will be kept.
Installed software will be kept where possible. System-
wide settings will be cleared.

Erase Ubuntu oneiric and reinstall
Warning: This will delete all your Ubuntu oneiric

programs, documents, photos, music, and any other files.

Something else
You can create or resize partitions yourself, or choose
multiple partitions for Ubuntu.

Quit Back Continue

Upgrade Ubuntu ... to 11.10

This option will keep all of your Documents, music, pictures, and other
personal files. Installed software will be kept when possible (not all your
currently installed software may be supported on the new version). System-
wide settings will be cleared.

Erase disk and install Ubuntu

Use this option if you want to erase your entire disk. This will delete any
existing operating systems that are installed on that disk, such as Windows
xPp, and install Ubuntu in its place. This option is also useful if you have

an empty hard drive, as Ubuntu will automatically create the necessary
partitions for you.

Formatting a partition will destroy any data currently on the partition. Be sure to
back up any data you want to save before Formatting.

Something else

This option is for advanced users and is used to create special partitions, or
format the hard drive with a file system different to the default one.

After you have chosen the installation type, click Continue, or Install
Now.

INSTALLATION 15

Ubuntu provides you with the option of either
replacing your existing operating system
altogether, or installing Ubuntu alongside

your existing system. The latter is called dual-
booting. Whenever you turn on or restart your
computer, you will be given the option to select
which operating system you want to use for
that session.

Figure 1.3: Choose where you would like to
install Ubuntu.

Ubuntu installs a home folder where your
personal files and configuration data are
located by default. If you choose to have your
home folder on a separate partition, then in the
event that you decide to reinstall Ubuntu or
perform a fresh upgrade to the latest release,
your personal files and configuration data won't
be lost.

More information and detailed instructions

on partitioning are available at: https://help.
ubuntu.com/community/HowtoPartition.


https://help.ubuntu.com/community/HowtoPartition
https://help.ubuntu.com/community/HowtoPartition

16 GETTING STARTED WITH UBUNTU 11.10

Confirm Partition choices and start install

If you chose Something else, configure the partitions as you need. Once
you are happy with the way the partitions are going to be set up, click the
Install Now button at the bottom right to move on.

To reduce the time required for installation, Ubuntu will continue the
installation process “in the background” while you configure important
user details—like your username, password, keyboard settings and default
timezone.

Where are you?

Install

Where are you?

Los Angeles

Forward

» Removing conflicting operating system files...

The next screen will display a world map. Using your mouse, click your
geographic location on the map to tell Ubuntu where you are. Alternatively,
you can use the drop-down lists underneath the map. This allows Ubuntu
to configure your system clock and other location-based features. Click
Forward when you are ready to move on.

Keyboard layout

Next, you need to tell Ubuntu what kind of keyboard you are using. In most
cases, you will find the suggested option satisfactory. If you are unsure
which keyboard option to select, you can click the Detect Keyboard Layout
button to have Ubuntu determine the correct choice by asking you to press
a series of keys. You can also manually choose your keyboard layout from
the list of options. If you like, enter text into the box at the bottom of the
window to ensure you are happy with your selection, then click Continue.

Who are you?

Ubuntu needs to know some information about you so it can set up the
primary user account on your computer. When configured, your name will
appear on the login screen as well as the MeMenu, which we discuss in
Chapter 2: The Ubuntu Desktop.

On this screen you will need to tell Ubuntu:

> your name

Figure 1.4: Tell Ubuntu your location.



Install

Keyboard layout

Choose your keyboard layout:

English (Cameroon)

English (Ghana) English (US) - Cherokee

English (Nigeria) English (US) - English (Colemak)

English (South Africa) | English (US) - English (Dvorak alternative internation|
English (UK) English (US) - English (Dvorak international with dea

English (US) - English (Dvorak)

Esperanto English (US) - English (Macintosh)

Estonian English (US) - English (US, alternative international)
Faroese English (US) - English (US, international with dead ke
Filipino English (US) - English (US, with euro on 5)

Finnish English (US) - English (classic Dvorak)

Type here to test your keyboard
| Detect Keyboard Layout |

Back Continue

» what you want to call your computer
» your desired username

» your desired password

» how you want Ubuntu to log you in

Install

Who are you?

‘Your name: |ubuntu-user o

‘Your computer's name: ubuntuuser-VirtualBox \Vf
The name it uses when it balks to other computers.

Pick a username: |ubuntu-user LY

Choose a password: @

Confirm your password: @@®®

Login automatically
@® Require my password to login
| Encrypt my home folder

Back Continue

Enter your full name under “Your name?”. The next text field is the name

your computer uses, for terminals and networks. You can change this to
what you want, or keep the predetermined name. Next is your username,
the name that is used for the Me Menu, your home folder, and behind the
scenes. You will see this is automatically filled in for you with your first
name. Most people find it easiest to stick with this. However, it can be
changed if you prefer.

Next, choose a password and enter it into the password field on the
left, and then enter same password into the password field on the right.
When both passwords match, a strength rating will appear to the right
that will show you whether your password is “too short,” “weak,” “fair,” or
“strong.” You will be able to continue the installation process regardless
of your password strength, but for security reasons it is best to choose a
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Figure 1.5: Verify that your keyboard layout is

correct.

Figure 1.6: Setup your user account.
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strong one. This is best achieved by having a password that is at least six
characters long, and is a mixture of letters, numbers, symbols, and upper-
case/lowercase. Avoid obvious passwords that include your birth date,
spouse’s name, or the name of your pet.

Login Options

Finally, at the bottom of this screen you have three options from which to
choose regarding how you wish to log in to Ubuntu.

» Log in automatically
» Require my password to log in
» Encrypt my home folder

Log in automatically

Ubuntu will log in to your primary account automatically when you start
up the computer so you won’t have to enter your username and password.
This makes your login experience quicker and more convenient, but if
privacy or security are important to you, we don’t recommend this option.
Anyone who can physically access your computer will be able to turn it on
and also access your files.

Require my password to login

This option is selected by default, as it will prevent unauthorized people
from accessing your computer without knowing the password you cre-
ated earlier. This is a good option for those who, for example, share their
computer with other family members. Once the installation process has
been completed, an additional login account can be created for each family
member. Each person will then have their own login name and password,
account preferences, Internet bookmarks, and personal storage space.

Encrypt my home folder

This option provides you with an extra layer of security. Your home folder
is where your personal files are stored. By selecting this option, Ubuntu
will automatically enable encryption on your home folder, meaning that
files and folders must be decrypted using your password before they can be
accessed. Therefore if someone had physical access to your hard drive (for
example, if your computer was stolen and the hard drive removed), they
would not be able to see your files without knowing your password.

If you choose this option, be careful not to enable automatic login at a later date.
It will cause complications with your encrypted home folder, and will potentially
lock you out of important files.

Installation Slideshow

Ubuntu will now finish installing on your hard drive. As the installation
progresses, a slideshow will give you an introduction to some of the default
applications included with Ubuntu. These applications are covered in more
detail in Chapter 3: Working with Ubuntu.

After approximately twenty minutes, the installation will complete and
you will be able to click Restart Now to restart your computer and start
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Install Figure 1.7: The first slide in the installation

Welcome to Ubuntu 11.10

slideshow.

Ubuntu is packed with features to make your
computer delightful to use. This version
consolidates the Unity desktop interface; a
brand new way to find and manage your
applications. Now with more features and
faster. We'd like to show some cool things to
look for in your new operating system. ®

Ubuntu. The cp will be ejected, so remove it from your cp drive and press
Enter to continue.

Installation Complete Figure 1.8: You are now ready to restart your
computer.

- Installationis complete. You need to restart
6 the computer in order to use the new
installation.

Restart Now

Wait while your computer restarts, and you will then see the login win-
dow (unless you selected automatic login).

Click your username and enter your password, then press Enter or click
Log in. You will then be logged in to Ubuntu and will be presented with
your new desktop!
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Ubuntu installer fFor Windows

You can install and run Ubuntu alongside your current installation of Win-
dows:

1. Download the Ubuntu installer for Windows http://www.ubuntu.com/
download/ubuntu/windows-installer

2. Run the download file

3. Install Ubuntu

Download and run the installer

After the file, wubi.exe, is downloaded, run the file to start the installation. If
a security message appears, click Continue, to proceed with the installation:

% User Account Control == Figure 1.9: User Account Control dialog

Do you want to allow the following program to make

changes to this computer?

2\e  Programname  Wubi - Ubuntu Installer for Windows
N Verified publisher: Canonical UK Ltd.
File origin: Network drive

~) Show details

Change when these notifications appear

Install

The Ubuntu Installer will start. Choose and enter a “Username” and “Pass-
word.” The password must be entered twice to ensure accuracy. After
choosing a password, click Install. The Ubuntu Installer will download and
install Ubuntu. This process will take some time. The download file size is
700Mb. After the installation is complete, click Finish on the “Completing
the Ubuntu Setup Wizard” screen to reboot the computer.

A = Figure 1.10: Ubuntu Windows Installer
You are about to install Ubuntu-11.10
@ Please select username and password for the new account
Installation drive: Lanquage:
% c: (108 free) - m [Engish us) =

. Installation size: _ Usemame:
E2 ees - & ubuntu-user|

Password:

Desktop environment:

-

[ Accessiiity | [ mstl ] [ cencdl

Installation complete

After the computer restarts, you can select “Ubuntu” from the boot menu.
You will then be logged in to Ubuntu and will be presented with your new
desktop!


http://www.ubuntu.com/download/ubuntu/windows-installer
http://www.ubuntu.com/download/ubuntu/windows-installer

2 The Ubuntu Desktop

Understanding the Ubuntu desktop

Initially, you may notice many similarities between Ubuntu and other Ubuntu 11.10 has an emphasis on “social
operating systems such as Microsoft Windows or Mac os x. This is because from the start” and features social network
h 1l based th t of hical interf . integration in the desktop for sites like Twitter
they are all based on the concept of a graphical user interface (cur)—i.e., and Facebook.
you use your mouse to navigate the desktop, open applications, move files,
and perform most other tasks. In short, things are visually oriented, which
means that it’s important for you to become familiar with where and what
to click in Ubuntu.

Efen B = 4)) 1036PM B Guest LF Figure 2.1: The Ubuntu 11.10 default desktop.
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Unity

All gui-based operating systems use a desktop environment. Desktop envi-
ronments encompass many things, such as:

» 'The look and feel of your system
» The way the desktop is laid out
» How the desktop is navigated by the user

In Linux distributions (such as Ubuntu), there are a number of desktop To read more about other variants of Ubuntu,
environments available for use. Ubuntu uses Unity as the default desktop refer to Chapter 8: Learning More.
environment.

KDE, XFCE, GNOME and LXDE are other popular desktop environments.
Since Ubuntu uses Unity, we will focus this guide on exploring the Unity
desktop.

After installation and log in, you will see the Unity desktop. Let’s explore
the default layout that is in front of you. This initial view is comprised of
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the The Desktop Background and two bars—one at the top of your desktop,
The Top Bar, and one on the left, Using Launcher.

The Desktop Background

Below the Top Bar is an image that covers the entire desktop. This is the
desktop background or wallpaper and the one you see in front of you be-
longs to the default Ubuntu 11.10 theme known as Ambiance. To learn more
about customizing your desktop including changing your background, see
the section on Customizing your desktop below.

The Top Bar
The Top Bar incorporates all of the functions that you need. First, the right “Top Bar” is also referred as “Top Panel.”
part of the bar is the Indicator area. To access an indicator, just left-click on
it. Starting from the left, the Indicators are: For more about:
» the Messaging Indicator see Microblogging;
» the Keyboard Indicator—allows you to select the keyboard layout you » the Network Indicator see Getting online;

would like and change your keyboard preferences. > the Session Indicator see Session options.

» the Messaging Indicator—incorporates all your social applications. From
here, you can access your instant messenger, your email client, your
microblogging application, and even UbuntuOne, your personal cloud!

» the Network Indicator—allows you to manage your network connections
and connect quickly and easily to a wired or wireless network.

» the Sound Indicator—allows you to adjust the sound volume, and access
your music player and Sound Settings.

» the Clock—shows you the current time and provides you with an easy
way to access your calendar and Time and Date settings.

» the Me Menu—allows you to easily switch between different users and
access your online and user accounts

» the Session Indicator—provides you an easy way to access System Set-
tings, Updates, Printers, and session options for locking your computer,
logging out of your session, restarting the computer, or shutting down
completely.

EBen B = d4)) 6:07PM R c7p ¥

Figure 2.2: The Indicators of the Top Bar.

Every application has a menu (like File, Edit, View etc.), called the ap-
plication menu. In Unity, the application menu isn’t on the titlebar of the
application, like in other desktop environments, but is instead located on
the left area of the Top Bar. To show an application’s menu, just move your
mouse to the Top Bar. This is the second key concept of the Top Bar, the
incorporation of application menus on the Top Bar. This feature of Unity
provides you with more free work space; especially beneficial for netbook

and laptop users. Note that some older applications may still
display their menu within the application
window.

The Launcher

The bar on the left side of the screen is called the Launcher. The Launcher
provides you with an easy way to access applications, mounted devices
and Trash. If you run a maximized application, Launcher is automatically
hidden. To show the Launcher, move your mouse to the left side of your



screen. Starting from the top, the first item of the Launcher is the Dash—we
will describe the Dash in depth later—next there are some applications, the
Workspace lens, any mounted devices, and at the bottom of the Launcher

is the Trash. By default there are some applications on the Launcher, like
Firefox. Also, all of the applications that you are running are available from
the Launcher, including the minimized applications.

The Dash

The Dash is a tool that helps you to access the application, files and mu-
sic, you want, if you are a Windows user you can see the Dash as a more
advanced approach of the Start menu. If you are a Mac user, the Dash is
something like Launchpad in the dock. If used a previous version of Ubuntu
or another GNOME distro, Dash replaces the GNOME menus.

To explore the Dash, move your cursor to the Launcher and click on the
top icon, containing the Ubuntu logo.

) Een = d)) 1031PM R cp B
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& Shortcuts
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Media Apps Internet Apps More Apps Find Files

”

) @ b

Browse the Web

View Photos Check Email Listen to Music

Now, you can see the search bar on the top, some shortcuts for your
media, mail and photo applications as well as icons to restrict your search
to particular file-types below. These are called lenses. When you type in the
search bar, the Dash will start searching for applications, files, folders or
music that match what you’ve typed.

At the bottom area of the Dash, are four icons, Home, Application Lens,
File Lens and Music Lens. Lenses serve to specialize search categories in the
Dash.

Search for Files and applications with the Dash

As mentioned, the Dash is the tool that helps you find what you want. So
if you are searching for an application, a file, a music album etc, the Dash
is the right place for you. The search bar in the the Dash will locate both
applications and files.
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Workspaces helps you to select the workspace
or the window you want. Trash contains
deleted files.

Tip: Pressing Meta+S will show the Workspaces.

The Dash allows the user to search for informa-
tion: locally (installed applications, recent files,
bookmarks, etc.) and remotely (Twitter, Google
Docs, etc.). This is accomplished by utilizing one
or more Lenses; each responsible for providing
a category of search results for the Dash. For
more information regarding the Dash and
lenses, see: https://wiki.ubuntu.com/Unity

Figure 2.3: The Dash

Figure 2.4: Dash lenses


https://wiki.ubuntu.com/Unity
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If you want to maximize the Dash, you only have to click on the icon at
the bottom right corner of the Dash.

Search applications

If you need an application, open the the Dash and press on the Application
Lens. The Dash automatically categorizes the application to “Most Fre-
quently Used,” “Installed,” and “Apps Available for Download.” Enter the
name of the application you are looking for, and the Dash will return the
results. If you can’t find what you want, you can also filter the results by
pressing Filter results in the top right corner of the Dash, and then selecting
a category.

More information on the applications you will need can be found in
Chapter 3: Working with Ubuntu.
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Search Files and Folders

Open the Dash, and then click on the File Lens. Now you can see files cat-
egorized to “Recent,” “Downloads,” and “Folders.” You can add criteria to
fine-tune the results. To do this, click on Filter results and select file or

folder modification times, or file type (.odt, .pdf, .doc, .tex., etc.), or its size.

Browsing files on your computer

There are two ways to locate files on your computer; either search for
them or access them directly from their folder. You can search for a file
via the Dash or Files & Folders in the Launcher. You can use the Files &
Folders tool to access commonly used folders (such as Documents, Music,
Downloads), and most recently accessed files.

Figure 2.5: You can see the default results when
you press Application Lens, and also the criteria
on the right side.

You can open your Home folder from the
Launcher



Places

On the desktop, hover your mouse over the Top Bar, and select Places. The
Places menu holds a list of commonly used folders (such as Documents,
Music, Downloads, and the Home Folder). You can also browse the disks
on your computer by clicking Computer in this menu. If you set up a home
network, you will find a menu item to access shared files or folders. You can
also access the Search for Files tool from the Places menu, or browse a list
of recently opened folders.

Your Home Folder

The home folder is where your personal files are located. When you open
your personal folder, you will see that there are several folders inside:
Desktop (which contains any files that are visible on the desktop), Docu-
ments, Downloads, Music, Pictures, Public, Templates, and Videos.

Using Launcher

Running applications

To run an application from the Launcher, just click on the application’s
icon. Any running application exists on the Launcher, and has one or more
triangles on the left side of its icon, indicating the number of the application
windows. The application that is on the foreground has a white triangle on
the right side of the application’s icon.

You can also run an application through the Dash. We will talk about the
Dash, in the The Dash section.

If you minimize an application, it is minimized to the Launcher, and can
be restored later from there.

Adding and removing applications from Launcher

If you want to add an application to the Launcher, there are two ways to do
so:

» Open the Dash, find the application you want, and then drag and drop it
on the Launcher

» Run the application you want to add to the Launcher, and then right-
click on the application’s icon on the Launcher, and select Keep in
launcher.

If you want to remove an application from the Launcher, right-click on
the application’s icon and then select Remove from launcher or deselect
Keep in launcher—if the application is running.

Workspaces

Workspaces are virtual desktops—separate views of your desktop which
let you group your open windows. These virtual desktops increase the size
of your working area. Workspaces are meant to reduce clutter and make
the desktop easier to navigate. By default Ubuntu has four workspaces.
For example, you can have all the media applications windows on one
workspace, the web browser and office suite windows on another.

THE UBUNTU DESKTOP

If you do not see the desktop menu, click
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somewhere on the desktop and it will appear.

If you hold the Meta key for a while, a number
will appear on each of the first ten applications.
You can launch an application with a number n

on it, with Meta+n.

Home Folder

Y-

Devices

— 58 GBFilesy..

®
=
122 GBFilesy...
2 19 GBFilesy..

; \— Floppy Drive
g Computer

Figure 2.6: You can see the Home Folder on the
foreground, having a triangle on the right of its
icon. And Firefox with two triangles, indicating

that there are two opened windows of the

browser.
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Switching between workspaces

To explore workspaces, click on the Workspaces lens, located on the
Launcher. This lens let you switch workspaces, and choose the one you
want to work on.

Managing windows

When you open a program in Ubuntu (such as a web browser or a text
editor—see Chapter 3: Working with Ubuntu for more information on using
applications)—a window will appear on your desktop. If you have used
another operating system before, such as Microsoft Windows or Mac os

X, you are probably familiar with the concept of a “window”—the box that
appears on your screen when you start a program. In Ubuntu, the top part
of a window (the titlebar) will have the title of the window in the center,
and three buttons in the top left corner. From left to right, these buttons
close, minimize, and maximize the window. Additionally, you can right-click
anywhere on the titlebar for a list of other window management options.

Closing, maximizing, restoring, and minimizing windows

o8 Ubuntu Manual - Home - Mozilla Firefox

To close a window, click on the “x” in the upper left corner of the window
—this will be the first button on the left-hand side. The button immediately
to the right of this, is used to minimize the window to the Launcher. Once
minimized the window will no longer be visible, but its corresponding icon
will remain on the Launcher. This icon will have a triangle on the left side
of it, indicating the program is still running. Clicking this icon, will restore
the window to its original position. Finally, the right-most button of this
group will maximize the window, making it fill the entire screen. Clicking
this button again will return the window to its original size. Note that if you
maximize a window its buttons and menu are automatically hidden from
view. To show them, just move your mouse to the left side of the Top Bar.

Moving and resizing windows

To move a window around the workspace, place the mouse pointer over the
window’s titlebar, then click and drag the window while continuing to hold
down the left mouse button. To resize a window, place the pointer on an
edge or corner of the window so that it turns into a larger arrow, the resize
icon. You can then click and drag to resize the window.

E= Workspace Switcher
L3

Switching between open windows
In Ubuntu there are many ways to switch between open windows.

1. If the window is visible on your screen, you can click any portion of it to
raise it above all other windows.

Figure 2.7: This is the Top Bar of a window,
named Titlebar. The close, minimize, and
maximize buttons are on the top-left corner of
windows.

You can also move a window by holding the Alt
key and dragging the window

Figure 2.8: The Workspaces Lens on the
Launcher.

Meta key (Meta), is also known as the Windows
key (Win key). Press Meta+D to hide all window
and display the desktop, the same works to
restore all windows.



2. Use Alt+Tab to select the window you wish to work on. Hold down
the Alt key, and keep pressing Tab until the window you’re looking for
appears in the popup.

3. Click on the corresponding icon on Launcher. Move your mouse to
left side of your screen to show the Launcher, and right-click on the
application icon. If the application has multiple windows open, double-
click on the icon in order to select the window you want.

Moving a window to different workspace

To move a window to a different workspace, make sure the window isn’t
maximized. If it is maximized click on the right-most button to restore it to
its original size. Then right-click on the window’s title bar, and select:

» Move to Workspace Left, to move the window to the left workspace

» Move to Workspace Right, to move the window to the right workspace

» Move to Another Workspace, and then choose the Workspace you want,
to move the window to the preferred workspace.

Window always on the top or on visible workspace

At times, you may want to have a window always on top so that it can be
seen or monitored while you work with other applications. For example
you may want to browse the web and at the same time have the instant
messenger on the top, to watch the chat.

To do this you can right-click on the window’s title bar, and then select
Always on the top. Note that this window will be on the top of all windows
that are opened on the current workspace.

If you want to have a window always on the top regardless of which
workspace the window is on, right-click on the window’s titlebar, and then
select Always on Visible Workspace. Doing so this window will be always
on the top of all windows, on all workspaces.

Nautilus file manager

Just as Windows has Windows Explorer and Mac os x has Finder to browse
files and folders, Ubuntu uses the Nautilus file manager by default. We will
now look at Nautilus in more detail.

The Nautilus file manager window

When you select the Home Folder shortcut in the launcher, or click on
a folder in Files & Folders, the Dash, or on the desktop, the Nautilus file
manager window opens up. The normal window contains the following
features:

Menubar The menubar is located at the top of the screen. These menus
allow you to modify the layout of the browser, navigate, bookmark
commonly used folders and files, and view hidden folders and files.

Toolbar The toolbar has tools for navigation and a tool to make the con-
tents of the window larger or smaller. A drop-down list gives you the
option of switching the view from Icon View to List View or Compact
View. The search icon (which looks like a magnifying glass) opens a field
so you can search for a file by name.

THE UBUNTU DESKTOP

If you bookmark a folder, it will appear in the
Bookmarks menu and in the left pane.

27
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Additional Navigation Tools Just below the toolbar, you will see a represen-
tation of where you are currently browsing. This is similar to the history
function of most browsers; it keeps track of where you are and allows
you to backtrack if necessary. You can click on the locations to navigate
back through the file browser.

Left Pane The left pane of the file browser has shortcuts to commonly-used
folders. When you bookmark a folder, it appears in the left pane. No
matter what folder you open, the left pane will always contain the same
folders. This left pane can be changed to display different features, such
as Information, Tree, History etc., by clicking the down arrow beside
“Places” near the top.

Central Pane The largest pane shows the files and folders in the directory
that you are currently browsing.
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Navigating Nautilus

To navigate between directories, use the bookmarks in the left pane of
the Nautilus file manager. You can also retrace your steps by clicking on
the name of a folder where it is listed just below the navigational icons.
Double-clicking on a visible directory will cause you to navigate to it in
Nautilus.

Opening files

A file in its simplest form, is data. Data can represent a text document,
database information, or data that will be used to produce music or video.
To open a file, you can either double-click on its icon or right-click and
select Open With (program).

Creating new folders

To create a new folder from within Nautilus click File » Create Folder, then
name the folder that appears by replacing the default “untitled folder” with
your desired label (e.g., “Personal Finances”). You can also create a new
folder by pressing Ctrl+Shift+N, or by right-clicking in the file browser

If you start typing a location starting with a /
character, Nautilus will automatically change
the navigation buttons into a text field labeled
Location. It is also possible to convert the
navigation buttons into a text field by pressing
Ctri+L.

Figure 2.9: Nautilus file manager displaying
your home folder.

What is a Directory? A Folder? A directory is a
division of space in a file system that you can
use to organize files. A folder is the name given
to a directory in a Graphical User Interface
environment like Nautilus.

Note that you can easily view hidden files

by clicking View » Show Hidden Files, or
alternatively by pressing Ctrl+H. Hiding files
with a dot (.) is not a security measure—instead
it provides a way of keeping your folders
organized and tidy.



window and selecting Create Folder from the popup menu (this action will
also work on the desktop).

Hidden Files and Folders

If you wish to hide certain folders or files, place a dot () in front of the
name (e.g., “Personal Finances”). In some cases it is impossible to hide files
and folders without prefixing them with a dot. In Nautilus these folders can
be hidden by creating a .hidden file. Open the file and enter in the name of
the file or folder you wish to hide. Make sure that each file or folder is on a
separate line. When you open Nautilus the folder will no longer be visible.

Copying and moving Ffiles and folders

You can copy files or folders in Nautilus by clicking Edit » Copy, or by right-

clicking on the item and selecting Copy from the popup menu. When using
the Edit menu in Nautilus, make sure you’ve selected the file or folder you
want to copy first (by left-clicking on it once).

Multiple files can be selected by left-clicking in an empty space (i.e.,
not on a file or folder), holding the mouse button down, and dragging the
cursor across the files or folders you want. This “click-drag” move is useful
when you are selecting items that are grouped closely together. To select
multiple files or folders that are not positioned next to each other, hold
down the Ctrl key while clicking on each item individually. Once multiple
files and/or folders are selected you can use the Edit menu to perform
actions just like you would for a single item. When one or more items have
been “copied,” navigate to the desired location then click Edit » Paste (or
right-click in an empty area of the window and select Paste) to copy them
to the new location.

While the copy command can be used to make a duplicate of a file or
folder in a new location, the cut command can be used to move files and
folders around. That is, a copy will be placed in a new location, and the
original will be removed from its current location.

To move a file or folder, select the item you want to move then click
Edit » Cut. Navigate to your desired location, then click Edit » Paste.

. As with the copy command above, you can also perform this action
using the right-click menu, and it will work for multiple files or folders at
once. An alternative way to move a file or folder is to click on the item, and
then drag it to the new location.

Using multiple tabs and multiple Nautilus windows

Opening multiple Nautilus windows can be useful for dragging files and
folders between locations. The option of tabs is also available in Nautilus,
as well as the use of panes. When browsing a folder in Nautilus, to open a
second window select File » New Window or press Ctrl+N. This will open a
new window, allowing you to drag files and folders between two locations.
To open a new tab, click File » New Tab or press Ctrl+T. A new row will
appear above the space used for browsing your files containing two tabs
—both will display the directory you were originally browsing. You can
click these tabs to switch between them, and click and drag files or folders
between tabs the same as you would between windows. You can also open
a second pane in Nautilus so you can see two locations at once without
having to switch between tabs or windows. To open a second pane, click
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You can also use the keyboard shortcuts
Ctrl+X, Ctrl+Cand Ctrl+V to cut, copy and
paste (respectively) files and folders.

When you “cut” or “copy” a file or folder,
nothing will happen until you “paste” it
somewhere. Paste will only affect the most
recent item that was cut or copied.

In the Nautilus Edit menu, you will also find
the Copy To and Move To buttons. These can
be used to copy or move items to common
locations, and can be useful if you are using
panes (see below). Note that it is unnecessary
to use Paste when using these options.

IF you click on a file or folder, drag it, and then
hold down the Alt key and drop it to your
destination folder, a menu will appear asking
whether you want to copy, move or link the
item. Notice that the symbol of the mouse
cursor changes from an arrow into a question
mark as soon as you hold down the Alt key

When dragging items between Nautilus
windows, tabs or panes, a small symbol will
appear over the mouse cursor to let you
know which action will be performed when
you release the mouse button. A plus sign

(+) indicates you are about to copy the item,
whereas a small arrow means the item will be
moved. The default action will depend on the
folders you are using.
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View » Extra Pane, or press F3 on your keyboard. Again, dragging files and
folders between panes is a quick way to move or copy items.

Searching for Files and Folders on your computer

You can search for files and folders using the Dash, the Launcher’s Files and
Folders lens or Nautilus.

Search for files and folders quickly by pressing
Ctrl+F in Nautilus and then typing what you
want to find.

Search using the Dash

In the Dash, click Search for Files. Open the drop-down menu on the right
side of the search bar. Select Folders, All Files, or one of the special folders,
e.g., Documents. It is sufficient to type the first few letters of the file or
folder you are searching for.

Search using the Launcher’s Files and Folders lens

Go to the Launcher’s Files and Folders lens. Open the drop-down menu on
the right side of the search bar. Select Folders, All Files, or one of the special
folders, e.g., Documents. It is sufficient to type the first few letters of the file
or folder you are searching for.

Search using Nautilus

In Nautilus, click Go » Search for Files, or press Ctrl+F. This opens the
search field where you can type the name of the file or folder you want to

find.

Customizing your desktop

System Settings

Figure 2.10: You can change most of your
system'’s settings here.
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Most customizations can be reached via the Session Indicator and then
selecting System Settings to open the System Settings application win-
dow. The Dash, Desktop appearance, Themes, Wallpapers, Screensavers,
Accessibility, and other configuration settings are available here. For more
information see Session options.
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You can change the background, fonts, and window theme to further
modify the look and feel of your desktop. To begin, open Appearance by
either right-clicking on your background and selecting Change Desktop
Background or selecting Session Indicator then System Settings then
Appearance .

Theme

The “Appearance” window will display the current selected background
wallpaper and theme when it opens. You may select a theme that will
control the appearance of your windows, buttons, scroll bars, panels, icons,
and other parts of the desktop. The Ambiance theme is used by default, but
there are other themes you can choose from. Just click once on the theme
you want to try. The theme will change immediately.

Desktop background

Under Background, you may choose from Wallpapers, Pictures Folder,
and Colors and Gradients. When Wallpapers is selected, you will see
Ubuntu’s default selection of backgrounds. To change the background
simply click the picture you would like to use. You’re not limited to this
selection though.

To use one of your own pictures, click the +... button, and navigate
to the image you want. Double-click it, and the change will take effect
immediately. This image will also then be added to your list of available
backgrounds.

If you are after a larger selection of desktop backgrounds, click the “Get
More Backgrounds Online” link at the bottom of the Appearance Prefer-
ences window. This link will open your web browser, and direct you to the
http://art.gnome.org/backgrounds website.

Accessibility

Ubuntu has built-in tools that make using the computer easier for people
with certain physical limitations. You can find these tools by opening the
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Figure 2.11: You can change the theme in the
Theme tab of “Appearance Preferences”.
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Dash and searching for “Universal Access” On the Seeing tab you can man-
age the text size, the contrast of the interfaces, enable a zoom tool and even
a screen reader. Selecting high-contrast themes and larger on-screen fonts
can assist those with vision difficulties. You can activate “Visual Alerts”
though the Hearing tab, if you have hearing impairment. Also you can ad-
just keyboard and mouse settings to suit your needs through the Typing
and Pointing and Clicking tabs respectively.

Universal Access

AllSettings

Seeing| Hearing| Typing| Pointing and Clicking

Display
Contrast: | Normal v Change contrast: No shortcut set
Textsize: Normal v Increase size: No shortcut set
Decrease size: No shortcut set
Zoom
 JorF Turn on or off: No shortcut set

Zoom in: No shortcut set
Zoom out: No shortcut set

Screen Reader
_ JorF Turn on or off: No shortcut set

Beep when Caps and Num Lock are used

Orca screen reader

Orca is a useful tool for people with visual impairments, and comes pre-
installed. To run Orca, click on the Dash and type Orca, and click on the
shown result. Orca is the Screen Reader of the Universal Access, and can
be launched once the “Screen Reader” is activated. Orca’s voice synthesizer
will activate and assist you through the various options such as voice type,
voice language, Braille, and screen magnification. Once you have finished
selecting your settings, you will need to log out of the computer (Orca will
offer to do this for you). When you log back in, the Orca settings you chose
will automatically run every time you use your computer.

Session options

When you have finished working on your computer, you can choose to log
out, suspend, restart, or shut down through the Session Indicator on the
far right side of the top panel. You can also quickly access these options by
pressing the Ctrl+Alt+Del keys.

Logging out

Logging out will leave the computer running but return you to the login
screen. This is useful for switching between users, such as when a different
person wishes to log in to their account, or if you are ever instructed to “log
out and back in again” You should save your work before logging out.

Figure 2.12: Universal allows you to enable
extra features to make it easier to use your
computer.



Suspend

To save energy, you can put your computer into suspend mode, which
will save its current condition and allow you to start more quickly while
remaining on but using very little energy. Suspending the computer spins

down the hard disk and saves your session to memory, so it is very quick to

suspend and resume from suspension.

Hibernate

Hibernate is similar to suspend, except that instead of saving your session
to memory, hibernate will save your session to the hard disk. This takes

a little longer, but with the added benefit that hibernation uses no power
while it is in a hibernated state.

Rebooting

To reboot your computer, select Shut Down... from the “Session Indicator”
and click on Restart.

Shut down

To totally power down your computer, select Shut Down... from the “Ses-
sion Indicator” and click on Shutdown.

Other options

From the Session Indicator, you can also select Lock Screen to require

a password before using the computer again—this is useful if you need
to leave your computer for some duration. You can also use the Session
Indicator to set up a guest session for a friend to try Ubuntu, or to switch
users to log into another user account without closing your applications.

Getting help

Ubuntu, just like other operating systems, has a built-in help reference,
called the Ubuntu Desktop Guide. To access it, click on the Dash and type
Help. Alternately, you can press F1 while on the desktop, or click Ubuntu
Help in the Top Bar.

If you can’t find an answer to your question in this manual or in the
Ubuntu Desktop Guide, you can contact the Ubuntu community through
the Ubuntu Forums (http://ubuntuforums.org).

Many Ubuntu users open an account on the forums to receive help, and
in turn provide support to others as they gain more knowledge. Another
useful resource is the Ubuntu Wiki (https://wiki.ubuntu.com), a website
maintained by the Ubuntu community.
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You can lock your screen quickly by using the
keyboard shortcut Ctrli+Alt+L. Locking your
screen is recommended if you move away from
your computer for a short amount of time.

Many applications have their own help which
can be accessed by clicking the Help menu
within the application window.

We encourage you to check any information
you find on other websites with multiple
sources when possible, but only follow direc-
tions if you understand them completely.
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Ubuntu Desktop Guide
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Welcome to Ubuntu 11.10

Use the Launcher to start
applications

Find apps, files, and music with the
Dash
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drives.
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accounts...

color management,
Bluetooth, disks...

Figure 2.13: The built-in system help provides
topic-based help for Ubuntu.



3 Working with Ubuntu

All the applications you need

If you are migrating from a Windows or Mac platform, you may wonder if

the programs that you once used are available. Some of the programs you

already use have native Linux versions. And, for those that don’t, there are

free and open-source applications that will cover your needs. This section

will recommend some alternates that will work well on Ubuntu. Most of You can search for more applications in the
the applications listed in this section are available via the Software Center. Ubuntu Software Center, by the category that
Those followed by an asterisk (*) can be downloaded directly from their youare interestedin

official websites.

Office Suites

» Windows: Microsoft Office, LibreOffice
» Mac OS: iWork, Microsoft Office, LibreOffice
» Linux: LibreOffice, KOffice, GNOME Office, Kexi (database application)

In Ubuntu you may choose among many office suites. The most popular
suite is the LibreOffice (formerly OpenOffice). Included in the suite:

» Writer—word processor

» Calc—spreadsheet

» Impress—presentation manager
» Draw—drawing program

» Base—database

» Math—equation editor

LibreOffice Suite is installed by default. Note that Base is not installed by
default and it can be installed through Ubuntu Software Center.

Email Applications

» Windows: Microsoft Outlook, Mozilla Thunderbird
» Mac OS: Mail.app, Microsoft Outlook, Mozilla Thunderbird
» Linux: Mozilla Thunderbird, Evolution, KMail

As with office suites, there are multiple options for email applications.
One very popular email application is Mozilla Thunderbird, which is also
available for Windows. Thunderbird is the default email application in
Ubuntu. Another option is Evolution—similar to Microsoft Outlook, it also
provides a calendar.

Web Browsers

» Windows: Microsoft Internet Explorer, Mozilla Firefox, Opera, Chromium,
Google Chrome
» Mac OS: Safari, Mozilla Firefox, Opera, Chromium, Google Chrome
» Linux: Mozilla Firefox, Opera®, Chromium, Google Chrome*, Epiphany
Opera is available for download from http://
The most popular web browsers can be installed directly from the www.opera.com/browser/download/. Google

Chrome is available for download from https/
Ubuntu Software Center. Jchrome.google.com.


http://www.opera.com/browser/download/
http://www.opera.com/browser/download/
https//chrome.google.com
https//chrome.google.com
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PDF Readers

» Windows: Adobe Reader
» Mac OS: Adobe Reader
» Linux: Evince, Adobe Reader, Okular

Evince is a user-friendly and minimalistic reader, and it is the default
PDF reader. If Evince doesn’t cover your needs, Adobe Reader is available
for Ubuntu too.

Multimedia Players

» Windows: Windows Media Player, VLC
» Mac OS: Quicktime, VLC
» Linux: Totem, VLC, Mplayer, Kaffeine

For multimedia, Ubuntu users have a wide variety of options for high
quality players. Two popular and powerful media players for Ubuntu are
VLC and Mplayer. Meanwhile, the classic and user-friendly Totem is the
default media player in Ubuntu.

Music Players and Podcatchers

» Windows: Windows Media Player, iTunes, Winamp
» Mac OS: iTunes
» Linux: Banshee, Rhythmbox, Amarok, Audacity, Miro

There are several options for listening to music with Ubuntu: Banshee
(installed by default), Rhythmbox, and Amarok, among others. With these
you can listen to music and your favorite podcasts. Audacity is similar to
Winamp. There is Miro for those of you who watch video podcasts and TV
series from the Internet.

CD/DVD Burning

» Windows: Nero Burning ROM, InfraRecorder
» Mac OS: Burn, Toast Titanium
» Linux: Brasero, K3b, Gnome-baker, Nero Burning ROM*

The are several popular disk burning applications such as Gnome-baker,
Brasero, Ubuntu’s default CD burner, and K3b. These burners are powerful
tools, offering user-friendly interfaces, many features and they are all open
source and free of charge! Also Nero Burning ROM is available for Linux,
but you have to buy it.

Photo Management

» Windows: Microsoft Office Picture Manager, Picasa
» Mac OS: Aperture, Picasa
» Linux: Shotwell, gThumb, Picasa*, Gwenview, F-Spot

You can view and manage your favorite photos with Shotwell, Ubuntu’s
default photo manager, or with gThumb, Picasa, Gwenview, and Fspot.

Picasa is available for download from http://
picasa.google.com/linux/.


http://picasa.google.com/linux/
http://picasa.google.com/linux/
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Graphics Editors

» Windows: Adobe Photoshop, GIMP
» Mac OS: Adobe Photoshop, GIMP
» Linux: GIMP

GIMP is a very powerful graphics editor. You can create your own
graphics, taper your photographs, modify your pictures. GIMP, a power-
ful alternative to Photoshop, covers the needs of novice users, professional
photographers, and designers.

& GIMP is not loaded by default, but can be installed via the Software Center.

Instant Messaging

» Windows: Windows Live Messenger, AIM, Yahoo! Messenger, Google
Talk

» Mac OS: Windows Live Messenger, AIM, Yahoo! Messenger, Adium,
iChat

» Linux: Empathy, Pidgin, Kopete, aMSN

None of the other platform IM clients have Linux versions. However,
you can use Pidgin, Empathy or Kopete to communicate over most proto-
cols including: AIM, MSN, Google Talk (Jabber/XMPP), Facebook, Yahoo!,
and ICQ. This means you need only one client to communicate with all of
your friends. The drawback is that some of these clients have limited video
support. If you are using MSN exclusively, aMSN may be worth a try.

VolIP Applications

» Windows: Skype, Google Video Chat
» Mac OS: Skype, Google Video Chat
» Linux: Ekiga, Skype, Google Video Chat

VoIP technologies allow you to talk to people over the Internet. The
most popular such application is Skype, which is available for Linux. An
open-source alternative Ekiga supports voice communication using the SIP
protocol. Note that Ekigka isn’t compatible with the Skype.

BitTorrent Clients

» Windows: uTorrent, Azureus
» Mac OS: Transmission, Azureus
» Linux: Transmission, Deluge, Azureus, KTorrent

There are a number of BitTorrent clients for Ubuntu: Transmission,
Ubuntu’s default client, is simple and light-weight, Deluge, Azureus and
KTorrent offer many features and can satisfy the most demanding of users.

Getting online

If you are in a location with Internet access, you will want to make sure
you are connected in order to get the most out of your Ubuntu operating
system. This section of the manual will help you check your connection and
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configure it where necessary. Ubuntu can connect to the Internet using a
wired, wireless, or dialup connection. It also supports some more advanced
connection methods, which we will briefly discuss at the end of this section.

A wired connection refers to when your computer is physically con-
nected to a router or an Ethernet port with a cable. This is the most com-
mon connection for desktop computers.

A wireless connection is when your computer is connected to the Inter-
net via a wireless radio network, also known as Wi-Fi. Laptop computers
commonly use Wi-Fi due to portability, making it easy to access the Inter-
net from different rooms in the house or when traveling.

In order to connect wirelessly, you must be in a location with a working
wireless network. To have your own, you will need to purchase and install
a wireless router or access point. Some locations may already have a publicly
accessible wireless network available.

A dialup connection is when your computer uses a modem to connect to
an Internet service provider through your telephone line.

NetworkManager

In order to connect to the Internet in Ubuntu, you need to use the Network-
Manager utility. NetworkManager allows you to turn all networking on or
off, and helps you manage your wired, wireless, and other connections.

You can access all the functions of NetworkManager using its icon in
the top panel. This icon may look different depending on whether you cur-
rently have a working connection, and whether the connection is wired or
wireless. If you are unsure, try hovering your mouse over the icon until a
short description appears near the cursor. This will read “Wired network
connection ‘Auto eth(0’ active” (for example) if you have a working wired
connection, or otherwise something else related to networking or connec-
tions such as “No connection” or “Networking disabled.”

Clicking this icon will bring up a list of network connections that are
available to you. If you are currently connected to the Internet, the name of
this connection will be highlighted in bold.

This menu also includes options to let you enable or disable networking,
view technical details about your current connection, or edit all connection
settings. In the image above, the check box next to Enable Networking is
currently selected; you can deselect it to disable all network connections.
This may be useful if you need to shut off all wireless communication, such
as when in an airplane.

Establishing a wired connection

If you have an Ethernet cable running from a wall socket, a router, or some
other device, then you will want to set up a wired network connection in
Ubuntu.

In order to connect with a wired connection, you need to know whether
your network connection supports pHCP. Dynamic Host Configuration
Protocol, is a way for computers on your network to automatically receive
configuration information from your Internet service provider (1sp). This is
usually the quickest and easiest way of establishing a connection between
your computer and your 1sp in order to access the Internet, although some
1sps may provide what is called a static address instead. If you are unsure
whether your 1sp supports DHCP, you may wish to contact their customer
service line to check. They will also be able to provide you with information

If you are unsure whether your computer has a
wireless card, check with your manufacturer.

Figure 3.1: NetworkManager will display this
icon in the top panel when you are connected
to a wired network.
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Auto etho
Disconnect

VPN Connections
+ Enable Networking

Connection Information
Edit Connections...

Figure 3.2: Here you can see the currently
active "auto eth0” connection listed in the
NetworkManager menu.

Are you already online? If the NetworkManager
icon in the top panel shows a connection, then
you may have successfully connected during the
installation process. If so, you do not need to
follow the rest of this section.



on your static address if one has been allocated to you (in many cases 1spPs
only allocate static addresses to customers upon request).

Automatic connections with DHCP

If your network supports DHCP, you may already be set up for online access.
To check this, click on the NetworkManager icon. There should be a “Wired
Network” heading in the menu that is displayed. If “Auto eth0” appears
directly underneath, then your computer is currently connected and prob-
ably already set up correctly for pucp. If “disconnected” appears in gray
underneath the wired network section, look below to see if an option la-
beled “Auto eth0” appears in the list. If so, click on it to attempt to establish
a wired connection.

To check if you are online, click on the NetworkManager icon in the top
panel and select the Connection Information option.

You should see a window showing details about your connection. If your
1p address is displayed as 0.0.0.0 or starts with 169.254, then your computer
was not successfully provided with an address through pacp. If it shows
another address, it is most likely that your connection was automatically
configured correctly. To test out your Internet connection, you may want to
open the Firefox web browser to try loading a web page. More information
on using Firefox can be found later in this chapter.

If you are still not online after following these steps, you may need to try
setting up your Internet configuration manually, using a static 1p address.

Manual configuration with static addresses

If your network does not support pDHCP, then you need to know a few items
of information before you can get online.

» An 1P address is a unique address used for identifying your computer on
the Internet. When connecting through pHcp this is likely to change at
times. However, if your 1sp has provided you with a static address then
it will not. An 1p address is always given in the form of four numbers
separated by decimal points, for example, 192.168.0.2.

» The network mask tells your computer how large the network is that
it belongs to. It takes the same form as an 1p address, but is usually
something like 255.255.255.0

» 'The gateway is the 1p address at your 1sp’s end. It helps your computer
connect or “talk” with their network, which acts as a “gateway” between
your computer and the Internet.

» DNS servers are one or more IP addresses of “Domain Name System”
servers. These servers convert standard web addresses (like http://www.
ubuntu.com) into 1p addresses such as 91.189.94.156. This step allows
your computer to “find” the correct web site when you enter the web
address you wish to visit. A minimum of one DNs server is required, up
to a maximum of three. The additional ones are used in case the first one
fails.

To manually configure a wired connection, click on the NetworkManager
icon and select Edit Connections. Make sure you are looking at the Wired
tab inside the “Network Connections” window that is displayed.

The list may already have an entry such as “Auto eth0,” or a similar
name. If a connection is listed, select it and then click the Edit button. If no
connection is listed, click the Add button instead.

WORKING WITH UBUNTU 39

@@ connection Information

@ Active Network Connections
Auto etho (default)

General

Interface: Ethernet (etho)
Hardware Address: 00:0D:87:76:41:DE
Driver: sis900

Speed: 100 Mb/s
Security: None

1Pv4

IP Address: 192.168.2.4
Broadcast Address: 192.168.2.255
Subnet Mask: 255.255.255.0
Default Route: 192.168.2.1
Primary DNS: 192.168.2.1

1Pv6
Ignored

| close |

Figure 3.3: This window displays your IP address
and other connection information.

An Internet Protocol (IP) address is a numerical
label assigned to devices on a computer
network. It is the equivalent of phone numbers
for your house and allows your computer to

be uniquely identified so you can access the
Internet and share files with others.

To access the “Connection Information”
window, you will need to make sure that
networking is enabled. Otherwise this option
will be gray and you will not be able to select
it through the menu of the NetworkManager
icon. To enable networking, click on the
NetworkManager icon and select Enable
Networking from the popup menu.

If you do not already have these settings, you
will need to consult your network administrator
or ISP customer support to receive them.
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If you are adding a connection, you first need to provide a name for the
connection so you can distinguish it from any others that are added later. In
the “Connection name” field, choose a name such as “Wired connection 1.

To set up the connection:

1. Under the connection name, make sure that the Connect automatically

option is selected.

Switch to the 1pv4 Settings tab.

Change the Method to “Manual””

Click on the Add button next to the empty list of addresses.

Enter your 1p address in the field below the Address header.

Click to the right of the 1p address, directly below the Netmask header,

and enter your network mask. If you are unsure of your network mask,

“255.255.255.0” is the most common.

7. Click to the right of the network mask, directly below the Gateway
header, and enter the address of your gateway.

8. In the DNs servers field below, enter the addresses of your pns server. If
your network has more than one DNs server, enter them all, separated by
spaces or commas.

9. Click Apply to save your changes.

S AL

A MAC address is a hardware address for your computer’s network card, and
entering it is sometimes important when using a cable modem connection or
similar. If you know the MAc address of your network card, this can be entered in
the appropriate text field in the Wired tab of the editing window.

When you have returned to the Network Connections screen, your
newly-added connection should now be listed. Click Close to return to the
desktop. If your connection is configured correctly, the NetworkManager
icon should have changed to show an active connection. To test if your
connection is properly set up, refer to the instructions above for checking a
DHCP connection.

Wireless

If your computer is equipped with a wireless (Wi-Fi) card and you have a
wireless network nearby, you should be able to set up a wireless connection
in Ubuntu.

Connecting to a wireless network For the Ffirst time

If your computer has a wireless network card, you should be able to connect
to a wireless network. Most laptop and netbook computers have a wireless
network card.

Ubuntu is usually able to detect any wireless networks that are available
within range of your wireless card. To see a list of wireless networks, click
on the NetworkManager icon. Under the “Wireless Networks” heading, you
should see a list of available wireless networks. Each network will be shown
with a name on the left, and a signal meter on the right. A signal meter
looks like a series of bars—the more bars that are filled in, the stronger the
connection will be.

A wireless network may be open to anyone to connect, or may be pro-
tected with network security. A small padlock will be displayed next to the

®®® Editing Auto etho

Connection name: |Auto etho
[ Connect automatically

Wired | 802.1x Security | IPv4 Settings | IPv6 Settings

Method: | Automatic (DHCP)

DHCP client ID:
& Require IPv4 addressing for this connection to complete

Routes...

& Available to all users Cancel Save...

Figure 3.4: In this window you can manually edit
a connection.

To improve speed and reliability of your
connection, try to move closer to your router or
access point.
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signal meter of any wireless networks that are protected. You will need to
know the correct password in order to connect to these.

To connect to a wireless network, select the desired network’s name
from the list. This will be the name that was used when the wireless router
or access point was installed. If you are in a workplace or a location with a
publicly accessible wireless network, the network name will usually make it
easy to identify.

If the network is unprotected (i.e., the network signal meter does not
display a padlock), a connection should be established within a few seconds.
The NetworkManager icon in the top panel will animate as Ubuntu attempts
to establish a connection. If it connects successfully the icon will change
to display a signal meter. A notification message in the upper right of your
screen will also appear, informing you that a connection was established.

If the network is secured, Ubuntu will display a window called “Wireless
Network Authentication Required” once it tries to connect. This means that
a password is required in order to connect.

Wireless Network Authentication Required Figure 3.5: Enter your wireless network
Authentication required by wireless network passphrase.

Passwords or encryption keys are required to access the wireless network
‘ThomsonFCDBF1'.

Show password

Cancel | | Connect |

If you know the password, enter it in the Password field, and then click
Connect. As you type your password, it will be obscured to prevent others
from seeing it. If you prefer, you can select the Show password option to
see the password as you type.

After you click the Connect button, the NetworkManager icon in the top
panel will animate as it tries to connect to the network. If you have entered
the correct password, a connection will be established and the Network-
Manager icon will change to show signal meter bars. Again, Ubuntu will
display a pop up message in the upper right of your screen informing you
that a connection was established.
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If you entered the wireless network’s password incorrectly, Network- Select the Show Password option to make sure
Manager will attempt to establish a connection then return to the “Wireless you haven’t made a mistake when entering the

c . . » . d.
Network Authentication Required” window. You can attempt to enter the passwor

correct password again, or click Cancel to abort your connection. If you do
not know the password to the network you have selected, you will need to
get the password from the network administrator.

Once you have successfully established a wireless network connection,
Ubuntu will store these settings (including the network password) in order
to make it easier to connect to the same wireless network in future. You
may also be prompted to select a keyring password here. The keyring stores
network and other important passwords in the one place, so you can access
them all in future by just remembering your keyring password.

Connecting to a saved wireless network

If you have previously successfully established a wireless connection, that
connection’s password will be saved on your computer. This will allow you
to connect to the same network without having to re-enter the password.
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In addition, Ubuntu will automatically try to connect to a wireless net-
work within range if it has its settings saved. This will work for both open
and secured wireless networks.

If you have many saved wireless networks that are in range, Ubuntu
may choose to connect to one of them, while you may prefer to connect to
another. In this case, click on the NetworkManager icon. You should see a
list of wireless networks in range, along with their signal meters. Click on
your desired network.

If the password and other settings have not changed, Ubuntu will con-
nect to the wireless network you chose. If the password has changed,
Ubuntu will open the “Wireless Network Authentication Required” win-
dow. In this case, follow the instructions in the previous section.

Connecting to a hidden wireless network

In some circumstances, you may need to connect to a hidden wireless net-

work. These hidden networks do not broadcast their names, which means

that they will not show up in the list of wireless networks in the Network-

Manager menu. In order to be able to connect to a hidden network, you will

need to get its name and security settings from your network administrator.
To connect to a hidden network:

1. Click on the NetworkManager icon in the top panel.

2. Select the Connect to Hidden Wireless Network option. Ubuntu should
open the “Connect to Hidden Wireless Network” window.

3. By default, the Connection field should show “New..”—you can leave
this unchanged.

4. In the Network name field, enter the name of the wireless network. This
name is also known as a ssip. Please enter the network name exactly as
it was given to you.

5. In the Wireless security field, select one of the options. If the network
is open, leave this field as “None.” If you do not know the correct setting
for the network you will not be able to connect to the hidden network.

6. Click on the Connect button.

The rest of the process should work exactly as in the section on the
initial connection to wireless networks. Once set up according to the in-
structions above, the hidden network should show up in the list of saved
networks.

Disabling and enabling your wireless network card

Wireless access in Ubuntu is enabled by default if you have a wireless
network card in your computer. In certain cases, for example on airplanes,
you may need or be required to turn your wireless radio off.

To do this, click on the NetworkManager icon, and deselect the Enable
Wireless option. Your wireless network will be turned off, and your com-
puter will no longer search for available wireless networks.

To turn wireless networking back on, click on the NetworkManager icon,
and click on the Enable Wireless option to re-select it. Your wireless net-
work will be turned back on. Ubuntu will then search for nearby wireless
networks and will connect to any saved networks within range.

Some computers may have a physical switch or
button to turn off Wi-Fi.
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Changing an existing wireless network

At times, you may want to change the settings for a wireless connection
that you have previously saved. Its password may have changed, or your
system administrator asked you to change some networking or security
settings.

To edit a saved wireless network connection:

1. Click on the NetworkManager icon and select Edit Connections...

10.

A “Network Connections” window should open. Click on the Wireless
tab to see a list of saved wireless connections.

By default, this list shows connections in the order of most recently used
to least recently used. Find the connection you want to edit, click on it,
and then click Edit.

Ubuntu should open a window called “Editing (connection name)”, where
(connection name) is the name of the connection you are editing. The
window should display a number of tabs.

Above the tabs, you may change the Connection name field if you want
to give the connection a more recognizable name.

If the Connect automatically option is not selected, Ubuntu will detect
the wireless network but will not automatically connect to it without
you choosing it from the NetworkManager menu. Select or deselect this
setting as needed.

On the Wireless tab of the “Editing (connection name)” window, you
may need to edit the ssiD field. A ssID is the wireless connection’s net-
work name—if set incorrectly, the network may not be detected and

a connection may not be made. Please make sure that the ssp is set
according to your network administrator’s instructions.

Below the ssip, you should see the Mode field. The “Infrastructure”
mode means that you would be connecting to a wireless router or access
point. This is the most common mode for wireless networks. The “Ad-
hoc” mode is a computer-to-computer mode and is often only used in
advanced cases.

On the Wireless Security tab of the “Editing (connection name)” win-
dow, you may need to change the Security field to the correct setting.

A selection of None means that you are using an open network with

no security. Other selections may require slightly different additional
information:

WEP 40/128-bit Key is an older security setting still in use by some wire-
less networks. If your network uses this security mode, you will need
to enter a key in the Key field that should appear after you select this
mode.

WEP 128-bit Passphrase is the same older security setting as the entry
above. However, instead of a key, your network administrator should
have provided you with a text passphrase—a password—to connect
to the network. Once you select this security mode, you will need to
enter your passphrase in the Key field.

wprA & WpAz Personal is the most common security mode for wireless
network connections at home and at businesses. Once you select this
mode, you will need to enter a password in the Password field.

If your network administrator requires LEAP, Dynamic WEP, or WPA
& wpaz2 Enterprise security, you will need to have the administrator
help you set up those security modes.

On the 1pv4 Settings tab, you may need to change the Method field
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from “Automatic (DHCP)” to “Manual,” or one of the other methods. For
setting up manual settings (also known as static addresses), please see
the section above on manual set up for wired network connections.

11. When you finish making changes to the connection, click Apply to save
your changes and close the window. You can click Cancel to close the
window without making changes.

12. Finally, click Close on the “Network Connections” window to return to
the desktop.

After making changes, your new settings should go into effect immedi-
ately.

Other connection methods

There are other ways to get connected with Ubuntu.

With NetworkManager, you can also configure Mobile Broadband con-
nections to keep online through your cellular or other mobile data carrier.
You can also connect to psts (Digital Subscriber Lines), which are a
method of Internet connection that uses your telephone lines and a “Dst

modem”

It’s also possible to use NetworkManager to establish a veN (Virtual
Private Network) connection. These are commonly used to create secure
connectivity to a workplace.

The instructions for making connections using mobile broadband, vens,
or DsLs, are beyond the scope of this guide.

Browsing the web

Once you have connected to the Internet, you should be able to browse the
web with Ubuntu. Mozilla Firefox is the default application for browsing the
web in Ubuntu.

Ubuntu Start Page - Mozilla Firefox EHen B § = ) T:40PM R c7p 3

L1 Ubuntu Start Page
| about:startpage MR B Ql @

Google

Search

Ubuntu help > Ubuntu shop Ubuntu communit

A VPN is a “Virtual Private Network,” and is
sometimes used to help secure connections.
DSLs are “Digital Subscriber Lines,” a type of
broadband connection.

Figure 3.6: The default Ubuntu home page for
the Firefox web browser.



Starting Firefox

To start Firefox, click on the Dash (the top-most icon in the Launcher) and
either search for ‘firefox’ using the search box or click on the ‘Browse the
Web’ button. If your keyboard has a “www” button, you can also press that
button to start Firefox.

Navigating web pages
Viewing your homepage

When you start Firefox, you will see your home page. By default, you will
see the Ubuntu Start Page.
To go to your home page quickly, press Alt+Home.

Navigating to another page

To navigate to a new web page, you need to enter its Internet address (also
known as a URL) into the Location Bar. URLs normally begin with “http://”
followed by one or more names that identify the address. One example is
“http://www.ubuntu.com/””

== ubuntu-manual.org MRk B Q @

To navigate:

1. Click on the Location Bar to select the URL that is already there.

2. Enter the UrL of the page you want to visit. The URL you type replaces
any text already in the Location Bar.

3. Press Enter.

To quickly select the URL of the Location Bar, press Ctri+L.

If you don’t know a URL, try typing something specific to the page you
want to visit (for example a name or other search request) into the Location
Bar and press Enter. This will search your preferred search engine—Google
by default—for that term, and take you to the web page that is the top result
from the search.

Clicking a link

Most web pages contain links you can click to move to other pages.
To click a link:

1. Move the mouse pointer until it changes to a pointing finger. This hap-
pens whenever the pointer is over a link. Most links are underlined text,
but buttons and pictures on a web page can also be links.

2. Click on the link once. While Firefox locates the link’s page, status
messages will appear at the bottom of the window.

Retracing your steps

If you want to visit a page you have seen before, there are several ways to
do so.

» To go back or forward one page, click on the Back or Forward button, at
the left side of the Location Bar.
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URL stands for uniform resource locator and
WWW stands for world wide web.

Figure 3.7: You can enter a web address or
search the Internet by typing in the location
bar.

To go backwards and forwards you can also use
Alt+Left to go backwards or Alt+Right to go
forwards.
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» To go back or forward more than one page, click on the small trian-
gle next to the Forward button. You should see a list of pages you’ve
recently visited. To return to a page, select it from the list.

» To see a list of any URLs you’ve entered into the Location Bar, click on
the down arrow at the right end of the Location Bar. To view a page,
select it from the list.

» To choose from pages you’ve visited during the current session, open
the History menu and choose from the list in the bottom section of the
menu.

» To choose from pages you’ve visited during the past several sessions,
open the History menu and select Show All History. Firefox should
open a “Library” window, which shows a list of folders. Click on the
folders to displays sub-folders, or titles of web pages you’ve visited in the
past. Click on a page’s title to view that page.

Stopping and reloading

If a page is loading too slowly or you no longer wish to view a page, click
on the Stop button or press Esc.

To reload the current page or to get the most up-to-date version, click on
the Reload button or press Ctri+R.

Opening new windows

At times, you may want to have more than one browsing window. This may
help you organize your browsing session better, or separate web pages that
you are viewing for different reasons.

There are three ways to create a new window:

» On the top bar, open the File menu, then select New Window.

» Right-click on the Firefox’s icon on the Launcher, and then select Open
New Windows

» Press Ctri+N.

Once a new window has opened, you can use it just like the first window
—including navigation and opening tabs.

Opening a link in a new window

Sometimes, you may want to click on a link to navigate to another web
page, but do not want the original page to close. To do this, you can open
the link you’d like to click in its own window.

There are two ways to open a link in its own window:

» Right-click on a link to open its popup menu. Select the Open Link in
New Window option. A new window will open, containing the web
page for the link you clicked.

» Press-and-hold the Shift key while clicking a link. This will also open
the web page in a new window.

Tabbed browsing

If you would like to visit more than one web page at a time, you can use
Tabbed Browsing to navigate the web.

Tabbed browsing lets you open several web pages within a single Firefox
window, each displaying in its own tab. This frees up space on your desktop

Stop and Reload buttons are at the right end of
the Location Bar.
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since you don’t have to have a window open for every web page you’re
currently visiting. You can open, close, and reload web pages in one place
without having to switch to another window.

You can alternate quickly between different tabs by using the keyboard
shortcut Ctrl+Tab.

Opening a new blank tab
There are three ways to create a new blank tab:

» Click on the Open new tab button on the right side of the last tab.
» On the top bar, open the File menu, and then select New Tab.
» Press Ctri+T.

When you create a new tab, it will contain a blank page with the Loca-
tion Bar focused. Start typing a web address (URL) or other search term to
open a website in the new tab.

Opening a link in its own tab

Sometimes, you may want to click on a link to navigate to another web
page, but do not want the original page to close. To do this, you can open
the link you’d like to click in its own tab.

There are many ways to open a link in its own tab:

» Right-click on a link to open its popup menu. Select the Open Link in
New Tab option. A new tab will open, containing the web page for the
link you clicked.

» If your mouse has a middle button, or a wheel, click on the link with the
middle mouse button or wheel. A new tab should open, containing the
web page for the link you clicked.

» Press-and-hold the Ctrl key while clicking the left mouse button on the
link. A new tab should open, containing the web page for the link you
clicked.

» Click on a link, holding both left and right mouse buttons.

» Click on the link with the left mouse button, and keep holding down
the mouse button. Drag the link up to a blank space on the tab bar, and
release the mouse button. A new tab should open, containing the web
page for the link you dragged.

Closing a tab

Once you have finished viewing a web page in a tab, you can close that tab.
There are various ways to close a tab:

» Click on the Close button on the right side of the tab you want to close.

» Open the File menu, and then select Close Tab.

» Click on the tab you want to close with the middle mouse button, or the
mouse wheel, if you have one.

» Press Ctril+Ww.

» Click on the tab with both mouse buttons.

Restoring a closed tab

Sometimes, you may close the wrong tab by accident, or want to bring back
a tab that you’ve recently closed.
To bring back a tab you’ve closed, do one of the following:
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» Open the History menu, select Recently Closed Tabs, and then choose
the name of the tab you want to restore.
» Press Ctrl+Shift+T to re-open the most recently closed tab.

Changing the tab order

To move a tab to a different location on the tab bar, drag it there using your
mouse. Click-and-hold on the tab and drag the tab to a new place on the tab
bar. While you are dragging the tab, Firefox will display a small indicator to

show where the tab will be moved. When moving a tab to a new window it may
reload the page. Remember to save your work
before doing this.

Moving a tab between windows

If you have more than one Firefox window open, you can move an open
tab to a different window. You can also split a tab off to become its own
window.

To move a tab from one Firefox window to another already open win-
dow, click-and-hold on the tab and drag it to the tab bar on the other Fire-
fox window. When you release the mouse button, the tab will be attached
to the new window.

To move a tab from one window into its own window, click-and-hold
on the tab and drag the tab below the tab bar. When you release the mouse
button, the tab will become a new window.

Searching

You can search the web, or other collections, from within Firefox without
first visiting the home page of the search engine.
By default, Firefox will search the web using the Google search engine.

Searching the web

To search the web in Firefox, type a few words into the Firefox search Bar.
For example, if you want to find information about the Ubuntu:

1. Click on the Search Bar.

2. Type the phrase “Ubuntu.” Your typing replaces any text currently in the
Search Bar.

3. Press Enter to search.

Search results from Google for “Ubuntu” should appear in the Firefox
window.

B3 Amazon.com

Selecting search engines & ask.com

¥ eBay
. . wikipedia (en)
If you do not want to use Google as your search engine in the Search Bar,

you can change the search engine that Firefox uses.
To change the search engine, click on the icon on the left side of the ) )
. . . Figure 3.8: These are the other search engines
Search Bar. Choose one of the other search engines in the list. Some search you can use—by deFault—from the Firefox
engines, like Google, Yahoo, Bing search the whole web; others, like Ama- search bar.

zon.com, Wikipedia only search specific sites. The Ubuntu home page’s search bar uses
Google by default, but will automatically use

Yahoo if Yahoo is selected in the Search Bar.

Manage Search Engines...

Searching the web For words selected in a web page

Sometimes, you may want to search for a phrase that appears on a different
web page. Instead of copying and pasting the phrase into the Search Bar,



Firefox allows you to search the web for words you select within a web
page.

1. Highlight any words in a web page using your left mouse button.
2. Right-click on the text you’ve highlighted to open a popup menu. Select
the option Search [Search Engine] for “[your selected words]”.

Firefox should open a new tab containing search results for your high-
lighted words, found using the currently selected search engine.

Searching within a page

ubuntu®

¥ Find: Match case

You may want to look for specific text within the web page you are
viewing. To find text within the current page in Firefox:

1. Press Ctrl+F or choose Edit » Find to open the Find Toolbar at the bot-
tom of Firefox.

2. Enter the text you want to find into the Find field in the Find Toolbar.
The search automatically begins as soon as you type something into the
field.

3. Once some text has been matched on the web page, you can:

» Click Next to find text in the page that is below the current cursor
position.

» Click Previous to find text that is above the current cursor position.

» Click on the Highlight all button to highlight occurrences of your
search words in the current page.

» Select the Match case option to limit the search to text that has the
same capitalization as your search words.

To find the same word or phrase again, press F3 or click on the Edit
menu and select Find Again.

Viewing web pages full screen

To display more web content on the screen, you can use Full Screen mode.
Full Screen mode condenses the Firefox’s toolbars into one small toolbar. To
enable Full Screen mode, simply choose View » Full Screen or press F11.

Copying and saving pages

With Firefox, you can copy part of a page so that you can paste it elsewhere,
or save the page or part of a page as a file on your computer.

Copying part of a page

To copy text from a page:

1. Highlight the text and/or images with your mouse.
2. Right click on highlighted text and select Copy or press Ctri+C.
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Figure 3.9: You can search within web pages
using the Find Toolbar.
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You can paste the text into other applications.
To copy a text or image link (URL) from a page:

1. Position the pointer over the link or image.

2. Right-click on the link or image to open a popup menu.

3. Select Copy Link Location. Note that if the image works as a link you
can copy you would have to select Copy Image Location

You can paste the link into other applications or into Firefox’s Location Bar.

Saving all or part of a page

To save an entire page in Firefox:

1. Choose File » Save Page As from the top bar. Firefox should open the
“Save As” window.

2. Choose a location for the saved page.

3. Type a file name for the page, and click Save.

To save an image from a page:

Position the mouse pointer over the image.

Right-click on the image to display a popup menu.

Select Save Image As. Firefox should open the “Save Image” window.
Choose a location for the saved image.

Enter a file name for the image and click Save.

EANL L S

Changing your homepage

By default, Firefox will show the Ubuntu Start Page when you start Firefox.
If you prefer to view another page when you start Firefox, you will need to
change your homepage preference.

> Firefox Preferences

: = Q 3 =

afl = B K ™ & @0 &

Tabs  Content Applications Privacy Security Sync  Advanced

Startup

When Firefox starts: | Show my home page

Home Page: | about:startpage

Use Current Page | |Use Bookmark | |Restore to Default

Downloads

& Show the D ds window when d loading a file
Close it when all downloads are finished
@ Sayefilesto |[@ Downloads Browse...
Always ask me where to save files
Add-ons
Change preferences For your add-ons Manage Add-ons...
Help Close

To change your homepage:

1. Navigate to the page that you would like to become your new homepage.

2. Choose Edit » Preferences from the top bar.

Figure 3.10: You can change Firefox settings in
this window.
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3. In the “Startup” section on the General tab, which is shown by default,
click on the Use Current Page button. If you had more than one tab
open then all the tabs will be opened when Firefox starts. If you prefer to

have one page open, close the other tabs and repeat steps 2—4. The homepage can also be set by entering the
4. Click Close. addresses that should be open in the Home
Page, with a pipe—|—separating pages to be
opened in a new tab

Download settings

In Edit » Preferences you can change how Firefox behaves with downloads. The Downloads window shows the progress
You can tell Firefox where to place downloaded files, or to ask where each of currently downloading files, and lists files
. . . 5 . downloaded in the past. It can be used to open
time. You can also set the behavior of Firefox’s Downloads window. The ) '
or re-download files.
Downloads window can be hidden entirely, or set to hide when downloads
finish.

Bookmarks

When browsing the web you may want to come back to certain web pages
again without having to remember the URL.

In Firefox, you can create bookmarks, which are saved in the web browser
and which you can use to navigate back to your picked web pages.

Bookmarking a page

After navigating to a web page you can save its location by bookmarking it.
There are two ways to bookmark a page:

» From the top bar, choose Bookmarks » Bookmark This Page. A window
will open. Provide a descriptive name for the bookmark, and click on the
Done button.

» Press Ctrl+D. A pop-up will appear. Provide a descriptive name for the
bookmark, and click on the Done button.

Navigating to a bookmarked page

To navigate to a bookmarked page, open the Bookmarks menu from the
top bar , and then choose your bookmark’s name. Firefox should open the
bookmark in the current tab.

You can also press Ctrl+B to display bookmarks in a sidebar on the left side of
the browser window. Press Ctrl+B again to hide the sidebar.

Deleting a bookmark

If you would like to delete a bookmark that you have previously made,
open the Bookmarks menu from the top bar, and then right-click on your
bookmark’s name. Firefox should open a popup menu for your bookmark.
Select the Delete option from the menu. Your bookmark should then be
deleted.

History

Whenever you are browsing the web, Firefox is saving your browsing his-
tory. This allows you to come back to a web page that you have recently
visited, without needing to remember the page’s URL, or even bookmarking
it.
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To see your most recent history, open the History menu from the top
bar. The menu should then display several of the most recent web pages
that you were viewing. Choose one of the pages to return to it.

To see the web pages you have visited recently, press Ctri+H. Firefox will
open a “sidebar” on the left side of the browser window, that contains your
browsing history, categorized as “Today,” “Yesterday,” “Last 7 days,” “This
month,” the past 6 months (listed month by month), and finally “Older than
6 months.” If history for a category does not exist, that category will not be
listed.

Click on one of the date categories in the sidebar to expand it. Then it
will reveal the pages you visited during that period. Then, once you find the
page you need, click on its title to return to it.

You can also search for a page by its title. Enter a few letters, or a word,
in the Search field at the top of the history sidebar. The sidebar should then
display a list of web pages whose titles match your search words. Click on
the title of the page you need to return to it.

If you would like to hide the history sidebar again, press Ctrl+H again.

Clearing private data

At times, you may want to delete all private data that Firefox stores about
your browsing history. While this data is stored only on your computer, you
may want to remove it if you share access to your computer.

To delete your private data, open the Tools menu from the top bar, and
select Clear Recent History. In the drop down list for the Time range to
clear, choose how far back you would like Firefox to delete.

If you would like more control over what you clear, click on the Details
text to display a list of options.

When done, click on the Clear Now button.

Using a different web browser

System Info Figure 3.11: You can change the default
All settings browser with the “System Info” utility. To use it,
open System Info from System Settings... -click
Overview on Session Indicator, on the top right corner of
Web | @ Firefox Web Browser | v
your screen-.
Graphics
Mail | €9 Thunderbird Mail -
Calendar ||# gedit -
Music | 5 Banshee -
Video | B Movie Player v
Photos &, Image Viewer v

If you install a different web browser on your computer, you may want
to use it as the default browser when you click on links from emails, instant
messages, and other places.

To change your preferred web browser, open click on the Session In-
dicator and then search for “System Info,” and open it. Then click on “De-
fault Applications” from the sidebar, and choose your new preferred web
browser from the Web dropdown list.
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Reading and composing email

Introduction to Thunderbird

Thunderbird is an easy to setup and use email client developed by Mozilla.
It is free, fast and comes packed full of useful features. Even if you are
new to Ubuntu and Thunderbird, you will be up and running in no time,
checking your email and staying in touch with friends and family.

Setting up Thunderbird

In the top right corner of the Ubuntu desktop you will see an envelope icon
in the notification area. This is the messaging menu, from here you can
launch Thunderbird by clicking set up mail. Alternatively you can click the
Ubuntu button in the top left corner of the screen at the top of the launcher
to bring up the Dash and type Thunderbird into the search box. Once
Thunderbird opens you will be greeted by a pop-up box that will prompt
you to setup your email account.

Thunderbird Mail

Figure 3.12: setting up Thunderbird

&, Get Mail

Mail Account Setup

Your name: | Name

Email address: | email@domain.com

& Remember password

Cancel Continue

Accounts

¥ Done

Enter your name in the first text box, your email address in the second
text box, for example username@domain.com and your email password in
the third text box.

Once you have done this click the continue button. Thunderbird will au-
tomatically set up your email account for you. When Thunderbird finishes
detecting your email settings click “create account” and Thunderbird will do
the rest. You can also set Thunderbird as your default news and rss reader
by checking the boxes in the pop-up box that appears after you click create
account. If you don’t want to see this message box every time you start
Thunderbird simply deselect Always perform this check when starting
Thunderbird. You are now ready to start using Thunderbird.

53


mailto:username@gmail.com

54 GETTING STARTED WITH UBUNTU 11.10

Around the Thunderbird workspace

Now that you have your email account set up lets get to know the Thunder-
bird workspace. Thunderbird is designed to be very user friendly and easy
to navigate. When you open it you will see the main workspace with your
email folders (all folders window) on the left. On the right of the screen you
will see two windows. The top right window displays a list of your email
and the bottom right window displays the current email you are viewing.
The size of these windows can be easily re-sized to suit your own needs.
To do this simply left click and hold the dividing bar that separates the two
windows and drag the bar up or down to your desired position. The all
folders windows is where you can see all your mail folders. You will see:
Your remote folders for your account are listed here and can include:

» inbox: Where your email is stored and accessed

» email address folder: You will see one of these folders for each of the
accounts you have setup

» drafts: Where your draft mails are stored

» sent mail: Where the emails you have sent are stored

» spam: This is where suspected spam email is stored so you can check
them to make sure you haven’t lost any important emails

» trash: This is where messages you’ve deleted are stored so you can dou-
ble check to make sure you haven’t accidentally deleted an important
email (also one of the local folders)

» important: This is where emails you have marked as important are stored

» starred: This is where emails you have marked with a star are stored

» personal: This is where emails you have marked as personal are stored

» receipts: You can move important receipts to this folder. Records of your
on line purchases for example

» travel: You can use this folder to store travel emails such as flight times
and bookings

» work: You can store work emails in this folder to keep them separate
from your personal email

» outbox: Where the emails you are in the process of sending are stored
(also one of the local folders)

Across the top of the Thunderbird workspace you will see four control
buttons, get mail, write, address book and tag. These are used to get your
mail, write your mail, access your address book and tag your email mes-
sages.

At the top and to the right of the all folders window you will see a set of
quick filter buttons, unread, starred, contact, tags andattachment. You can
use these buttons to filter your email messages so that you only see your
unread mail, your favorite mail (starred), mail from people in your address
book, mail you have tagged and mail that includes attachments.

If you are used to a more traditional desktop and you have Thunderbird
maximized to full screen you might be wondering where the menus are,
they are still there and if you want to access them, move your mouse to the
top of the screen and you will see the familiar menus, file, edit, view, go,
message, tools and help.

At the top of the window that displays your email you can see five action
buttons, reply, forward, archive, junk, and delete. You will find these very
useful for quickly replying to email, forwarding your email to another
person, archiving (backing up) your email, marking an email as junk mail
and quickly deleting an email. To the left of these quick action buttons you
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will see information about the email you are viewing that includes who the
email is from, the subject of the email, the address to reply to and who the
email was sent to.

Using your address book

At the top of the main workspace you will see the address book button,
click this button to access your address book. Once the address book opens
you will see the address book window, from here you can organize your
contacts very easily. At the top of the address book window you will see
five buttons, new contact, new list, properties, write and delete.

» new contact: This button allows you to add a new contact and add as
much detail as you like including, name, nickname, address, email, addi-
tional email, screen name, work number, home number, fax, pager and
mobile/cell number.

» new list: This button allows you to add lists for your contacts such as
family, friends, acquaintances, etc.

» properties: This button allows you to rename your address book name.
The default name is ’personal address book’ but using this button you
can change the name to what suits you best.

» write: This button allows you to quickly send an email to a selected con-
tacted without needing to go back to the main Thunderbird workspace.
Simply select a contact from your contacts list and click this button to
send them an email.

» delete: This button allows you to quickly delete a contact from your
address book. Just select the contact you want to delete and press this
button to remove the contact from your address book.

Checking and reading messages

Thunderbird will automatically check your email account for new messages
every ten minutes or so but if you need to manually check for new mes-
sages left click the get mail button in the top left corner of the workspace.
Thunderbird will then check your email account for new messages and
download them. As they are downloaded you will see your email appear in
the message window on the right side of the workspace. When you click
on one of your emails it will appear in the window below your email list.
If you want to view your email in a full window double left click your cho-
sen email and Thunderbird will display the email in a full window in its
own tab. At the top of the open email you will see information about the
email and the five quick action buttons, reply, forward, archive, junk and
delete, as previously discussed. If an email has remote content you will see
a message asking if you want to display the email or not.

You may want to filter your emails from time to time; this is easily done
with Thunderbird. When you have an email selected and you want to tag
the email simply click the tag button and a drop down list will be displayed.
In the list you have the options to Remove All Tags or Mark as..., Impor-
tant, Work, Personal, To Do, Later or create a new tag that is more suited
to your own personal requirements.

Composing and Replying to Messages

To compose a new email message click the write button in the top left of
the workspace. This will bring up a new window where you will compose
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your new email. In the To: field, enter the email address of the destination
—the contact to whom you are sending this email. If there is more than one
contact to whom you are writing, separate multiple recipients with commas.
If a contact that you are addressing is in your address book, you can address
them by name. Start typing the name of the contact; Thunderbird will dis-
play the list of mailing contacts below your text. Once you see the contact
you intend to address, click on their email address or use the down arrow
key and then Enter to select the address. If you would like to carbon-copy
(Cc) some contacts, click the To: field and select Cc: Contacts on the To:
and Cc: lines will receive the email, and will see the rest of the contacts to
whom an email was sent. If you would like to send an email to some con-
tacts without disclosing to whom your email was sent, you can send a blind
carbon-copy, or Bec. To enable Bec, select Bee: by clicking the To: field and
selecting Bce: Any contacts entered in the Bece: field will receive the mes-
sage, but none of the recipients will see the names or emails of contacts on
the Bcc: line.

Instead of typing the email addresses, or names, of the contacts you
are addressing in the message, you can also select the contacts from your
address book. Start typing a few letters from your contact’s first or last
name in the To: field to filter the list to only show mailing contacts. Once
you identify the contact you would like to address, click on their name in
the list. If you’ve added the contact in error, delete their address and enter
the correct address.

You may enter a subject for your email in the Subject field. Messages
should have a subject to help the recipient to identify the email while glanc-
ing at their message list; if you do not include a subject, Thunderbird will
warn you about this. Enter the contents of your message in the big text field
below the subject. There is no practical limit on the amount of text you can
include in your message. By default Thunderbird will auto-detect the cor-
rect format for your email but you can change this by clicking Options then
mouse over Format and select your preferred option from the list.

You have a choice of Auto-Detect, Plain Text Only, Rich Text (HTML)
Only and Plain and Rich (HTML) Text. When you have finished composing
your email, click on the Send button on the window’s toolbar. Your message
will be placed in the Outbox, and will be sent to your desired recipient.

Attaching Files

At times, you may want to send files to your contacts. To send files, you
will need to attach them to your email message. To attach a file to an email
you are composing, click on the Attach button and when the new window
opens select the file you want to send and click open. That file will then be
attached to the email when you click send.

Replying to Messages

In addition to composing new messages, you may want to reply to messages
that you receive. There are three types of email replies:

» Reply (or “Reply to Sender”)—sends your reply only to the sender of the
message to whom you are replying.

» Reply to All—sends your reply to the sender of the message, as well as
anyone else on the To or Cc lines.

» Forward—allows you to send the message, with any additional comments
you may add, to some other contacts.



To use any of these methods, click on the message to which you want
to reply and then click the Reply, Reply to All, or Forward button on the
message toolbar. Thunderbird will open the reply window. This window
should look much like the window for composing new messages, but the
To, Cc, Subject, and main message content fields should be filled in from the
message to which you are replying. Edit the To, Cc, Bcc, Subject or main
body as you see fit. When your reply is finished, click on the Send button
on the toolbar. Your message will be placed in the Outbox, and will be sent.

Using instant messaging

Instant messaging allows you to communicate with people you know in real
time. Ubuntu includes the Empathy application that lets you use instant
messaging features to keep in touch with your contacts. To start Empathy,
open the Messaging Menu (the envelope icon on the menubar), then select
Chat.

Empathy lets you connect to many instant messaging networks. You
can connect to: Facebook Chat, Google Talk, Jabber, People Nearby, A1m,
Gadu-Gadu, Groupwise, I1CQ, IRC, MSN, mxit, myspace, QQ, sametime, silc,
stp, XMPP, Yahoo!, and Zephyr.

Running Empathy For the First time

When you open Empathy for the first time you will need to configure it
with the details of your instant messaging accounts.

When Empathy starts you will see the “Welcome to Empathy” window.
Choose the option corresponding to your situation.

You have a previous account

If you have an account that you have used previously with another instant
messaging program, then select the Yes, I'll enter my account details now
option. Then, click Forward to continue.

On the next screen, choose your account type from the drop-down list
below What kind of chat account do you have?. Then, enter your account
details in the field below.

Depending on the account type that you choose, Empathy may request
that you enter a username, or an ID for your account, followed by a pass-
word.

© Messaging and VoIP Accounts Assistant

- it what kind of chat account do you have? | % Windows Live (MSN) |+
Enter your account details
Plea t rson t What is your Windows Live ID?

Example: user@hotmail.com

What is your Windows Live password?
@

Do you have any other chat accounts you want to set up?
Yes @ No, that's all for now

Cancel Go Back

If you do not remember your account information, you will need to visit
the website of the instant messaging service to retrieve that information. (It
is suggested that you visit the web sites where you have instant messenger
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Figure 3.13: Creating a new instant messenger
account in Empathy.
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accounts, before you start Empathy, so you can gather all of the credentials
for each account.)

If you have another account to add then select the Yes option, and click
Forward to repeat the above process. When you have entered all of your
accounts leave the No, that’s all for now option selected, and click Apply to
finish the setup process.

Next, Empathy should display the “Please enter personal details” screen.
If you choose to fill in this information, you will be able to communicate
with people who are on your local network either at home or from the
office.

Enter your first name in the First name field, and your last name in
the Last name field. Enter a nickname that you want to use on your lo-
cal network in the Nickname field. When you have completed all of the
information, click Apply.

If you don’t want to communicate with people on your local network,
select the I don’t want to enable this feature for now option, and click

Apply.

You do not have a previous account

If you don’t have an account that you can use, then you can create one by
selecting the No, I want a new account option. Click Forward to display
the next set of options.
Choose the account type that you would like to create from the drop-
down list below What kind of chat account do you want to create? You
can create either a Jabber or a Google Talk account. Note: IF you wish to create a type of account

Next, enter the account name that you would like in the text field, and in other than one of these, then you will need
to visit the relevant website and create the

the following text field enter a password of your choice. If you would like account first. Then Follow the instructions in
to set up another account then select the Yes option, and repeat the above the “You have an account” section.
process.

When you have entered all the accounts leave the No, that’s all for now
option selected, and click Forward.

Empathy should display the “Please enter personal details” window.
Providing this information allows you to communicate with people who are
on your local network either at home or in the workplace.

Enter your First name in the text field, and enter your Last name in the
next field. In the Nickname field enter a nickname by which you would like
to be identified. When you have filled all of the text fields click Apply to
save your settings.

If you don’t want to talk to people on your local network then select the
I don’t want to enable this feature for now option and click Apply.

You want to talk to people nearby

If you would only like to communicate with people on your local network
either at home or in the workplace, then you should select the No, I just
want to see people online nearby for now option.

Click Forward to display the next set of options. Then enter your First
name in the text field, and enter your Last name in the next field. In the
Nickname field enter a nickname by which you would like to be identified.
When you have filled all of the text fields, click Forward.
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P - 0 .
L)) ) el (AL e T Figure 3.14: You can talk to people nearby by
to Empat entering your information.
Empathy can automatically discover and chat with the gy
people connected on the same network as you. If you
Enter your account details want to use this feature, please check that the details
Please enter personal details below are correct. You can easily change these details
later or disable this Feature by using the "Accounts’
dialog (Edit->Accounts).
Ido not want to enable this feature for now
First Name: I

Last Name:

Nickname:

Cancel Go Back

Changing account settings

If you need to add more accounts after the first launch, open the Edit menu,
then select Accounts. Empathy will then display the “Accounts” window.

Adding an account

To add an account click on the + button on the bottom left of the “Accounts”
window. Empathy should display some options on the right-hand side

of the window. Choose your account type from the Protocol drop-down
list. Next, enter your account name in the first text field. Then enter your
password in the Password text field. Finally click on the Log in button to
save and verify your settings.

Editing an account

You might need to edit an account if you change the password or get the
password wrong. Fortunately, this is very easy to do. Select the account you
want to change on the left side of the “Accounts” window. Empathy should
show the current information for the account. Once you have made your
changes, click Save.

Removing an account

To remove an account select the account on the left hand side of the win-
dow and click on the - button. Empathy should open the “Do you want to
remove” window. Click on the Remove button to confirm that you want to
remove the account, or click Cancel to keep the account.

Editing contacts
Adding a contact

To add a contact open the Chat menu, then select Add contact. Empathy
should open the “New Contact” window.

In the Account drop-down list, choose the account that you want to add
the contact to. When creating a contact you must select the service that
matches the service your contact is using.

For example if your contact’s address ends in “@googlemail.com” then
you will need to add it to an account that ends in “@googlemail.com”.
Likewise if the contact’s email ends in “@hotmail.com” then you will need
to add it to an account ending in “@hotmail.com”

After choosing the account you wish to add the contact to, enter their
login 1D, their username, their screen name or their email address in the
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Identifier text field. Next, in the Alias text field, enter the name you want to
see in your contact list. Click Add to add the contact to your list of contacts.

Removing a contact

Click on the contact that you want to remove, then on the Unity bar at the
top of the screen, open the Edit menu, select Contact, then Remove. This
will open the “Remove contact” window.

Click on the Remove button to confirm that you want to remove this
contact, or click Cancel to keep the contact.

Communicating with contacts
Text

To communicate with a contact, select the contact in Empathy’s main win-
dow and double-click their name. Empathy should open a new window
where you can type messages to your contact, and see a record of previ-
ously exchanged messages.

To send a message to the contact, enter your message in the text field be-
low the conversation history. When you have typed your message press the
Enter key to send the message to your contact. If you are communicating
with more than one person then all of the conversations will be shown in
tabs in your Empathy window.

Audio

If your contact has audio capabilities then there will be a microphone icon
next to their name. Click on the microphone icon to open the popup menu.
Select the Audio call option from the menu. Empathy should then open the
“Call” window.

This window shows your picture on the right and your contact’s picture
on the left. Ensure that your microphone and speakers are connected, and
proceed with the audio conversation. You can finish the conversation by
clicking on the Hang up button.

Video

If your contact has video chat capabilities then there will be a webcam icon
next to their name. Click on the icon to open a popup menu. Select the
Video call option from the menu. Empathy should then open the “Call”
window. This window shows your webcam view in the top right and your
contact’s webcam will be in the middle. If you don’t have a webcam then
your picture will be shown instead. You can finish the call by clicking on
the Hang up button.

Sending and receiving Files
Sending a file

When you are in a conversation with a contact and you would like to send
them a file, open the Contact menu, then select Send file. Empathy should
open the “Select file” window. Find the file you wish to send, and click on
the Send button. A “File Transfers” window will open showing the file and
its transfer progress. When the file transfer is complete, you can close the
“File Transfers” window.
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Receiving a File

When a contact wants to send you a file, the status icon to the left of the
contact’s name will flash with an icon of a paper plane. To receive the file,
double-click the contact’s name. Empathy will open the “Select a destina-
tion” window. Choose the location where you would like Empathy to save
the file, and click Save. Empathy should open the “File Transfers” window.
The “File Transfers” window shows you the progress of current file transfer.
You can stop the file transfer by clicking on the Stop button, open trans-
ferred files by clicking on the Open button, and clear the list of completed
transfers by clicking on the Clear button.

Changing your status

You can use your status to show your contacts how busy you are or what
you are doing. You can use the standard statuses, which are:

» Available
» Busy
» Away
» Invisible

» Off-line

These can be changed in one of two ways. The first method is in the
main Empathy window from the drop-down list at the top of the window.

The same drop-down list lets you set a custom status by choosing “Cus-
tom Message...” next to the icon that matches your status. Enter what you
would like your status to say, and click on the green check mark.

The second method is to click the Messaging Icon on the top Unity Bar.
From this menu, you will see all of the same options that Empathy presents,
but accessible without having to open the application window.

Changing your picture

Your picture is what your contacts will see next to your name in their con-
tact list. The default picture is the outline of a person. You can change your
picture by opening the Edit menu, then choosing Personal Information.
Empathy should open the “Personal Information” window. From the Ac-
count drop-down list choose the account that you want to change, then
click on the picture on the right-hand side of the window. Empathy should
open the “Select Your Avatar Image” window. Find the file containing your
picture, and click Open. If you would like to return it to the default avatar,
click on the No Image button, instead.

Desktop Sharing

Desktop sharing is a very nifty feature available with Ubuntu. It can be used
for a lot of purposes like troubleshooting, online meetings or just showing
off your cool desktop to your friend. It is very easy to get remote desktop
sharing working between two Ubuntu machines.

1. Click on System » Preferences » Remote Desktop and select Allow re-
mote desktop. It is strongly recommended you add a password, for security
reasons.

2. Open Empathy and login using your Google/Jabber client p

3. Double click on the user with whom you want to share your desktop

4. From the new window, click on Contact » Share your desktop.
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It should be noted that the other user will obviously be able to see the
information displayed on your screen. Please be sure to keep this in mind
if you have documents or files that are of a private nature open on your
desktop.

Microblogging

Ubuntu Software Center < b = 9:44PM R senthil ¥

- 2

All Software Installed

Gwibber Social Client

Update your microblog and Follow your contacts' statuses

(139 ratings)

& Installed | Remove |

Gwibber is a social networking client For GNOME. It supports Facebook, Twitter, Identi.ca, StatusNet,
FriendFeed, Qaiku, Flickr, and Digg.

This package includes the Gwibber desktop client

Developer Web Site

Add-ons
& & Buzz plugin For Gwibber (gwibber-service-buzz)
& {5 Diggplugin for Gwibber (gwibber-service-digg)
& & Flickr plugin for Gwibber (gwibber-service-flickr)
& & Foursquare plugin For Gwibber (gwibber-service-foursquare)

& [ Friendfeed plugin for Gwibber (gwibber-service-friendfeed)

Gwibber is the default microblogging application that connects several
microblogging accounts in one window without loading a browser. Gwib-
ber can be used to access and post on Twitter, Facebook, Identi.ca, Ping.fm,
Flickr, Digg, Status.net, Qaiku and FriendFeed. Support for Google+ will be
available once the API is released.

Upgrades and add-ons

If you intend to access Ping.fm, Flickr, Digg, Status.net, Qaiku or Friend-
Feed, you will need add-ons. Go to Ubuntu Software Center and search for
Gwibber. Make sure the appropriate add-ons are selected and installed.

You also may like to install an add-on to search Gwibber feeds using
Unity Lens.

Setting up Gwibber Accounts

Access Gwibber from the Message menu on the top panel bar. Click Broad-
cast to start Gwibber.

To add a new account, click Edit and select Accounts. This will open a
new window for the “Accounts Manager”. Click the + button to add a new
account. After you enter your login and password, choose an account color
and then click Add. You will have to authorize Gwibber to use Twitter or
Facebook, and enable the ap1 for Qaiku, if you are using Qaiku.

Removing accounts is easier. Go to the “Accounts Manager” window and
select the account to be removed. Click the — button to remove the account.

Figure 3.15: Gwibber Social Client

Gwibber feeds can be searched and accessed
from Unity Lens.



® | @ Manchester

I:I Images S

Manchester United
Happy Birthday Nani! 25 years old today.
send Nani your b

Videos

Ryan Giggs

[Video] Get today's news and gossip - as
Liverpool and Manchester United
reportedly chase Brazilian wonderkid! ...

Ryan Giggs

Swansea 0-1 Manchester United |
Hernandez the hero again as United
in Wales! Match review: http://bit.ly/

C 2 3 =& W) 3:43:18PM 1 senthil &

Manchester United

The '99 Treble team - your fFavourite of
Sir Alex's teams. What made them so
special?

Manchester United

Swansea 0-1 United. Hernandez's early
goal sees the Reds edge a close game.
‘Will Chicharito finish the season as our ...

Filter results »

Manchester United
25 years. Only 1Sir Alex Ferguson...

Ryan Giggs

Manchester United target Alvaro
Dominguez has signed a contract
extension with Atletico Madrid! Read ...

WORKING WITH UBUNTU

Figure 3.16: Gwibber Lens Add-on
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Figure 3.17: Accessing Gwibber from the
Message Menu
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Using Gwibber to follow streams

Gwibber displays feeds from each service provider as streams. You can
select for them to be listed in either ascending or descending order by
selecting the Sort option under View menu. You can separate the feeds as
messages, replies, and private messages.

In addition, the attachments from the feed are sorted as images, links,
and videos. Clicking the image, link, or the video would take you to the
actual website by opening a new tab in your default browser.

Notifications

Feeds can be displayed in the notification bubble by selection for the op-
tion in the “Preferences” window. You can also choose the rate at which
Gwibber searches for new feeds.

Replying, liking, and retweeting

Each tweet can be liked, retweeted, or replied from within Gwibber’s win-
dow by selecting the Twitter icon on the top right of each post.

Figure 3.19: Clicking on the image would open
the Facebook page on a browser.

Figure 3.20: Notifications from Gwibber can be
customized from the Preferences window.
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Figure 3.21: Facebook updates can similarly
liked and commented from within Gwibber
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Status updates

Select the Message menu from the top panel and click Update Status. This You can deselect an account from posting using
would open a new window. Enter your status message and post it to all Gwibber.
your accounts in one click.

Advanced options

Gwibber can be customized to have individual colors for each account.
You can also shorten URLSs as you post from Gwibber using a list of URL
shortening services. Play with Gwibber and discover other cool things it
can do. Visit http://gwibber.com/docs/user-guide/current/master_social
networking_with_gwibber.pdf for more information.

Viewing and editing photos

Shotwell Photo Manager is the default photo application in Ubuntu allow-
ing you to view, tag, edit, and share your photos. To start Shotwell, click
on the Ubuntu icon near the top left of the screen, then select the Shotwell
icon labeled View Photos.

Importing

When you launch Shotwell for the first time, you will be greeted by the
“Import” window. After the first launch, you can import more photos by
dragging the photos into the Shotwell window. You can also import photos
by connecting your camera or external storage device to the computer.

From a digital camera Connect your camera to the computer using the
data cable and power it on. If your camera is properly detected, you will
see a new window prompting you to launch an application. Select Shotwell
in the drop-down menu then click OK. Your camera will be listed in the
Shotwell sidebar. Select your camera in the sidebar. You will see a preview
of the camera’s contents. Select individual photos by pressing and holding


http://gwibber.com/docs/user-guide/current/master_social_networking_with_gwibber.pdf
http://gwibber.com/docs/user-guide/current/master_social_networking_with_gwibber.pdf
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Ctrl and clicking on each photo you want to import, and then clicking
Import Selected on the bottom bar of the window. Or, you can choose to
import all photos by clicking Import All

From your computer You can import photos into Shotwell by dragging
photos from your file browser into the Shotwell window. Alternatively, you
can click File Import From Folder, » select the folder containing the photos
you want to import.

From external hard drive, UsB flash drive, or co/DvD Importing photos from
external storage is similar to importing from your computer. Your external
storage device may also appear under the Camera label on the Shotwell
sidebar. Follow the instructions for importing from a camera or computer.

Choosing where Shotwell saves photos

The default location for the Shotwell Library is your Pictures folder. When
importing pictures in the “Import” window, you will be given the option to
copy the files to your Library, or keep the files in place.

If you have your photos stored on your computer, the option Import
in Place will be suitable so photos aren’t duplicated. If you are importing
photos from an external source, such as a portable hard drive, uss flash
drive, or cp/DVD, you should select Copy into Library so the photos are
copied to your computer—otherwise they won’t appear when you remove
the external source.

Viewing photos

Choose Library or any collection in the sidebar to display photos from
your selection. Use the slider on the bottom bar to adjust the size of the
thumbnails. To view a full-window image, double-click an individual photo.

Figure 3.22: Manage your collection, enhance
your photos while keeping the original, and
share your memories online using Shotwell
Photo Manager.
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In the full-window view, you can navigate through the collection using
the back and forward arrows, zoom on the image using the slider, pan by
clicking and dragging the image, and exit the full-window view by double-
clicking the image.

To view the collection in full-screen mode, press F11 or go to View »
Fullscreen. You can navigate through the collection using the toolbar that
is available by moving your mouse to the bottom of the screen. To view a
slideshow presentation of the collection, press F5 or go to View » Slideshow.
Press the Esc key to exit the Fullscreen or Slideshow views.

Organizing photos

Shotwell makes finding photos of the same type easier by using tags. You
can apply as many tags to a photo as you like. To apply tags to photos,

first select the photos. Then right-click on the photos and select Add Tags.
Enter the tags you want into the text field, separated by commas. If you are
adding new tags, these will appear in the side bar on the right under the
Tags label.

Editing images

You may want to edit some of the photos you import into Shotwell. For
example, you may want to remove something at the edge, adjust the color,
reduce the red-eye effect, or straighten the image. To edit a photo, double-
click on the photo that you want to edit and then click on one of the follow-
ing buttons:

Rotate

Click Rotate to rotate the image 9o0° clockwise. You can click the button
more than once and it will rotate the image clockwise in 9o° intervals.

Crop

Click Crop to change the framing of the photo. The image will darken and a
selection will appear. Adjust the selection to your desired crop by dragging
a corner or side. If you want to choose a specific aspect ratio, use the drop-
down menu to select one of the preset ratios or enter your own custom
ratio. A pivot button is provided to change your selection from landscape to
portrait and vice versa. Once you are happy with the selection, click OK to
apply the crop or Cancel to discard it.

Red-eye reduction

If you have taken a photo and the flash has caused the subject to have red
eyes, you can fix this problem in Shotwell.

Click the Red-eye button. A circle will appear.

Drag this circle over one of the subjects eyes and then use the slider to
adjust the circle size.

When the circle is over the eye, click Apply to fix the red eye. You will
need to repeat this for each individual eye. Use caution when adjusting
the size of the circle. A circle too large and covering the skin may cause
discoloration when applying the red-eye reduction.
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Adjust
Clicking Adjust will bring up a window that lets you edit a few things:

» Levels: Similar to contrast

» Exposure: How bright the image is

» Saturation: How colorful the image is

» Tint: The overall color

» Temperature: Whether the image is warm (more yellow) or cool (more
blue)

» Shadows: How dark the shadows are

To change these values, drag the sliders until you are satisfied with the
image. Click OK to apply the changes, Reset to undo the changes and start
over, or Cancel to discard the changes.

Enhance

Click Enhance to let Shotwell automatically adjust the color, levels, expo-
sure, contrast and temperature to make a more pleasing image.

Reverting an edited photo to the original

When you edit a photo in Shotwell, your original image remains untouched.
You can undo all of the changes and revert to the original version by right-
clicking on the photo, then selecting Revert to Original. This option is only
available for photos you have edited.

Sharing your photos

You can easily share your photos on the web using Shotwell’s Publish
feature. Select the photos you want to share, then click the Publish button
located on the bottom bar. Choose Facebook, Flickr, or Picasa Web Albums
in the drop-down menu and log-in with your credentials. Some services
may require you to authorize Shotwell before allowing the application to
publish photos. Follow the instructions on the window, select your desired
options, and click Publish to upload your images to the web.

Further information

We’ve only just touched on the features of Shotwell. To get more help,
select Help » Contents. The User Manual option will take you to http://trac.
yorba.org/wiki/UsingShotwello.7 which gives more detailed instructions on
how to use Shotwell effectively.

Watching videos and movies

To watch videos or pvDps in Ubuntu, you can use the Movie Player appli-
cation. To start the Movie Player, click on Dash, then search for “Movie
Player” and select it. This will open the “Movie Player” window.

Codecs

Watching pvDs may require Ubuntu to install a “codec,” which is a piece of
software that allows your computer to understand the contents of the pvp,
and display the video.


http://trac.yorba.org/wiki/UsingShotwell.
http://trac.yorba.org/wiki/UsingShotwell.

Movie Player

Playlist %

Time:

Sidebar| db
Stopped  0:00/0:00

& Legal Notice: Patent and copyright laws operate differently depending on which
country you are in. Please obtain legal advice if you are unsure whether a par-
ticular patent or restriction applies to a media format you wish to use in your
country.

So that you can play all videos and pvDs, you will need to install some
codecs. These are located within the Multiverse repository. This is now
enabled by default.

To install the codecs, open the Ubuntu Software Center, either through
Dash or the Launcher. When the “Ubuntu Software Center” window opens,
use the search box in the top right and search for the following:

» ubuntu-restricted-extras
» libdvdreadq
» libdvdnavg

When you find each one, select it with a double-click and then click the
Install button. This may open an “Authenticate” window. If so, enter your
password then click Authenticate to start the installation process.

Playing videos from file

Open the Movie menu, then select Open.... This will open the “Select
Movies or Playlists” window. Find the file or files that you want to play
and click on the Add button. The video or videos will start playing.

Playing a DVD

When you insert a DvD in the computer, Ubuntu should open the “You have
just inserted a Video pvp. Choose what application to launch” window.
Make sure that Open Movie Player is chosen in the drop-down list and
then click OK. The “Movie Player” window will open and the movie will
start.

If the “Movie Player” window is already open, open Movie menu, then
select Play Disc... and the movie will start.
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Figure 3.23: Movie player (Totem) plays music
and videos.
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Listening to audio and music

GETTING STARTED WITH UBUNTU 11.10

Ubuntu comes with the Banshee Music Player for listening to your music,
streaming Internet radio and managing playlists and podcasts. Banshee also
comes bundled with multiple ways to find and purchase music, TV shows,
Movies and even ways to subscribe to your favorite rss feeds.
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Starting Banshee

To start Banshee, open the Dash, then click on Listen to Music with the
Banshee logo above it. You can also type Banshee then click on the Banshee
Icon, or browse the list of applications manually. Ubuntu 11.10 comes with
an indicator menu for sound-related devices. This menu includes a link to
start Banshee as well as basic playback and volume controls. To quit Ban-
shee, move your mouse into the upper right corner and window controls
will appear. Then, click the orange x. You can also click Ctr1+Q on your
keyboard. Banshee will continue to run in the background, but you can still
control your music from the Sound indicator.

Playing music

To play music, you must first import music into your library. Choose Mu-
sic» Import Folder or press Ctr1+0 on your keyboard to import a folder

of media, a single file, an Amazon Mp3 purchase or media from an iPod,
iPhone or iPad. The Banshee toolbar contains most of the controls that you
will use for browsing and playing your music. If you want to play a song,
double-click a track or click it and press the Play button on the toolbar (you
can also choose Playback » Play from the menubar or press Space). When a
song is playing, the Play button will become a Pause button. Clicking on it
will pause the song. Next and Previous buttons are next to the Play/Pause
button. You can click on these buttons to play the next and previous songs



in your library or playlist. Banshee also has options to toggle Shuffle or Re-
peat modes. Banshee offers five different types of shuffling, all of which can
be accessed by clicking on the drop-down menu next to Next button or by
using the global menubar (Playback » Shuffle). Repeat controls are located
in bottom right hand corner and through the global menubar (/menuPlay-
back » Repeat).

Playing Audio CDs

To play your CD, insert it into your drive. It will automatically appear
within Banshee in the Side Pane beneath your Music Library and Video
Library. You can click the CD (named Audio CD, or the name of the album)
and double-click a track in it to play the tracks on the CD.

Importing/Ripping Audio CDs

Begin by inserting a CD. Banshee will automatically detect it and add it to
the side menu. Click the CD. Uncheck any tracks you don’t want imported.
Press the Import CD button, located near the upper-right corner of Banshee.
Banshee will begin importing the CD. As it finishes each track, they will
appear in your Music Library.

Listening to Streaming Radio

Banshee is pre-configured to enable you to stream radio from various
sources. These include Internet broadcast stations (Radio from the Side
Pane) as well as Last.fm. Streaming radio is a term that refers to radio sta-
tions that are broadcast over the Internet. To listen to an Internet radio
station, right-click Radio in the Side Pane and enter all relevant information
into the corresponding field and click save. The station is now saved in Ban-
shee and you can play it by double-clicking it or by selecting it and clicking
the Play button. To listen to music from Last.fm, configure your Account
Settings.

Connect digital audio players

Banshee can connect with many popular digital media players. Connected
players will appear in the Devices list. Features will vary depending on the
player (and often the player’s popularity), but common tasks like transfer-
ring songs and playlists should be supported.

Listen to shared music

If you are on the same network as other Banshee users (or most other music
player software), you can share your music and listen to their shared music.
Under the Online Media category in the sidepane, there is a subcategory
titled Shared Music. Media shares should be listed automatically, but you
may be required to add the IP manually. To do this click Media » Add Re-
mote DAAP Server. Then enter the IP address and the port number. Then
click OK. Clicking a shared library will enable you to browse and play songs
from other computers. You can also import music from shared libraries by
clicking Media » Import Media (Ctr1+I) then scrolling down to the desired
media share.
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Streaming radio are radio stations that are
broadcast over the Internet.

DAAP stands for “Digital Audio Access Proto-
col,” and is a method designed by Apple Inc. to
let software share media across a network.
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Manage podcasts

Banshee can manage all of your favorite podcasts. Select Podcasts from the
Side Pane to view all added podcasts. The toolbar will display additional op-
tions to Subscribe to a New Podcast (the icon with the green cross) and Check
all Podcasts for New Episodes. Choose Media » Add Podcast, Ctri+Shift+F,
or or press the Subscribe button in the toolbar to import a podcast. Podcasts
will be automatically downloaded at regular intervals or you can manually
update feeds. Select an episode and click buttonPlay. You can also delete
episodes.

View

Banshee comes with the option of a fullscreen mode. To enter fullscreen

mode press F on your keyboard or use the global menubar (View » Fullscreen),
to exit from fullscreen mode press F. Banshee also has a browser bar that is
enabled by default (this area is the top half of the program window). It gives
you the option to search your music by artist (upper-right) or album (upper-
left). This browser can be disabled through the menubar (View » Browser)

or with your keyboard (Ctrl+B).

Banshee preferences

The default configuration of Banshee may not be exactly what you want.
Choose Edit » Preferences to alter the application settings. The Preferences
tool is broken into three main areas: General, Source Specific and Extensions.

General Options include how you want Banshee to interact with the actual
media files as well as usability and bug reporting options.

Source Specific options allow you to choose the source of your music, your
music folder, and file organization, as well as how to sort albums by the
same artist and automatically detecting the BPM (Beats per Minute)
of your songs. » [Extensions] options give you the opportunity to add

Figure 3.25: Banshee connected to an iPhone
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functionality to Banshee. They include Context Pane extensions, Core
extensions, Device Support extensions, Online Source extensions and
Utilities extensions.

Managing your music

Banshee supports creating playlists. Playlists are either static lists of songs
that are played in order or can be smart playlists based on filter criteria.
Playlists contain references to songs in your library. They do not contain
the actual song file, or even the song in you library. If you remove a song
from a playlist (right-click on the song » Remove from Playlist), it will
remain in your library and on your hard drive. To create a playlist, choose
Media » New Playlist, Ctrl+N or right-click Music in the side pane and click
New Playlist. Then give the new playlist a name. You can then either drag
songs from you library to the new playlist in the side pane or right-click on
songs and select Add to Playlist and pick the playlist. Smart Playlists are
created almost the same way as static playlists. Choose Media » New Smart
Playlist. Next, define the filter criteria. You can add multiple filter rules
and select a name. Finally, click Save. Smart Playlists will appear in your
side pane with a different icon than any static playlists. You can update

any playlist by right-clicking on the name and choosing Edit. Banshee
supports song ratings. Select a song in your library and choose Edit » Rating
or right-click on the song and click on the appropriate amount of stars.
Other song information such as Title, Artist, and Album can be arranged
from right-clicking a song, clicking Edit Track Information, then looking
under the Basic Details tab. To delete a song, click delete or right-click it
and select Remove from Library. To delete a song from your hard drive
entirely, right-click it and select Delete from Drive. If you ever want to
move a song, highlight the song (or group of songs) from your library and
drag it to a folder or to your desktop. This will make a copy of the audio file
in the new location.

Banshee Extensions

Banshee comes with a variety of extensions. These are tools that you can
enable and disable that add more features to Banshee. Examples include
Youtube searching, Wikipedia Integration, and various music stores. Some
extensions are enabled by default. To view the list of available extensions,
Choose Edit » Preferences » Extensions.

Music stores

Banshee has two music stores which give you access to an extremely large
catalog of music with a variety of licensing options. The Ubuntu One Mu-
sic Store (see figure below) sells music from global major and minor music
labels. The store offers DRM-free (no copy protection) songs encoded in
high-quality MP3 format. You can browse the catalog, play previews, and
buy songs with the Ubuntu One Music Store. The Ubuntu One Music Store
also integrates with the Ubuntu One service as the name suggests. All
purchases are transferred to your personal cloud storage and then auto-
matically copied to all of your computers. For that reason, an Ubuntu One
account is required (it is free of charge and quick to register). The catalog of
music available for purchase will vary depending on where you live in the
world. More information about the Ubuntu One Music Store can be found
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at https://one.ubuntu.com/music/. The Amazon Music Store is the other
music store included with Banshee. It offers a large variety of music from
various sources. Both stores have very competitive prices.
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Audio codecs

Different audio files (MP3, WAV, AAC) require unique tools to decode them
and play the contents. These tools are called codecs. Rhythmbox will at-
tempt to detect any missing codecs on your system so you can play all of
your audio files. If a codec is missing, it will try to find the codec in online
resources and guide you through installation.

Banshee support

Banshee is used by many users throughout the world. There are a variety of
support resources available in many languages.

» Click the Help button for a variety of support options and information
about reporting Banshee bugs.
» The Banshee website: http://banshee.fm/

» The Multimedia & Video category of Ubuntu Forums: http://ubuntuforums.

org/forumdisplay.php?f=334

Burning CDs and DVDs

To create a cp or DVD open the Dash and search for Brasero Disc Burner,
then open Brasero. This opens Brasero, which gives you five options to
choose from. Each one of these is explained below.

Getting Started

Before you can get started with Brasero, you need to Create a new project.
There are three types of projects that are available to you: Audio Project,

Figure 3.26: Amazon MP3 Store
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Data Project, and Video Project. Make your selection based on which you
require. Please note that at the moment Brasero does not support Blu-Ray.

These following options apply for all projects except Disc copy and Burn
Image.

Adding files to a project

To add files to the list, click the Green + button, which opens the “Select
Files” window. Then navigate your way to the file you want to add, click
it, and then click the Add button. Repeat this process for each file that you
want to add.

Removing Files

If you want to remove a file from the project, click the file in the list and
click on the Red - button. To remove all the files in the list click on the
Broom shaped button.

Saving a project

To save a project so that you can finish it later, choose Project » Save. The
“Save Current Project” window will be opened. Choose where you would
like to save the project. Then, in the Name: text field, enter a name for the
project so that you will remember it. Now click the Save button.

Burning the disc

>

When you click the Burn... button you will see the “Properties of ...
dow.

You can specify the burning speed in the Burning speed drop down. It is
best to choose the highest speed.

To burn your project directly to the disc, select the Burn the image
directly without saving it to disc option. With this option selected, no
image file is created and no files are saved to the hard disk.

The Simulate before burning option is useful if you encounter problems
burning discs. Selecting this option allows you to simulate the disc burning
process without actually writing data to a disc—a wasteful process if your
computer isn’t writing data correctly. If the simulation is successful, Brasero
will burn the disc after a ten second pause. During that ten second pause,
you have the option to cancel the burning process.

> win-
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Figure 3.27: Brasero burns music, video, and
data DVDs and CDs.

Icons of a broom are often used in Ubuntu to
represent clearing a text field or returning
something to its default state.

Temporary files are saved in the /tmp folder

by default. Should you wish to save these files
in another location, you will need to change

the setting in the Temporary files drop down
menu. Under normal conditions, you should not
need to change this setting.
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Blanking a disk

If you are using a disc that has Rw written on it and you have used it before,
then you can blank it so that you can use it again. Doing this will cause you
to lose all of the data currently on the disc. To blank a disc, open the Tools
menu, then select Blank. The “Disc Blanking” window will be open. In the
Select a disc drop down choose the disc that you would like to blank.

You can enable the Fast blank option if you would like to shorten the
amount of time to perform the blanking process. However, selecting this
option will not fully remove the files; if you have any sensitive data on your
disc, it would be best not to enable the Fast blank option.

Once the disc is blank the you will see The disc was successfully blanked.
Click the Close button to finish.

Audio project

If you record your own music, then you may want to transfer this music
onto an audio cD so your friends and family can listen. You can start an
audio project by clicking Project » New Project » New Audio Project.

So that each file does not play straight after each other you can add a
two second pause after a file. This can be done by clicking the file and then
clicking the pause button.

You can slice files into parts by clicking the Knife button. This opens a
“Split Track” window. The Method drop down gives you four options each
one of these lets you split the track in a different way. Once you have split
the track click OK.

In the drop down at the bottom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. Then click
the Burn button.

Data project

If you want to make a back up of your documents or photos it would be best
to make a data project. You can start a data project by clicking Project then
clicking New Project and then New Data Project.

If you want to add a folder you can click the Folder picture, then enter
the name of the folder.

In the drop down at the bottom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. Then click
the Burn button.

Video project

If you want to make a bvD of your family videos it would be best to make
a video project. You can start a video project by clicking Project, then New
Project and then New Video Project.

In the drop down at the bottom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. Then click
the Burn button.

Disc copy

You can copy a disc clicking Project, then New Project and then Disc copy.
This opens the “Copy cp/pvD” window.

RW stands for Re-Writable which means that
disc can be used more than once.
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If you have two cp/DvD drives you can copy a disc from one to the other,
the disc that you want to copy to must be in the cp-Rw/DVD-RW drive. If
you have only one drive you will need to make an image and then burn it to
a disc. In the Select disc to copy drop-down choose the disc to copy. In the
Select a disc to write to drop-down either choose image file or the disc that
you want to copy to.

Image file

You can change where the image file is saved by clicking Properties, this
shows the “Location for Image File”. You can edit the name of the file in the
Name: text field.

The default save location is your home folder, you can change this by
clicking the + next to Browse for other folders. Once you have chosen
where you want to save it click Close.

Back in the “Copy c¢p/pvDp” window click Create Image. Brasero will
open the “Creating Image” and will display the job progress. When the
process is complete click Close.

Burn image

To burn an image, open the Project » New Project, and then Burn Image.
Brasero will open the “Image Burning Setup” window. Click on the Click
here to select a disc image drop-down and the “Select Disc Image” window
will appear. Navigate your way to the image you wish to burn, click on it,
and then click Open.

In the Select a disc to write to drop-down menu, click on the disc to
which you’d like to write, then click Create Image.

Working with documents, spreadsheets, and presentations

LibreOffice suite is the default office suite when working with: word docu-
ments, spreadsheets, and slide presentations.

Working with documents
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If you need to work with documents, you can use the LibreOffice Word Pro- The LibreOffice Word Processor is also known
cessor. To start the word processor, open the Dash home of the Launcher, as the LibreOffice Writer. Spreadsheet is also

search for Libre0Office Writer and select it. Ubuntu should then open the
main window for the word processor.

Impress.

Working with spreadsheets

If you need to work with spreadsheets, you can use the LibreOffice Spread-
sheet. To start the spreadsheet application, click on the Dash home, type
Libre0ffice Calc and select LibreOffice Calc.

Working with presentations

If you need to work with slides for a presentation, you can use the Libre-
Office Impress. To start the presentation application, open the Dash home
menu, type Libre0Office Impress, and then click on it.

known as Calc, and Presentation is known as
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Getting more help

Each of these applications comes with a comprehensive set of help screens.
If you are looking for more assistance with these applications, press the F1
key after starting the application.

Ubuntu One

What is Ubuntu One?

Ubuntu One is an optional, online storage service that allows you to save
and access your data over the Internet and to share and synchronize infor-
mation with other people and devices. Ubuntu One is run by Canonical, the
people who develop Ubuntu.

Although the name implies that it is an Ubuntu-specific feature, at its
simplest, Ubuntu One can be used with any device that has a web browser
and Internet access, regardless of operating system. You don’t need to be
an Ubuntu user at all! However, to make best use of all the Ubuntu One
features, you will need to install some special Ubuntu One software on
your device. There are currently versions available for Windows, Android
and iPhone/iPad. (Of course, there is also an Ubuntu version, which is
automatically installed as part of the standard Ubuntu set up).

Uses For Ubuntu One

Here are some situations where you may find Ubuntu One useful:

You have multiple devices and want to share files between them

If you often work at several different machines, it can be frustrating to re-
alize that a file you want to use is stored on another machine. One solution
is to carry a UsB memory stick around and save files onto this. But there
are some problems with this: you may not have the stick with you when
you need it; the device you are using (a smartphone, say) may not have a
UsB socket; or the device’s UsB sockets may have been disabled (as they
often are, i.e., in Internet cafés). Plus, there is always the risk of losing the
stick...Ubuntu One provides a neat alternative to this problem. Storing your
files online means they can be accessed from any device that has Internet
access.

You want to share files with Family and friends

Ubuntu One allows you to share some of your online files with other peo-
ple. There are several reasons you might want to do this. You don’t have

to send the files to them directly—for example, as email attachments. This
is particularly useful if the files are large: large attachments can be annoy-
ing for the recipients because they are slow to download and can clog up
inboxes. Instead of sending the files themselves, you include a link to them
instead. A typical example might be a couple away on holiday uploading
photographs from their smartphone to Ubuntu One for the rest of the fam-
ily back home to see. Sharing files online also makes it easier to collaborate.
Having a single copy of documents accessible by everybody makes it easier
to coordinate changes and avoids inadvertently creating multiple versions,
which might happen if documents are circulated around by email. A small

Internet-based services such as Ubuntu One
are often referred to as “cloud services.” The
word “cloud” is often used to denote a remote
network such as the Internet, which would
often be drawn as a cloud shape on diagrams.

You may see this software referred to as the
Ubuntu One client (because it runs on a user's
(i.e., client) machine, rather than a server. There
are also non-official Ubuntu One client versions
available for other operating systems, such as
Fedora.



club or society might find this useful, for example, to collaborate on doc-
uments such as agendas, publicity material, meeting minutes and so on.

Which files you share and who you share them with is up to you. Files
can be visible just to you, to a defined group, or to everybody.

You want a simple way to backup files online

There are many ways to lose data, for example:

» accidentally deleting a file (although you may be able to recover it from
the trash bin);

» inadvertently re-formatting a disk or partition;

» losing a UsB stick;

» device failure, such as a hard drive breaking;

» damage to media, such as scratching a cp or DVD;

» fire, theft etc.

It is always prudent to make backups of valuable files and Ubuntu One
provides a good solution because, whatever may befall your own media or
devices, your files will remain safe and secure on Ubuntu One servers.

You are a music Fan and like to listen to music on different devices

Ubuntu One provides a neat solution for people who like to listen to music
on multiple devices. You can use your Ubuntu One account as an online
jukebox and have your music streamed to whatever device you are cur-
rently using. Your music collection is available at any time on any device.
You can also purchase music quickly and easily in the Ubuntu One Music
Store and have it delivered directly in to your account, ready for streaming.

& Ubuntu One Music Streaming requires payment of a subscription.

How safe is Ubuntu One?

Before using Ubuntu One, you should bear the following points in mind:

» Uploading, downloading and synchronizing your information with
Ubuntu One is done over an encrypted connection, which prevents
anybody eavesdropping on your information as it is being transferred.

» Information uploaded to Ubuntu One can potentially be accessed by
Canonical, so as with other online services and websites, you are implic-
itly trusting them to respect your privacy. If you don’t feel you can trust
them with certain information, don’t upload it to Ubuntu One.

» If you violate the Ubuntu One terms and conditions and store illegal
material, Canonical may be required to hand the information over to law
enforcement agencies without your consent.

» Your online information can be accessed by anybody who knows (or can
guess) your account name and password. For this reason, you should
choose a good password and keep it secure.

Getting started with Ubuntu One

To use Ubuntu One, you will need to create an online account and subscribe
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Note that Ubuntu One is not a revision control
system. If you need revision and version control
features, have a look at Bazaar http://bazaar.
canonical.com

Ubuntu One uses the same encryption tech-
niques used to secure online banking.

5GB is enough to store about 1,500 music files
or 5,000 photographs (depending on size).


http://bazaar.canonical.com
http://bazaar.canonical.com
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to the Ubuntu One service. Subscribing is free and will give you 5GB of
online storage. If you find this is not enough, you can purchase additional
storage in 20GB blocks for either a monthly or annual subscription.

Note: you will need an email address in order to set up Ubuntu One. If necessary,
first create an email account. You will also need to be connected to the Internet.

There are two ways to create an Ubuntu One account. You can sign up
online by going to the Ubuntu One website https://one.ubuntu.com and
clicking the Sign Up link. Alternatively, you can sign up using the Ubuntu
One Control Panel.

Creating an Ubuntu One account using the Ubuntu One Control Panel

In the launcher, click the Ubuntu One button. E
This will open the Ubuntu One Control Panel.

Figure 3.28: Launcher Icon

Ubuntu One Control Panel

Figure 3.29: Control Panel Initial View

The Power of Your Personal Cloud

Keep Connected i
@ Unify your contacts acros robile and Wel Join now
stay Productive | already have an account!
& Keep your Tomboy notes s

Click the Join now button. The Create Ubuntu One account dialog will
appear.

Create UbuntuOne account Figure 3.30: Control Panel Create Account

Create Ubuntu One account

Ubuntu One requires an Ubuntu Single Sign On (SSO) account. This process
will allowyou to create a new account, if you do not yet have one.

The password must have a minimum of 8 characters and include one uppercase character
and one number.

fe=22dpt ¢
requiring n
two-thirds

[& 1 agree with the Ubuntu One terms and conditions

Show Terms & Conditions

Already have an account? Click here to signin Cancel Forward

Fill in the details requested. Make sure you use a valid email address that
only you have access to. The squiggly text below your details is a captcha.
You need to re-type the captcha text back into the text box below. Because


https://one.ubuntu.com

captchas are automatically generated, they can sometimes be difficult to
read. If you get one that is indecipherable, just click the circular blue arrow
to generate another.

You should review the terms and conditions before signing up. When
you’re happy, click Forward.

Create Ubuntu One accountk

Create Ubuntu One account
Enter verification code
Check test@quadrisys.co.uk For an email from Ubuntu Single Sign On. This

message contains a verification code. Enter the code in the field below and
click OK ko complete creating your Ubuntu One account

ok |

You will be sent an email containing the verification code (this may take
a few minutes to arrive, so be patient!). Enter the verification code into the
box and click OK. If all goes well, you will get a congratulatory message
and then see the main Ubuntu One Control Panel. You will also get another
email welcoming you to Ubuntu One. Congratulations, you’re now signed

up!

Using Ubuntu One

Now you’re signed up, there are various things you can do using your
Ubuntu One account:

» Manage your cloud data via the Ubuntu One website

» Manage your account via the Ubuntu One Control Panel
» Set up contact synchronization with Thunderbird

» Synchronize your cloud and local files using Nautilus

The following sections cover each of these.

Using the Ubuntu One website

You can access your cloud data through the Ubuntu One website at https://
one.ubuntu.com. Sign in using the same email address and password you
used in the sign up process. Once signed in, you should see your account
dashboard.

The dashboard summarizes your account use and provides a central
point of access. Through the dashboard, you can:

» Create ‘post it’ style reminder notes
» Manage your contacts
Managing your cloud files and folders

On the dashboard screen, click the Files link. The Files page appears.
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The captcha acts as a check that it really is a
person filling in the form and not a computer
(because a computer won't be able to read the
captcha text).

Figure 3.31: Control Panel Create Account


https://one.ubuntu.com
https://one.ubuntu.com
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I ubuntu One : Dashboard

&= 42 Ul ubuntu.com ubuntu.com, MR B [\ @
| |
u Ubuntu Welcome My Account | legout

one
Dashboard Files Notes Contacts
Hi Welcome Back

View your account details and see what's new.

?
Files Contacts Nt Need more space?

‘You get 5GB for free! Add more storage to suit

0 bytes 0 0 your needs.
View files View contacts View notes
Buy more storage space
Ubuntu One now works on Windows! Getting started
Ubuntu one For Windows is easy to install and use, works on Need help?
Windows XP, Vista and 7, so you can you can access your files,
T e e e Wr?etheryuu have a question or just want to give us your feedback -
visit our help pages for support.
Learn more »
Go to our help section »
Ubuntu One Buzz Ubuntu One on YouTube

Uploading a File to Ubuntu One

» Click Upload file. A small pop-up window appears.

» Click Browse to open the file selector and select a file to upload.
» Then click Upload to upload the file.

» The file will then appear in your online storage.

Once a file has been uploaded, you have several options:

Delete File If you no longer need the file, you can delete it from your ac-
count. You will be asked to confirm this action.

Download file This allows you to retrieve a file from online storage. De-
pending on the type of file and your browser’s configuration, you may
see either a download prompt or the file may be displayed in a new
browser tab.

Publish File Publishing a file makes it publicly available for other people to
view (but not change). When you publish a file, Ubuntu One will assign
it a unique URL through which the file can be viewed directly. You can
give this URL to anybody who would like to view the file. When a file is
published, its icon becomes embellished with a globe and its public URL
will be shown. To stop publishing the file, click Stop publishing. The file
will no longer be available at the URL and anybody trying to view it will
receive an error message.

Using Folders
Ubuntu One allows you to group your files into folders to make them easier
to manage, just as you would with local files.

Creating a new folder

Click New folder, enter a name in the pop-up window then click Create.
The new folder will be created and will appear in your storage.

Figure 3.32: Ubuntu One Web Dashboard

You can only upload one file at a time. If
you have a lot of files, it is easier to use file
synchronization, described later.

You may need to click More on the right hand
side of the page to see these options. You can
also download a file by clicking its name.

Be careful not to publish files unintentionally!
Bear in mind that published files can potentially
be viewed by anybody, not just people you

give the URL to: there is always a chance that
other people may stumble across the file’s URL
accidentally—for example, by mistyping the
URL of another file published by somebody
else. If the file is confidential, you should
probably not publish it! You can publish the file
again later if you wish. Its public URL will be the
same as before.



Adding and deleting files from a folder

In order to manage the files in a folder, you first need to navigate into it so
that it becomes the current folder. You do this by clicking the folder name.
Once in the folder, adding and deleting files is done exactly as before. It

is also possible to create sub-folders (and sub-sub-folders if you wish). To
return to your main folder, click My Storage in the location path.

Deleting a folder

Deleting a folder is similar to deleting a file. Just click Delete folder and
confirm that this is what you want to do. Deleting a folder will also delete
all the files and folders inside it.

Sharing a Folder

Sharing a folder allows you to give one or more people access to the folder
and its contents. You can also specify whether each person can modify

the files in the folder or just view them. Anybody you would like to share

a folder with will either need to have an existing Ubuntu One account or

be prepared to sign up for one. To share a folder with someone else, click
Share folder. A pop-up box will appear. Enter the email address of the
person you would like to share with. This person will be sent an email
containing instructions for viewing the shared folder and for signing up

to Ubuntu One if necessary. The share name is the name of the folder as

the other person will see it. For example, you might have a folder called

Pix 2011 06 Small, but want to share it as the more friendly Our Holiday
Photos. The Allow modification check box specifies whether the sharer will
be able to modify the contents of the folder (that is, to add, edit, or delete
files and sub-folders). If the box is not ticked, they will be restricted to read-
only access. Click Share this folder to begin sharing. You can share a folder
with several people by repeating these steps for each person in turn. You
can stop sharing a folder with someone by clicking Stop sharing.

Accepting a share invitation from someone else

If you are invited to share a folder by someone else, you will receive an
email containing a link. Clicking the link will take you to the Ubuntu One
website where you can log in and accept the share. After you have done so,
the shared folder will appear in your list of files.

. Dashboard L Files Notes i1 contacts

Files [juploadfile [gNewfolder (@ Share this Folder
My Storage

& Our Holiday Pictures from

* quotetxt

If you have been allowed to modify the folder by the sharer, you will be
able to add, edit and delete files and sub-folders as if the folder was one of
your own. If you don’t have modify permissions, you won’t be able to make
any changes.
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Sharing is not the same as publishing. Sharing
is more secure because there is no public URL
for the folder and the people you share with
have to be authenticated by signing in to their
Ubuntu One account.

Figure 3.33: Web Files Shared Folder

Files in folders shared by other people do not
count towards your 5GB storage allowance,
because the files are not actually stored in your
account.
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Using the Ubuntu One Control Panel

The Ubuntu One Control Panel gives you a quick and easy way to manage
your Ubuntu One account. The control panel is opened by clicking the
Ubuntu One button in the launcher.

Ubuntu One Control Panel

Using 0 bytes of 5 GiB (0%) / File sync is up-to-date.

Cloud Folders Devices Services

Welcome to Ubuntu One!
Personal details Your services

Ubuntu One Free (5 GB)
Total storage: 5 GB

Edit account details Buy storage and plans

Official Support Community Support Talk to us on: (&) B

The control panel has four tabs:

» Account: lets you amend your account details

» Cloud Folders: lets you control file and folder synchronization between
your current device and your Ubuntu One account

» Devices: lets you manage the devices attached to your Ubuntu One
account

» Services: lets you set up and manage additional synchronization options,
such as synchronizing your contacts.

The Cloud Folders tab

The Cloud Folders tab lets you control which folders are being synchro-
nized. You can specify whether a cloud folder is synchronized with a local
folder by ticking or clearing the Sync locally? check box.

The Devices tab

The Devices tab lists the devices that have been set up to synchronize with
your Ubuntu One account, with the current device highlighted. There are
two uses for this tab. Firstly, you can remove a device so that it no longer
synchronizes. Secondly, you can configure bandwidth throttling to limit
the amount of your connection’s capacity that Ubuntu One will use during
synchronization. By default, there is no throttling, but you may wish to
change this if you find that synchronization is affecting your other online
activities, such as web-browsing. Obviously, the more the bandwidth is
throttled, the longer it will take to synchronize files.

The Services tab

The services tab allows you to configure additional synchronization fea-
tures. By default, synchronization of files is always enabled. However, it

Figure 3.34: Control Panel Account

When you first open the Ubuntu One Control
Panel, you may see the Introductory page (with
the Join Now option) shown in the ‘Creating

an Ubuntu One subscription’ section. At this
point, the Control Panel is connecting to your
Ubuntu One account. Once this has been done,
the page will change to the Welcome to Ubuntu
One page shown here.

You can also control folder synchronization
through Nautilus (see later).

This controls the synchronization with your cur-
rent device only. You can choose to synchronize
different cloud folders with different devices.
For example, if someone is sharing a folder
with you, you may only want to synchronize

it with your desktop computer and not with
your laptop or smartphone. (Of course, you can
always access any cloud folder via the Ubuntu
One website whether or not it is synchronized).



is possible to synchronize other information as well—i.e., your contacts,
Tomboy notes and software selection. If you intend to use these extra fea-
tures, you should install the ubuntuone-desktopcouch package, by clicking
the Install now button on this page.

Synchronizing Contacts with Thunderbird

Your Ubuntu One account can synchronize contacts between the following
sources:

» Your Facebook account
» Your mobile phone
» Your Thunderbird address book

Thunderbird synchronization

Synchronization is handled by a Thunderbird plug-in, which can be in-
stalled from the Services tab of the Ubuntu One Control Panel.

Click the Install now button in the Contacts section to install the plug-
in. Once installed, the ‘Enable Contacts Sync’ check-box will be ticked.

After a synchronization cycle, you will see your online contacts appear
in the Ubuntu One folder in your Thunderbird address book. Synchroniza-
tion is bi-directional: if you add a contact to your Ubuntu One address book,
it will appear in your Ubuntu One account and vice versa.

Using Ubuntu One with Nautilus
Basic file and folder synchronization using Nautilus

If you created your Ubuntu One account using the Ubuntu One Control
Panel and have uploaded some files, you may be surprised to see that copies
of these files have appeared in the “Ubuntu One” folder in your home folder.
This is Ubuntu One’s file synchronization feature at work. Synchroniza-
tion is the process of replicating files and folders between devices and your
Ubuntu One account. The synchronization occurs continuously in the back-
ground (as long as you are connected to the Internet) and is bi-directional,
so that changes to either the local or cloud copy of a file will be replicated
to the other. By default, the “Ubuntu One” folder is automatically synchro-
nized. However, it is possible to synchronize other folders as well.

In Nautilus, synchronized folders are indicated with a tick mark.

Because the “Ubuntu One” folder is automatically synchronized, it pro-
vides quick and easy access to your cloud storage: any files or folders you
create in this folder will automatically be synchronized to your Ubuntu
One account with no further effort on your part. This is much easier than
manually uploading and downloading files via the Ubuntu One website. If
you make a lot of changes to synchronized files and folders in a short time,
the synchronization process may not be able to keep up with them all im-
mediately. This is especially likely to happen if you have a slow Internet
connection or you have restricted the bandwidth that synchronization is al-
lowed to use. However, the pending changes will all eventually get written.

The synchronization state of each file or folder is indicated by a badge
on its icon: a green tick means the file is synchronized, whilst a circle of
green and blue arrows means synchronization is pending or underway. In
the screenshot below, quote.txt is up to date, but ‘LargeFile.txt’ is still being
synchronized.
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Thunderbird contact synchronization is
currently only available for Ubuntu. For other
operating systems, you will need to access
contacts through the Ubuntu One website.

You need to have installed the ubuntuone-
desktopcouch package first.

You may need to restart Thunderbird to
activate the plug-in.

You can only synchronize folders in your home
folder.

R

Ubuntu One

Figure 3.35: Ubuntu One Folder Icon

You can also get an overview of the synchro-
nization state from the Ubuntu One Control
Panel, which will show either “File Syncin
progress” or “File Sync is up-to-date.” However,
the Control Panel does not show the state of
individual files.
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Ubuntu One
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"LargeFile.txt" selected (239.1 kB)

You can make any changes you like to the local copy of the file and they

will automatically be synchronized to Ubuntu One. This table summarises
how changes to the local file are synchronized:

Ubuntu One File Actions

Action Effect in Cloud Notes
Move file: into Remote file Any new file that appears in the Ubuntu
Ubuntu One created One folder will automatically begin to be
folder synchronized.
Update file: edit Remote file up-
and save dated to new

contents
Rename file Remote file

renamed
Delete file Remote file

deleted
Move file: to Remote file Because the file has been removed from
another (un- deleted the Ubuntu One folder, this is treated as
synchronized) a deletion. The file is no longer under
folder synchronization.

Synchronizing additional Folders

You can specify additional folders that should be synchronized, as long as
they are in your home folder. For instance, you may wish to synchronize
your Documents folder so that your documents are available on all your

devices. To synchronize another folder, navigate to the folder in Nautilus,

then tick the Synchronize this folder.

Alternatively, right-click a folder icon to display its shortcut menu, then

select Ubuntu One » Synchronize This Folder.

Encrypting files for security

You can give yourself an extra layer of security by encrypting sensitive
files before putting them on Ubuntu One. This will help protect you if your
Ubuntu One account is compromised. Here is a simple way to do this:

» In Nautilus, right-click on the file you want to encrypt and select Com-

press....

Figure 3.36: Ubuntu Nautilus Badges

This is not a very robust encryption method. If
you need greater protection, consider using an
application such as GPG (GNU Privacy Guard)
that uses cryptographic keys rather than
passwords.
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» The “Compress” dialog will appear with your filename selected.

» For the filetype, choose .zip.

» Click the arrow next to Other Options to expand the section and see the
Password box.

» Enter a password, then click Create.

A new file will be created with a .zip extension in the same folder as your
original document. This file contains an encrypted version of the original
file, which you can then safely upload to Ubuntu One.

Make sure you only upload the encrypted version of the file to Ubuntu One and
not the original! Don’t use your account password to protect your document. If
somebody knows your account password, they will probably try this first.

Some applications, such as LibreOffice, can already create password-
protected documents. If a document is already encrypted, there is no need
to re-encrypt it.

The .zip format will also try to compress your file, so you may find that
the encrypted file is smaller than the original. Don’t worry about this: none
of your information has been lost and when you decrypt the file, it will be
exactly the same as before.

Decrypting an encrypted file

To recover the original document, double-click the .zip file. This will open
the Archive Manager application. Click the Extract button on the toolbar,
specify a location for the decrypted file, then click Extract. At this point,
you will be prompted to enter the original password so that the file can be
decrypted.

The Shared With Me Folder

Shared With Me is a special folder where folders that other people are
sharing with you can be synchronized. By default, shared folders are not
synchronized. To enable synchronization, use the Cloud Folders tab of the
Ubuntu One Control Panel and ensure the Sync locally? box is ticked for
the shared folder you want to synchronize. The folder will then appear in
the Shared With Me folder and begin to synchronize. Once the synchro-
nization is complete, the folder emblem will change from circular blue and
green arrows to a green tick.
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Figure 3.37: Nautilus Sync






4 Hardware

Using your devices

Ubuntu supports a wide range of hardware, and support for new hardware
improves with every release.

Hardware identification

To identify your hardware you can install the following application: Click
Ubuntu Software Center from the Unity launcher. When the “Ubuntu
Software Center” window opens, use the search box in the top right and
search for the following: sysinfo. Now select the Application, click Install
and enter your password to install the application.

To run the application, search for Sysinfo at the Dash search bar. Click
on the program once you find it. The Sysinfo program will then open a
window with information about the hardware that is part of your system.

Displays

Hardware drivers

A driver consists of code that is packaged in a file, which tells your com-
puter how to communicate with a piece of hardware. Every component in a
computer requires a driver to function, whether it’s the printer, pvp player,

hard disk, or graphics card.

A majority of graphics cards are manufactured by three well-known Your graphics card is the component in your
companies: Intel, AMD/ATI, and NVIDIA Corp. You can find your video card computer that outputs to the display. When
£ b ferri s 1. looki . h you're watching videos on YouTube, viewing
manutacturer by referring to your computer's manual, looking tor the DVDs, or simply enjoying the smooth transition
specifications of your particular model on the Internet, or by using the com- effects when you maximize/minimize your
mand lspci in a terminal. The Ubuntu Software Center houses a number windows, your graphics device is doing the hard

C . . . . k behind th .
of applications that can tell you detailed system information. SysInfo is one workbenindhe scenes

such program that you can use to find relevant information about your Sys-
tem devices. Ubuntu comes with support for graphics devices manufactured
by the above companies, and many others, out of the box. That means you
don’t have to find and install any drivers yourself, Ubuntu takes care of it
all.

Keeping in line with Ubuntu’s philosophy, the drivers that are used by
default for powering graphics devices are open source. This means that
the drivers can be modified by the Ubuntu developers and problems with
them can be fixed. However, in some cases a proprietary driver (restricted
driver) provided by the company may provide better performance or fea-
tures that are not present in the open source driver. In other cases, your
particular device may not be supported by any open source drivers yet. In
those scenarios, you may want to install the restricted driver provided by
the manufacturer.

For both philosophical and practical reasons, Ubuntu does not install
restricted drivers by default but allows the user to make an informed choice.
Remember that restricted drivers, unlike the open source drivers for your
device, are not maintained by Ubuntu. Problems caused by those drivers
will be resolved only when the manufacturer wishes to address them.
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To see if restricted drivers are available for your system, press the Su-
per/Windows key on your keyboard to show the dash or click the Ubuntu
icon on the Unity launcher, and search for Additional Drivers. If a driver

is provided by the company for your particular device, it will be listed there.

You can simply click Activate to enable the driver. This process requires an
active Internet connection and it will ask for your password. Once installa-
tion is complete you may have to reboot your computer to finish activating
the driver.

The Ubuntu developers prefer open source drivers because they allow
any problem to be identified and fixed by anyone with knowledge within
the community. Ubuntu development is extremely fast and it is likely that
your device will be supported by open source drivers. You can use the
Ubuntu Live cb to check your device’s compatibility with Ubuntu before
installing, or go online to the Ubuntu forums or to http://www.askubuntu.
com to ask about your particular device.

Setting up your screen resolution

One of the most common display related tasks is setting your screen resolu-
tion.

Ubuntu correctly identifies your native screen resolution by itself and
sets it for you. However, due to a wide variety of devices available, some-
times it can’t properly identify your resolution.

To set or check your screen resolution, go to System Settings » Displays.
The “Displays” window shows you your monitor’s name, size, screen res-
olution, and refresh rate. From the Resolution drop-down menu you can
select the resolution of your choice.

Adding an extra display

Sometimes, you may want to add more than one display device to your
desktop, or may want to add an external monitor to your laptop. Doing
this is quite simple. Whether it’s an extra monitor, LCD TV, or a projector,
Ubuntu can handle it all. Ubuntu supports the addition of multiple displays
by default, which is as easy as plug and play. Ubuntu recognizes almost

all the latest monitors, TVs and projectors by default. Sometimes it may
happen that your additional display is not detected when you connect it to
the machine. To resolve this, go to System Settings » Displays and click on
Detect Displays. This will detect the monitors connected to the machine.
This menu can also be found from the Power Off menu on the top panel.
You can also search for Displays at the Dash search bar. Now, there are two

modes which you can enable for your displays. One option is to spread your

desktop across two or more monitors. This is particularly useful if you are
working on multiple projects and need to keep an eye on each of them at

the same time. The second option is to mirror the desktop onto each of the
displays. This is particularly useful when you are using a laptop to display

something on a larger screen or a projector. To enable this option just check

the box beside Mirror displays and click Apply to save the settings. You
will get a pop-up notification asking if you want to keep the current setting
or revert to the previous setting. Click to keep the current setting.

Another useful resource is the official online
documentation (http://help.ubuntu.com), which
contains detailed information about various
graphics drivers and known problems. This
same documentation can be found by searching
for Yelp in the Dash search bar or by pressing
F1 on your keyboard.

Displays are made up of thousands of tiny
pixels. Each pixel displays a different color,

and when combined they all display the image
that you see. The native screen resolution is a
measure of the amount of actual pixels on your
display.
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Connecting and using your printer

Ubuntu supports most new printers. You can add, remove, and change
printer properties by navigating to System Settings » Printing. You can also
search for Printing from the Dash search bar. Opening Printing will display
the “Printing-localhost” window.

When you want to add a printer, you will need to make sure that it is

switched on, and plugged into your computer with a UsB cable or connected

to your network.

Adding a local printer

If you have a printer that is connected to your computer with a usB cable
then this is termed a local printer. You can add a printer by clicking on the
Add Printer button.

In the left hand pane of the “New Printer” window any printers that you
can install will be listed. Select the printer that you would like to install and
click Forward.

You can now specify the printer name, description and location. Each of
these should remind you of that particular printer so that you can choose
the right one to use when printing. Finally, click Apply.

Adding a network printer

Make sure that your printer is connected to your network either with an
Ethernet cable or via wireless and is turned on. You can add a printer by
clicking Add Printer. The “New Printer” window will open. Click the “+”
sign next to Network Printer.

If your printer is found automatically it will appear under Network
Printer. Click the printer name and then click Forward. In the text fields
you can now specify the printer name, description and location. Each of
these should remind you of that particular printer so that you can choose
the right one to use when printing. Finally click Apply.

You can also add your network printer by entering the 1p address of the
printer. Select “Find Network Printer,” enter the 1p address of the printer
in the box that reads Host: and press the Find button. Ubuntu will find the
printer and add it. Most printers are detected by Ubuntu automatically. If
Ubuntu cannot detect the printer automatically, it will ask you to enter the
make and model number of the printer.

Changing printer options

Printer options allow you to change the printing quality, paper size and
media type. They can be changed by right-clicking a printer and choosing
Properties. The “Printer Properties” window will show; in the left pane,
select Printer Options.

You can now specify settings by changing the drop-down entries. Some
of the options that you might see are explained.

Media Size

This is the size of the paper that you put into your printer tray.
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If your printer can automatically do double
sided printing, it will probably have a duplexer.
Please refer to the instructions that came with
the printer if you are unsure. If you do have a
duplexer, make sure the Duplexer Installed
option is checked and then click the Forward
button.

The default printer is the one that is automat-
ically selected when you print a file. To set a
printer as default, right-click the printer that
you want to set as default and then click Set As
Default.
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Media source

This is the tray that the paper comes from.

Color Model

This is very useful if you want to print in Grayscale to save on ink, or to
print in Color, or Inverted Grayscale.

Media type

Depending on the printer you can change between:

» Plain Paper

» Automatic

» Photo Paper

» Transparency Film
» CD or DVD Media

Print quality

This specifies how much ink is used when printing, Fast Draft using the
least ink and High-Resolution Photo using the most ink.

Sound

Ubuntu usually detects the audio hardware of the system automatically
during installation. The audio in Ubuntu is provided by a sound server
named PulseAudio. The audio preferences are easily configurable with the
help of a very easy to use Gul which comes preinstalled with Ubuntu.

Volume icon and Sound Preferences

A volume icon, sitting on the top right corner of the screen, provides quick
access to a number of audio related functions. When you left-click on the
volume icon you are greeted with four options: A mute option at the very
top, a slider button which you can move horizontally to increase/decrease
volume, a shortcut to the default music player Banshee and an option for
accessing the Sound Preferences. Selecting Sound Preferences opens up
another window which provides access to sound themes, hardware, input
and output preferences. Sound Preferences can also be found if you go to
System Settings » Sound.

Sound Effects The first tab which shows up by default is Sound Effects.
You can disable the existing sound theme or configure it with the options
available.

Hardware The Hardware tab will have a list of all the sound cards available
in your system. Usually there is only one listed; however, if you have a
graphics card which supports HDMI audio, it will also show up in the list.

Input The third tab is for configuring audio Input.You will be able to use
this section when you have an in-built microphone in your system or if
you’ve pluged in an external microphone. You can also add a bluetooth
headset to your input devices which can serve as a microphone. You can

You can add new sound themes by installing
them from Software Center (e.g., Ubuntu
Studio’s GNOME audio theme.) You will get the
installed sound themes from the drop down
menu. You can also enable window and button
sounds.

A microphone is used for making audio/video
calls which are supported by applications like
Skype or Empathy. It can also be used for sound
recording.

You should note that by default in any Ubuntu
installation, the input sound is muted. You
will have to manually unmute to enable your
microphone to record sound or use it during
audio/video calls.



increase/decrease and mute/unmute input volume from this tab. If there is
more than one input device, you will see them listed in the white box which
reads Choose a device for sound input.

Output The Output tab is used for configuring the output of audio. You
can increase/decrease and mute/unmute output volume and select your
preferred output device. If you have more than one output device, it will be
listed in the section which reads “Choose a device for sound output.” The
default output hardware, which is automatically detected by Ubuntu during
installation will be selected.

Applications The Applications tab is for changing the volume for running
applications. This comes in handy if you have multiple audio applications
running, for example, if you have Rhythmbox, Totem Movie Player and a
web-based video playing at the same time. In this situation, you will be able
to increase/decrease, mute/unmute volume for each application from this
tab.

More functionality

The icon can control various aspects of the system, application volume and
music players like Banshee. The volume indicator icon can now be easily
referred to as the sound menu, given the diverse functionality of the icon.
Media controls available include play/pause, previous track, and next track.
You can also switch between different playlists from the Choose Playlist
option. There is also a seek bar which you can manually drag to skip some
portions of any song. If the current playing song has album art, it will
show up beside the name of the current track, otherwise you will see only
the details of the song. It displays the track name, the artist name and the
album name of the current track.

Using a webcam

Webcams often come built into laptops and netbooks. Some computers,
such as Apple desktops, have a webcam built into their display. If you
purchase a webcam because your computer doesn’t have its own, it will
most likely have a UsB connection. To use a USB webcam, plug it into an
empty USB port on your computer.

Almost all new webcams are detected by Ubuntu automatically. You can
configure webcams for individual applications such as Skype and Empathy
from the application’s setup menu. For webcams which do not work right
away with Ubuntu, visit https://wiki.ubuntu.com/Webcam for help.

Scanning text and images

Scanning a document or an image is very simple in Ubuntu. Scanning is
handled by the application Simple Scan. Most of the time, Ubuntu will
simply detect your scanner and you should just be able to use it. To scan a
document, follow these steps:

1. Place what you want to scan on the scanner.
2. Click to open the Dash and enter scan.
3. Click on Simple Scan.
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By default, the volume in Ubuntu is set to
maximum during installation.

If you change your sound output device, it will
remain as default.

The Ubuntu Design Team have made a few
changes to the volume icon in this release of
Ubuntu 11.10.

You can start and control the default music
player, Banshee, by simply left clicking on the
sound menu and selecting Banshee from the
list. Clicking the play button also starts the
player.

There are several applications which are useful
if you have a webcam. Cheese can capture
pictures with your webcam and VLC media
player can capture video from your webcam.
You can install these from the Ubuntu Software
Center.


https://wiki.ubuntu.com/Webcam
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Click to choose between Text or Photo from Document » Scan » Text.
Click Scan.

Click the Paper Icon to add another page.

Click Save to save.
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You can save the scanned documents and pictures in jpeg. You can also
save in pdf format to enable opening in Acrobat Reader. To do that, add the
extension “.pdf” at the end of the filename.

Help! Ubuntu can’t find my scanner!

If your scanner is not detected, Ubuntu may give you a “No devices avail-
able” message when trying to scan. There may be a reason why Ubuntu
cannot find your scanner.

» Simply unplug the scanner and plug it back in. If it is a newer USB scan-
ner, it is likely that it will just work.

» The driver for your scanner is not being automatically loaded. Restart
your system. It might help!

» Your scanner is not supported in Ubuntu. The most common type
of scanner not supported is old parallel port or Lexmark All-in-One
printer/scanner/faxes.

» SANE project listing of supported scanners. The SANE (Scanner Access
Now Easy) project provides most of the back-ends to the scanning soft-
ware on Ubuntu.

» Check https://wiki.ubuntu.com/HardwareSupportComponentsScanners
to find out which scanners work with Ubuntu.

Other devices

usB

USB ports are available as standard on almost all computers available now.
They are used to connect a multitude of devices to your computer. These
could include portable hard drives, flash drives, removable cp/pvp/Blu-ray
drives, printers, scanners and mobile phones. When connected, flash drives
and portable hard drives are automatically detected—the file manager will
open and display the contents of the drive. You can then use the drives

for copying data to and from the computer. All new cameras, camcorders
and mobile phone sp cards are automatically detected by Ubuntu. These
SD cards have different types of data, so a window will appear with a drop
down menu to choose between video, audio import and the file manager
—you can choose your desired action from this menu.

Firewire

Firewire is a connection on some computers that allows you to transfer data
from devices. This port is generally used by camcorders and digital cameras.
If you want to import video from your camcorder you can do so by
connecting your camcorder to the Firewire port. You will need to install a
program called Kino which is available in the Ubuntu Software Center.

Bluetooth

Bluetooth is a wireless technology that is widely used by different types of
devices to connect to each other. It is common to see a mouse or a keyboard

Firewire is officially known as IEEE 1394. It
is also known as the Sony i.LINK and Texas
Instruments Lynx.

To find out more about Kino, visit http://www.
kinodv.org/.
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that supports Bluetooth. You can also find Gps devices, mobile phones,
headsets, music players and many other devices that can connect to your
desktops or laptop and let you transfer data, listen to music, or play games
as an example.

If your computer has Bluetooth support then you should see a Bluetooth
icon in the top panel, usually near the volume icon. Click on the Bluetooth
icon to open a popup menu with several choices, such as an option to Turn
off Bluetooth.

The Bluetooth preferences can also be accessed from System Settings »
Bluetooth. If you want to connect a new device—for example, to have a
mobile phone send pictures or videos to your computer—select Setup new
device....

Ubuntu will open a window for new device setup. When you click For-
ward, Ubuntu will show you how many Bluetooth devices are present near
your computer. The list of available devices might take a minute or so to
appear on the screen as your system scans for these devices. Each device
will be displayed as soon as it is found by Ubuntu. Once a device you’d like
to connect with appears in the list, click on it. Then, choose a PIN number
by selecting PIN options.

Three predefined pIN numbers are available, but you can also create a
custom PIN. You will need to enter this PIN on the device you will be pairing
with Ubuntu.

Once the device has been paired, Ubuntu will open the “Setup com-
pleted” window. In Ubuntu, your computer is hidden by default for security
reasons. This means that your Ubuntu system can search other Bluetooth
devices, but others cannot find your Ubuntu system when they perform a
search on their own computer. If you would like to let another device find
your computer, you will have to explicitly allow your computer to be found.
To allow your computer to be found, select “Make computer discoverable”
in Bluetooth preferences. You can also click on the Bluetooth icon and
select Visible to make your computer discoverable.

You can also add a fancy name for your Bluetooth-enabled Ubuntu sys-
tem by changing the text under Friendly Name.

Another feature present in the Bluetooth icon menu is “Send files to
device” Use this option to send a file to a mobile phone without pairing
with the computer.
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Figure 4.1: The Bluetooth applet menu.
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When you pair two Bluetooth devices, you are
letting each device trust the other one. After

you pair two devices, they will automatically
connect to each other in the future without

requiring a PIN.

Android devices need to be paired at all times,

even while transferring files.






5 Software Management

Software management in Ubuntu

As discussed in Chapter 3: Working with Ubuntu, Ubuntu offers you a
wide range of applications for your daily work. Ubuntu comes with a basic
set of applications for common tasks like surfing the Internet, checking
your email, listening to music, and organizing your photos and videos.
Sometimes you may need an extra level of specialization: for example you
may want to retouch your photos, run some software for your business,

or play some new games. In each of these cases you can search for an
application, install it and use it—usually, with no extra cost.

Software in Ubuntu is delivered as packages, simplifying the installa-
tion to one click. A package is a compressed file archive containing every-
thing needed to run the application. Packages can also contain information
describing which other applications, called dependencies or libraries, are
needed. Linux is designed in a way that any library can be updated without
having to reinstall the complete application, minimizing hard drive usage by
letting other applications use the same library.

Most other operating systems require a user to purchase commercial
software (online or through a physical store), or search the Internet for a
free alternative (if one is available). The correct installation file must then
be verified for integrity, downloaded and located on the computer, followed
by the user proceeding through a number of installation prompts and op-
tions. By default Ubuntu gives you a centralized point with two different
ways to browse the repositories for searching, installing and removing soft-
ware.

» Ubuntu Software Center
» Command line apt-get

Searching, installing and/or removing applications with Ubuntu Software
Center is the easiest and most comfortable way. It is recommended for all
kinds of users, starting from beginners to the most experienced.

Using the Ubuntu Software Center

There are numerous ways to install software on an operating system. In
Ubuntu, the quickest and easiest way to find and install new applications is
through the Ubuntu Software Center.

To start the application, click on the Ubuntu Software Center icon in the
launcher, or click on the Dash and search for Ubuntu Software Center.

The Ubuntu Software Center can be used to install applications that are
available in the official Ubuntu repositories. The Software Center window
has two parts—a list of categories on the left, a banner at the top, and two
featured areas on the right. Clicking on a category will take you to a list
of related applications. For example, the Internet category contains Firefox
Web Browser. The featured areas highlight What’s New and Top Rated
software. Each area shows different application icons. Just click an icon to
get more information on the application or to install it. To see all software
the area contains, click More.

Figure 5.1: Software Center icon

We recommend Ubuntu Software Center for
searching, installing and removing applications,
although you still have the possibility to use the
command-line application apt-get, orinstall
and use the advanced application Synaptic
Package Manager.
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Figure 5.2: You can install and remove applica-
tions from your computer using the Software
Center.
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Three sections at the top represent your current view of the Software
Center’s catalog. Click the All Software button to see software that is avail-
able to install, click Installed to see a list of software that is already installed
on your computer, or click History to see previous installations and dele-
tions organized by date.

Find your application

Ubuntu Software Center displays different sources in the “Get Software”
section. Clicking the arrow next to “All Software” will show a list of in-
dividual sections. Selecting “Provided by Ubuntu” will show free official
software, “For Purchase” will show software for purchasing, and “Canonical
Partners” will show software from partners of Canonical, such as Adobe.

If you are looking for an application, you may already know a specific
name (for example, VLC Media Player), or you may just have a general
category in mind (for example, the Sound and Video category includes a
number of different software applications such as video converters, audio
editors, and music players).

To help you find the right application, you can browse the Software
Center catalog by clicking on the category that reflects the type of software
you are looking for, or use the Search field at the top right of the window to
look for specific names or keywords.

When you select a category, you will be shown a list of applications.
Some categories have sub-categories—for example, the Games category has
subcategories for Simulation and Card Games. To move through categories
you can use the back and forward buttons at the top of the window.

Installing software

Once you have found an application you would like to try, installing it is
just one click away:.
To install software:



1. Click the Install button to the right of the selected package to install it. If
you would like to read more about the software package before installing
it, first click on “More Info.” This will take you to a short description of
the application, as well as a screenshot and a Web link when available.
Related add-ons will be listed below the application’s description. You
can click Install from this screen as well. In addition, if you use the
Gwibber micro-blogging application, you can hit the “Share..” link below
the description of an application to tell your friends about it.

2. After clicking Install, enter your password into the authentication win-
dow that appears. This is the same password you use to log in to your
account. You are required to enter it whenever installing or removing
software in order to prevent someone without administrator access
from making unauthorized changes to your computer. If you receive an
Authentication Failure message after typing in your password, check
that you typed it correctly by trying again. If the error continues, this
may mean that your account is not authorized to install software on the
computer.

3. Wait until the package is finished installing. During the installation
(or removal) of programs, you will see an animated icon of rotating
arrows to the left of the In Progress button in the sidebar. If you like, you
can now go back to the main browsing window and choose additional
software packages to be installed by following the steps above. At any
time, clicking the Progress button on the top will take you to a summary
of all operations that are currently processing. Here you can also click
the X icon to cancel any operation.

Once the Software Center has finished installing an application, it is ready
to be used. You can start the newly installed application by going to the
Dash and typing the name of the application in the search bar. You may
want to add the application to the Launcher.

Removing software

Removing applications is very similar to installing them. First find the in-
stalled software in Ubuntu Software Center. You can click on the Installed
button which will show all the installed software listed in different cate-
gories. Scroll down to the application you wish to remove. If you click on
the arrow next to Installed button, you will find a list of software providers,
which can help you to narrow your search. You also can enter keywords in
the Search field to quickly find installed software, or you can search by date
in the History tab (more on History below).

To remove software:

1. Click the Remove button to the right of the selected application.

2. Enter your password into the authentication window that appears. Re-
moving Software also requires that you enter your password to help
protect your computer against unauthorized changes. The package will
then be queued for removal, and will appear under the progress section
in the top.

Removing a package will also update your menus accordingly.
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You must have administrative privileges, and
you will need to be connected to the Internet
for the Software Center to work. To learn how
to set up your Internet connection, see Getting
online.
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Software history

The Ubuntu Software Center keeps track of past software management
in the History section. This is useful if you wish to revert installations or
removals and do not remember the application’s name.

There are four buttons in the history section—All Changes, Installations,
Updates and Removals. Clicking one will show a list of days that action
occurred. If you click the arrow next to a day, a list of individual packages
will be shown, along with what was done with them and at what time. The
History section shows all software installation history, not just changes
made within the Software Center. For example, packages updated through
the Update Manager will also be listed.

Managing additional software

Although the Ubuntu Software Center provides a large library of appli-
cations to choose from, initially only those packages available within the
official Ubuntu repositories are listed. At times, you may be interested in a
particular application that is not available in these repositories. If this hap-
pens, it is important to understand some alternative methods for accessing
and installing software in Ubuntu, such as downloading an installation file
manually from the Internet, or adding extra repositories. First, we will look
at how to manage your repositories through Software Sources.

Software Sources

The Ubuntu Software Center lists only those applications that are available
in your enabled repositories. Repositories can be added or removed through
the Software Sources application. To open this, click on the Dash and enter
Software Sources. Then open the application from the results shown.

Managing the official repositories

When you open Software Sources, it shows you the Ubuntu Software tab
where the first four options are enabled by default.

Canonical-supported open source software (main) This repository contains
all the open-source packages that are maintained by Canonical.

Community-maintained open source software (universe) This repository
contains all the open-source packages that are developed and maintained
by the Ubuntu community.

Proprietary drivers for devices (restricted) This repository contains propri-
etary drivers, which may be required to utilize the full capabilities of
some of your devices or hardware.

Software restricted by copyright or legal issues (multiverse) This repository
contains software that may be protected from use in some states or
countries by copyright or licensing laws. By using this repository you
assume responsibility for the usage of any packages that you install.

Source code This repository contains the source code that is used to build
the software packages from some of the other repositories. The Source
code option should not be selected unless you have experience with
building applications from source.

You can also open Software Sources from the
Ubuntu Software Center. Simply go to Edit »
Software Sources.

The Ubuntu Software tab lists the official
Ubuntu repositories, each containing different
types of packages.

Closed-source packages are sometimes
referred to as non-free. This is a reference to
freedom of speech, rather than monetary cost.
Payment is not required to use these packages.

Building applications from source is an ad-
vanced process for creating packages, and
usually only concerns developers. You may
also require source files when using a custom
kernel, or if trying to use the latest version of
an application before it is released for Ubuntu.
As this is a more advanced area, it will not be
covered in this manual.
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Selecting the best software server

Ubuntu provides and allows many servers around the world to mirror the
packages from the sources listed under “Managing the official repositories.” Ubuntu grants permission to many servers all

When selecting a server, you may want to consider the following: across the world to act as mirrors. That is, they
host an exact copy of all the files contained in

. . . . . the official Ubuntu repositories.
Distance to server. This will affect the speed you can achieve with the file P

server.

Internet Service Provider. Some Internet service providers offer cheaper, or
even unlimited free downloads from their own servers.

Quality of server. Some servers may only offer downloads at a capped
speed, limiting the rate at which you can install and update software on
your computer.

Ubuntu will automatically choose an appropriate server while installing,
and as such these settings should not be changed unless your physical
location changes drastically or if you feel a higher speed should be achieved
by your Internet connection. The guide below will help in choosing an
optimal server.

Ubuntu provides a tool for selecting the server that provides the fastest
connection with your computer.

1. Click the dropdown box next to “Download from:” in the Software
Sources window.

2. Select “Other..” from the list.

3. In the “Server Selection” window that appears. Click the Select Best
Server button in the upper right. Your computer will now attempt a
connection with all the available servers, then select the one with the
fastest speed.

If you are happy with the automatic selection, click Choose Server to
return to the Software Sources window.

If you are not happy with the automatic selection or prefer not to use
the tool, the fastest server is often the closest server to you geographically.
In this case simply choose “Other” then find the nearest location to your
computer. When you are happy with the settings chosen click Choose
Server to return to the Software Sources window.

If you do not have a working Internet connection, updates and programs
can be installed from the installation media itself by inserting your media
and clicking the box under “Installable from cp-rom/DVD.” Once this box is
checked the media within thecp-rRom/DVD drive will function as an online
repository and as such the software on the media will be installable from
the Ubuntu Software Center.

Adding more software repositories

Ubuntu makes it easy to add additional, third-party repositories to your APPAs a Personal Package Archive. These
list of software sources. The most common repositories added to Ubuntu \al;er:::;‘zfrzgff’;';"rre'esa‘izd : ch’sltt:‘erlzt::tts
are called ppas. These allow you to install software packages that are not and other app“cationz 9es, ClgRal projecs,
available in the official repositories, and automatically be notified whenever
updates for these packages are available.

If you know the web address of a ppa’s Launchpad site, adding it to your
list of software sources is relatively simple. To do so, you will need to use
the Other Software tab in the “Software Sources” window.

On the Launchpad site for a ppa, you will see a heading to the left called
“Adding this PPA to your system.” Underneath will be a short paragraph
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containing a unique URL in the form of ppa:test-ppa/example. Highlight this
URL by selecting it with your mouse, then right-click and select Copy.

Lifesaver : Chris Jones - Mozilla Firefox

Een B = o) 1123PM L c7p ¥

Ip Lifesaver : Chris Jones

1> launchpad.net launchpad.net MR B Q @

Login/Register |~

.
Chris Jones
B m Code Bugs Blueprints Translations Answers

Lifesaver © view package deals
Chris Jones » Lifesaver
Latest updates
PPA description lifesaver 36 weeks ago v
Packages of Lifesaver, a GNOME Screensaver which displays recent posts from Twitter and SuccessFully built
Identi.ca about Ubuntu. lifesaver 81 weeks ago v
Successfully built
lifesaver 81 weeks ago
o v

Successfully built

Adding this PPA to your system PPA statistics

You can update your system with unsupported packages from this untrusted PPA by Activity
adding ppa:emsiflifesaver to your system's Software Sources. (Read about installing) 0 updates added during the past month.

b Technical details about this PPA

For questions and bugs with software in this PPA please contact & Chris Jones.

View package details
Overview of published packages

Published in: | Any series Filter

1-30f 3results

Package Version Uploaded by

& Chris Jones (2011-02-24)
8 chris Jones (2010-04-19)
& chris Jones (2010-04-19)

g lifesaver 1.4-1-ppat
) lifesaver 13-1ppa8
() liFesaver 1.3-1ppa7

Return to the “Software Sources” window, and in the Other Software tab
click Add... at the bottom. A new window will appear, and you will see the
words “Apt line:” followed by a text field. Right-click on the empty space in
this text field and select Paste, and you should see the URL appear that you
copied from the ppas Launchpad site earlier. Click Add Source to return to
the “Software Sources” window. You will see a new entry has been added
to the list of sources in this window, with a selected check box in front
meaning it is enabled.

If you click Close in the bottom right corner of this window, a message
will appear informing you that “The information about available software
is out-of-date” This is because you have just added a new repository to
Ubuntu, and it now needs to connect to that repository and download a
list of the packages that it provides. Click Reload, and wait while Ubuntu
refreshes all of your enabled repositories (including this new one you just
added). When it has finished, the window will close automatically.

Congratulations, you have just added a PPA to your list of software
sources. You can now open the Software Center and install applications
from this ppa, in the same way you previously installed applications from
the default Ubuntu repositories.

Manual software installation

Although Ubuntu has extensive software available, on some occasions you
may want to manually install software packages that are not available in the
repositories. If there is not a ppa for the software, you will need to install it
manually. Before you choose to do so, make sure you trust the package and
its maintainer.

Packages in Ubuntu have a .deb extension. Double-clicking a package

Figure 5.3: This is an example of the Launchpad
page for the Lifesaver PPA. Lifesaver is an
application that is not available in the official
Ubuntu repositories. However, by adding

this PPA to your list of software sources, it
would then be easy to install and update this
application through the Software Center.
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will open an overview page in the Software Center, which will give you
more information about that package.

The overview gives some technical information about that package, a
website link (if applicable) and the option to install. Clicking Install will
install the package just like any other installation in the Software Center.

Updates and upgrades

Ubuntu also allows you to decide how to manage package updates through
the Updates tab in the Software Sources window.

Ubuntu updates

In this section, you are able to specify the kinds of updates you wish to
install on your system, and usually depends on your preferences around
stability, versus having access to the latest developments.

Important security updates These updates are highly recommended to
ensure your system remains as secure as possible. These are enabled by
default.

Recommended updates These updates are not as important for keeping your
system secure, but will mean your packages always have the most recent
bug fixes or minor updates that have been tested and approved. This
option is also enabled by default.

Pre-released updates This option is for those who would rather remain
up-to-date with the very latest releases of applications, at the risk of in-
stalling an update that has unresolved bugs or conflicts. Note that it is
possible that you will encounter problems with these updated applica-
tions, therefore this option is not enabled by default.

Unsupported updates These are updates that have not yet been fully tested
and reviewed by Canonical. Some bugs may occur when using these
updates, and so this option is also not enabled by default.

Automatic updates

The middle section of this window allows you to customize how your sys-
tem manages updates, such as the frequency with which it checks for new
packages, as well as whether it should install important updates right away
(without asking for your permission), download them only, or just notify
you about them.

Release upgrade
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Here you can decide which system upgrades you would like to be notified Every 6 months, Canonical will release a new
about. version of the Ubuntu operating system. These
are called normal releases. Every four normal

Never Choose this if you would rather not be notified about any new releases—or 24 months—Canonical releases

Ubuntu releases.

a long-term support (LTS) release. Long-term
support releases are intended to be the most

Normal releases Choose this if you always want to have the latest Ubuntu stable releases available, and are supported for

release, regardless of whether it is a Long Term Support release or not. a longer period of time.
This option is recommended for normal home users.
Long Term Support releases only Choose this option if you need a release
that will be more stable and have support for a longer time. If you use
Ubuntu for business purposes, you may want to consider selecting this
option.






6 Advanced Topics

Ubuntu for advanced users

By now, we hope you understand how using Ubuntu can make your com-
puting experience easier, safer, and more efficient. So far, we've provided
detailed instructions on getting the most from Ubuntu’s basic features. In
this chapter, we’ll detail some of Ubuntu’s more advanced features—like
the terminal, a powerful utility that can help you accomplish tasks without
the need for a graphical user interface (cur). We’ll also discuss some ad-
vanced security measures you can implement to make your computer even
safer. We’ve written this chapter with advanced users in mind. If you're
new to Ubuntu, don’t feel as though you’ll need to master these topics to
get the most out of your new software (you can quite easily skip to the next
chapter without consequence). However, if you’re looking to expand your
knowledge of Ubuntu, we encourage you to keep reading.

Introduction to the terminal

Throughout this manual, we have focused primarily on the graphical desk-
top user interface. However, in order to fully realize the power of Ubuntu,
you may want to learn how to use the terminal.

What is the terminal?

Most operating systems, including Ubuntu, have two types of user in-
terfaces. The first is a graphical user interface (Gur). This is the desktop,
windows, menus, and toolbars that you click to get things done. The second,
and much older, type of interface is the command-line interface (cL).

The terminal is Ubuntu’s command-line interface. It is a method of
controlling some aspects of Ubuntu using only commands that you type on
the keyboard.

Why would | want to use the terminal?

You can perform most day-to-day activities without ever needing to open
the terminal. However, the terminal is a powerful and invaluable tool that
can be used to perform many useful tasks you might not be able to accom-
plish with a cul. For example:

» Troubleshooting any difficulties that may arise when using Ubuntu
sometimes requires you to use the terminal.

» A command-line interface is sometimes a faster way to accomplish a
task. For example, it is often easier to perform operations on many files
at once using the terminal.

» Learning the command-line interface is the first step towards more
advanced troubleshooting, system administration, and software develop-
ment skills. If you are interested in becoming a developer or an advanced
Ubuntu user, knowledge of the command-line will be essential.
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Opening the Terminal

You can open the terminal by clicking Dash » Applications » Terminal.

When the terminal window opens, it will be largely blank apart from
some text at the top left of the screen, followed by a blinking block. This
text is your prompt—it displays your login name and your computer’s
name, followed by the current directory. The tilde (~) means that the current
directory is your home directory. Finally, the blinking block is the cursor
—this marks where text will be entered as you type.

To test a terminal command, type pwd and press Enter. The terminal
should display /home/yourusername. This text is called the “output” You
have just used the pwd (print working directory) command, which outputs
(displays) the current directory.

quickshot@rocket: ~
quickshot@rocket:~5 ||

All commands in the terminal follow the same approach: Type a com-
mand, possibly followed by some parameters, and press Enter to perform
the specified action. Often some output will be displayed that confirms the
action was completed successfully, although this depends on the command.
For example, using the cd command to change your current directory (see
below) will change the prompt, but will not display any output.

The rest of this chapter covers some very common uses of the terminal.
However, it cannot address the nearly infinite possibilities available to
you when using the command-line interface in Ubuntu. Throughout the
second part of this manual, we will continue to refer to the command line,
particularly when discussing steps involved in troubleshooting and the
more advanced management of your computer.

Ubuntu file system structure

Ubuntu uses the Linux file system, which is based on a series of folders in
the root directory. Each of these folders contains important system files that
cannot be modified unless you are running as the root user or use sudo. This
restriction exists for both security and safety reasons: computer viruses will
not be able to change the core system files, and ordinary users should not be
able to accidentally damage anything vital.

Below are some of the most important directories.

The root directory—denoted by /—contains all other directories and files.
Here are the contents of some essential system directories:

/bin & /sbin Many essential system applications (equivalent to C:\Windows)

/etc System-wide configuration files

/home Each user will have a subdirectory to store personal files (for exam-
ple /home/your-username, equivalent to C:\Users or C:\Documents and
Settings)

The terminal gives you access to what is called a
shell. When you type a command in the terminal
the shell interprets this command, resulting

in the desired action. Different types of shells
accept slightly different commands. The most
popular is called “bash,” and is the default shell
in Ubuntu.

In GUI environments the term “folder” is
commonly used to describe a place where
files are stored. In CLI environments the
term “directory” is used to describe the same
thing and this metaphor is exposed in many
commands (i.e., cd or pwd) throughout this
chapter.

Figure 6.1: The default terminal window allows
you to run hundreds of useful commands.

Parameters are extra segments of text,
usually added at the end of a command, that
change how the command itself is interpreted.
These usually take the form of -h or - -

help, for example. In fact, --help can be
added to most commands to display a short
description of the command, as well as a list
of any other parameters that can be used with
that command.
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Figure 6.2: Some of the most important
i directories in the root file system.
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/1ib Library files, similar to .d11 files on Windows

/media Removable media (cp-rRoMs and UsB drives) will be mounted in this
directory

/root This contains the root user’s files (not to be confused with the root
directory)

/usr Pronounced “user,” it contains most program files (not to be confused
with each user’s home directory, equivalent to C:\Program Files)

/var/log Contains log files written by many applications

Every directory has a path. The path is a directory’s full name—it de-
scribes a way to navigate the directory from anywhere in the system.

For example, the directory /home/your-username/Desktop contains
all the files that are on your Ubuntu desktop. The path, /home/your-
username/Desktop, can be broken down into a few pieces:

1. /—indicates that the path starts at the root directory

2. home/—from the root directory, the path goes into the home directory

3. your-username/—from the home directory, the path goes into the your-
username directory

4. Desktop—from the your-username directory, the path ends up in the
Desktop directory

Every directory in Ubuntu has a complete path that starts with the / (the
root directory) and ends in the directory’s own name.

Directories and files that begin with a period are hidden directories.
These are usually only visible with a special command or by selecting a
specific option. In the Nautilus you can show hidden files and directories by
selecting View » Show Hidden Files, or by pressing Ctrl+H. There are many
hidden directories in your home folder used to store program preferences.
For example, /home/your-username/.evolution stores preferences used by
the Evolution mail application.

Mounting and unmounting removable devices

Any time you add storage media to your computer—an internal or external
hard drive, a uss flash drive, a cD-RoM—it needs to be mounted before it is
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accessible. Mounting a device means to associate a directory name with the
device, allowing you to navigate to the directory to access the device’s files.

When a device such as a UsB flash drive or a media player is mounted in
Ubuntu, a folder is automatically created for it in the media directory and
you are given the appropriate permissions to be able to read and write to
the device.

Most file managers will automatically add a shortcut to the mounted
device in the side bar of your home folder, so the device is easy for you to
access. You shouldn’t have to physically navigate to the media directory in
Ubuntu, unless you choose to do so from the command line.

When you’ve finished using a device, you can unmount it. Unmounting a
device disassociates the device from its directory, allowing you to eject it.

Securing Ubuntu

Now that you know a bit more about using the command line, we can use it
to make your computer more secure. The following sections discuss various
security concepts, along with procedures for keeping your Ubuntu running
smoothly, safely, and securely.

Why Ubuntu is safe
Ubuntu is secure by default for a number of reasons:

» Ubuntu clearly distinguishes between normal users and administrative
users.

» Software for Ubuntu is kept in a secure online repository, which contains
no false or malicious software.

» Open-source software like Ubuntu allows security flaws to be easily
detected.

» Security patches for open-source software like Ubuntu are often released
quickly.

» Many viruses designed to primarily target Windows-based systems do
not affect Ubuntu systems.

Basic security concepts

The following sections discuss basic security concepts—like file permissions,
passwords, and user accounts. Understanding these concepts will help you
follow the remaining procedures for securing your computer.

Permissions

In Ubuntu, files and folders can be set up so that only specific users can
view, modify, or run them. For instance, you might wish to share an impor-
tant file with other users, but do not want those users to be able to edit the
file. Ubuntu controls access to files on your computer through a system of
“permissions.” Permissions are settings that you can configure to control
exactly how files on your computer are accessed and used.

To learn more about modifying permissions, visit https://help.ubuntu.
com/community/FilePermissions.
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Passwords

You should use a strong password to increase the security of your com-
puter. Your password should not contain names, common words or com-
mon phrases. By default, the minimum length of a password in Ubuntu is
four characters. We recommend a password with more than the minimum
number of characters. A password with a minimum of eight characters
which includes both upper and lower case letters, numbers and symbols is
considered strong.

Locking the screen

When you leave your computer unattended, you may want to lock the
screen. Locking your screen prevents anyone from using your computer
until your password is entered. To lock the screen:

» Click the session menu icon in the right corner of the top panel, then
select Lock Screen, or

» press Ctrl+Alt+L to lock the screen. This keyboard shortcut can be
changed in Dash » Applications » Keyboard Shortcuts

User accounts
Users and groups

When Ubuntu is installed, it is automatically configured for a single person
to use. If more than one person will use the computer with Ubuntu, each
person should have her or his own user account. This way, each user can
have separate settings, documents, and other files. If necessary, you can also
protect files from being viewed or modified by users without administrative
privileges.

Like most operating systems, Ubuntu allows you to create separate user
accounts for each person that uses the computer. Ubuntu also supports user
groups, which allow you to administer permissions for multiple users at the
same time.

Every user in Ubuntu is a member of at least one group—the group’s
name is the same as the name of the user. A user can also be a member of
additional groups. You can configure some files and folders to be accessible
only by a user and a group. By default, a user’s files are only accessible by
that user; system files are only accessible by the root user.
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User Accounts Figure 6.3: Add, remove and change the user

All settings & Unlock accounts.

My Account

c7p

Other Accounts Account type  Administrator

Language English (United States)
Login Options
Password  sssse

Automatic Legin
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Managing users

You can manage users and groups using the Users and Groups administra-
tion application. To find this application, click Session Indicator » Systems
and Settings » User Accounts.

To adjust the user and group settings, first select the user that you want
to modify from the list. Then click “Change..” next to the element that you
want to make changes to. You will need to input your password in order to
make changes to user and group settings.

Adding a user Click the Add button which appears underneath a list of
the current user accounts that have already been created. A window will
appear that has two fields. The Name field field is for a friendly display
name. The Username field is for the actual username. Fill in the requested
information, then click OK. A new dialog box will appear asking you to
enter a password for the user you have just created. Fill out the fields, then
click OK. Privileges you grant to the new user can be altered in “Users
Settings”.

Modifying a user Click on the name of a user in the list of users, then click
on the Change... button, which appears next to each of following options:

» Account type:
» Password:

For more advanced user options click on the Advanced Settings button.
Change the details as required in the dialog that appears. Click OK to save
the changes.

Deleting a user Select a user from the list and click Delete. Ubuntu will
deactivate the user’s account, and you can choose whether remove the
user’s home folder or leave it.

Managing groups

Click on the Manage Groups button to open the group management dialog.

Adding a group To add a group, click Add. In the dialog that appears,
enter the group name and select the names of users you would like to add to
the group.

Modifying a group To alter the users in an existing group, select a group
and click on the Properties button. Select and deselect the users as required,
then click OK to apply the changes.

Deleting a group To delete a group, select a group and click Delete.

Applying groups to files and folders

To change the group associated with a file or folder, open the Nautilus file
browser and navigate to the appropriate file or folder. Then, either select
the folder and choose File » Properties from the menubar, or right-click on
the file or folder and select Properties. In the Properties dialog that appears,
click on the Permissions tab and select the desired group from the Groups
drop-down list. Then close the window.
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Using the command line

You can also modify user and group settings via the command line. We
recommend that you use the graphical method above unless you have a
good reason to use the command line. For more information on using the
command line to modify users and groups, see the Ubuntu Server Guide at
https://help.ubuntu.com/11.10/serverguide/C/user-management.html

System updates

Good security depends on an up-to-date system. Ubuntu provides free
software and security updates. You should apply these updates regularly.
See Updates and upgrades to learn how to update your Ubuntu computer
with the latest security updates and patches.

Trusting third party sources

Normally, you will add applications to your computer via the Software Cen-
ter, which downloads software from the Ubuntu repositories as described
in Chapter 5: Software Management. However, it is occasionally necessary
to add software from other sources. For example, you may need to do this
when an application is not available in the Ubuntu repositories, or when
you need a newer version of the one available in the Ubuntu repositories.
Additional repositories are available from sites such as getdeb.net and
Launchpad pras, which can be added as described in Software Sources. You
can download the DEB packages for some applications from their respective
project sites on the Internet. Alternately, you can build applications from
their source code (an advanced method of installing and using applications).
Using only recognized sources such as a project’s site, PPA, or various
community repositories (such as getdeb.net) is more secure than down-
loading applications from an arbitrary (and perhaps less reputable) source.
When using a third party source, consider its trustworthiness, and be sure
you know exactly what you’re installing on your computer.

Firewall

A firewall is an application that protects your computer against unautho-
rized access by people on the Internet or your local network. Firewalls
block connections to your computer from unknown sources. This helps
prevent security breaches.

Uncomplicated Firewall (Urw) is the standard firewall configuration
program in Ubuntu. It is a program that runs from the command line, but
a program called Gufw allows you to use it with a graphical interface. See
Chapter 5: Software Management to learn more about installing the Gufw
package.

Once it’s installed, start Gufw by clicking Dash » Applications » Firewall
configuration. To enable the firewall, select the Enable option. By default,
all incoming connections are denied. This setting should be suitable for
most users.

If you are running server software on your Ubuntu system (such as a
web server, or an FTP server), then you will need to open the ports these
services use. If you are not familiar with servers, you will likely not need to
open any additional ports.
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To open a port click on the Add button. For most purposes, the Precon-
figured tab is sufficient. Select Allow from the first box and then select the
program or service required.

The simple tab can be used to allow access on a single port, and the
Advanced tab can be used to allow access on a range of ports.

Encryption

You may wish to protect your sensitive personal data—for instance, finan-
cial records—by encrypting it. Encrypting a file or folder essentially “locks
that file or folder by encoding it with an algorithm that keeps it scrambled
until it is properly decoded with a password. Encrypting your personal data
ensures that no one can open your personal folders or read your private
data without your private key.

Ubuntu includes a number of tools to encrypt files and folders. This
chapter will discuss two of these. For further information on using en-
cryption with either single files or email, see Ubuntu Community Help
documents at https://help.ubuntu.com/community.

»

Home folder

When installing Ubuntu, it is possible to encrypt a user’s home folder. See
Chapter 1: Installation for more on encrypting the home folder.

Private folder

If you have not chosen to encrypt a user’s entire home folder, it is possible
to encrypt a single folder—called Private—in a user’s home folder. To do
this, follow these steps:

1. Install the ecryptfs-utils software package from the Ubuntu Software
Center. (For more information about the Software Center, review Using
the Ubuntu Software Center.)

2. Use the terminal to run ecryptfs-setup-private to set up the private
folder.

3. Enter your account’s password when prompted.

4. Either choose a mount passphrase or generate one.

5. Record both passphrases in a safe location. These are required if you ever
have to recover your data manually.

6. Log out and log back in to mount the encrypted folder.

After the Private folder has been set up, any files or folders in it will
automatically be encrypted.

If you need to recover your encrypted files manually see https://help.
ubuntu.com/community/EncryptedPrivateDirectory.
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7 Troubleshooting

Resolving problems

Sometimes, things may not work as they should. Luckily, problems that
are encountered while working with Ubuntu are often easily fixed. Below,
we offer a guide for resolving the basic problems that users may encounter
while using Ubuntu. If you need any additional help beyond what this
chapter provides, take a look at other support options that are discussed in
Finding additional help and support later in this book.

Troubleshooting guide

The key to an effective troubleshooting is to work slowly, complete all

of troubleshooting steps, and to document the changes that you make to
Ubuntu. This way, you will be able to undo your work, or give fellow users
the information about your previous attempts in cases when you need to
turn to the community for support.

Ubuntu Ffails to start after I've installed Windows

Occasionally you may install Ubuntu and then decide to install Microsoft
Windows as a second operating system running side-by-side with Ubuntu.
This is supported by Ubuntu, but you might also find that after installing
Windows you will no longer be able to start Ubuntu.

When you first turn on your computer, a “bootloader” must start Ubuntu

or another operating system. When you installed Ubuntu, you installed an A bootloader is the initial software that loads
advanced bootloader called Grus which allows you to choose between the the 09?3“"9 system when you switch on the
compucer.

various operating systems on your computer, such as Ubuntu, Windows,
Solaris or Mac OS X. However, when you installed Windows, it replaced the
GRUB with its own bootloader, thus removing the ability to choose which
operating system you’d like to use. You can restore GRUB and regain the
ability to choose your operating system by using the same cD you used to
install Ubuntu.

First, insert your Ubuntu cp into your computer and then restart it,
making sure to have your computer start from the cp (see Chapter 1: Instal-
lation). Next, choose your language (e.g., English) and select Try Ubuntu.
Once Ubuntu starts, click on the top-most icon in the launcher (the Dash
icon). Then, search for Terminal using the search box and then select Ter-
minal in the search results. A window should open with a blinking prompt
line. Enter the following, and press Enter:

$ sudo fdisk -1

Disk /dev/hda: 120.0 GB, 120034123776 bytes
255 heads, 63 sectors/track, 14593 cylinders
Units = cylinders of 16065 * 512 = 8225280 bytes

Device Boot Start End Blocks Id System
/dev/sdal 1 1224 64228+ 83 Linux
/dev/sda2 * 1225 2440 9767520 a5 Windows
/dev/sda3 2441 14593 97618972+ 5 Extended

/dev/sda4 14532 14593 498015 82 Linux swap
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Partition table entries are not in disk order

This output shows that your system (Linux, on which Ubuntu is based)
is installed on device /dev/sda1, but your computer is booting to /dev/sdaz
(where Windows is located). We need to fix this by telling the computer to
boot to the Linux device instead.

To do this, first create a place to connect your existing existing Ubuntu
installation with your temporary troubleshooting session:

$ sudo mkdir /media/root

Next, link your Ubuntu installation and this new folder:

$ sudo mount /dev/sdal /media/root

If you’ve done this correctly, then you should see the following:

$ 1s /media/root

bin dev home 1lib mnt root srv usr

boot etc initrd 1ib64 opt sbin sys var

cdrom initrd.img media proc selinux tmp vmlinuz

Now, you can reinstall GRUB:

$ sudo grub-install --root-directory=/media/root /dev/sda
Installation finished. No error reported.

This is the contents of the device map /boot/grub/device.map.
Check if this is correct or not. If any of the lines is incorrect,
fix it and re-run the script grub-install.

(hd0) /dev/sda

Finally, remove the Ubuntu disc from your cp-rom drive, reboot your
computer, and then start enjoying your Ubuntu operating system once
again.

This guide may not work for all Ubuntu users due to differences in the
various system configuration. Still, this is the recommended and most
successful method for restoring the GRUB bootloader. If you are following
this guide and if it does not restore GRUB on your computer, then try the
other troubleshooting methods at https://help.ubuntu.com/community/
RecoveringUbuntuAfterInstallingWindows.

Ubuntu doesn’t present the login screen when my computer boots

The simplest and easiest way to correct this issue is to reset the graphics
configuration. Press and hold Ctrl+Alt+F1. You should now see a black and
white screen with a prompt for your username and password.

Enter your username, and press Enter. Then, enter your password and
press Enter. Next, enter the following commands, pressing Enter after each
line. You will be asked for your password again.

sudo cd /etc/X11

sudo mv ./xorg.conf ./xorg.conf_old
sudo service gdm stop

sudo X -configure

sudo mv ./xorg.conf.new ./xorg.conf
sudo reboot now

H A A A A

Now Ubuntu will reboot, and your login screen should be restored.

The device (/dev/sda1, /dev/sda2, etc) we are
looking for is identified by the word “Linux” in
the System column. Modify the instructions
below if necessary, replacing /dev/sda1 with
the name of your Linux device.

(Characters will not appear on the screen as you
enter your password. This behavior is normal
and was implemented for security purposes).
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| fForgot my password

If you forget your password in Ubuntu, you will need to reset it using the
“Recovery mode.”

To start the Recovery mode, shut down your computer and then start
again. As the computer starts up, press Shift. Select the Recovery mode
option using the arrow keys on your keyboard. Recovery mode should be
the second item in the list.

Figure 7.1: This is the grub screen in which you
can choose recovery mode.

Wait until Ubuntu starts up—this may take a few minutes. Once booted,
you will not be able to see a normal login screen. Instead, you will be pre-
sented with the Recovery Menu. Select root using the arrow keys and press
Enter.

You will now be at a terminal prompt:

root@ubuntu:~#
To reset your password, enter:
# passwd username

Replace “username” above with your username, after which Ubuntu will
prompt you for a new password. Enter your desired password and press the
Enter key and then re-type your password again, and press Enter. (Ubuntu
asks for your password twice to make sure you did not make a mistake
while typing). Once you have restored your password, return to the normal
system environment by entering:

# init 2

Login as usual and continue enjoying Ubuntu.

I accidentally deleted some Files that | need

If you’ve deleted a file by accident, you may be able to recover it from
Ubuntu’s trash folder. This is a special folder where Ubuntu stores deleted
files before they are permanently removed from your computer.

To access the trash folder click on the Trash icon at the bottom of the
Unity Launcher.

If you want to restore deleted items from the trash:

1. Open Trash

2. Click on each item you want to restore to select it. Press and hold Ctrl
to select multiple items.

3. Click Restore Selected Items to move the deleted items back to their
original locations.

How do I clean Ubuntu?

Over time, Ubuntu’s software packaging system can accumulate unused
packages and temporary files. These temporary files, also called caches,
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contain files from all of the packages that you have installed. Over time this
cache can grow quite large. Cleaning out the cache allows you to reclaim
space on your computer’s hard drive for storing your documents, music,
photographs, or other files.

To clear the cache, you can either use the clean, or the autoclean option
for the command-line program apt-get.

To run clean, open Terminal and enter:
$ sudo apt-get clean

Packages can also become unused over time. If a package was installed to
assist with running another program—and that program was subsequently
removed you no longer need the supporting package. You can remove it
with apt-get autoremove.

Load Terminal and enter:

$ sudo apt-get autoremove

I can't play certain audio or video files

Many of the formats used to deliver rich media content are proprietary,
meaning they are not free to use, modify, or distribute with an open-source
operating system like Ubuntu. Therefore, Ubuntu does not include the ca-
pability to use these formats by default; however, users can easily configure
Ubuntu to use these proprietary formats. For more information about the
differences between open source and proprietary software, see Chapter 8:
Learning More.

If you find yourself in need of a proprietary format, you may install
the files necessary for using this format from the Ubuntu Software Center.
Ensure that you have Universe and Multiverse repositories enabled before
continuing. See the Software Sources section to learn how to do this. When
you are ready to continue, install the necessary software as follows:

1. Open the Ubuntu Software Center by searching for it from the Dash (the
top-most button on the Launcher).

2. Search for ubuntu-restricted-extras by typing “Ubuntu restricted
extras” in the search box on the right-hand side of the Ubuntu Software
Center main window. When the Software Center finds the appropriate
software, click the arrow next to its title.

3. Click Install, then wait while Ubuntu installs the software.

One program that can play many of these formats is VLC media player.
It can be installed from the Ubuntu Software Center. Once Ubuntu has
successfully installed this software, your rich media content should work

properly.

How can | change my screen resolution?

The image on every monitor is composed of millions of little colored dots
called pixels. Changing the number of pixels displayed on your monitor is
called “changing the resolution” Increasing the resolution will make the
displayed images sharper, but will also tend to make them smaller. The
opposite is true when screen resolution is decreased. Most monitors have

a “native resolution,” which is a resolution that most closely matches the
number of pixels in the monitor. Your display will usually be sharpest when

The clean command will remove every

single cached item, while the autoclean
command only removes cached items that can
no longer be downloaded (these items are
often unnecessary).
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your operating system uses a resolution that matches your display’s native
resolution.

The Ubuntu configuration utility Displays allows users to change the
resolution. Open it by clicking on the session indicator and then on Dis-
plays.... The resolution can be changed using the drop-down list within
the program. Picking options higher up on the list (for example, those with
larger numbers) will increase the resolution.

Figure 7.2: You can change your display
Monitor: Goldstar Company Ltd 19" settings_
Resolution: | 1024 x 768 (4:3)
[Goldstar Company Ltd 19" Refreshrate: | 75Hz
Rotation: Normal

Detect monitors

Panel icon
Show monitors in panel

Make Default Apply Close

You can experiment with various resolutions by clicking Apply at the
bottom of the window until you find one that is comfortable for you. Typ-
ically the highest resolution will be the native resolution. Selecting a res-
olution and clicking Apply will temporarily change the screen resolution
to the selected value and a dialog box will also be displayed. It allows you
to revert to the previous resolution setting or keep the new resolution. The
dialog box will disappear in 30 seconds, restoring the old resolution.

Figure 7.3: You can revert back to your old
@ Does the display look OK? settings if you need to.

The display will be reset to its
previous configuration in 22 seconds

Restore Previous Configuration Keep This Configuration

This feature was implemented to prevent someone from being locked
out of the computer by a resolution that distorts the monitor and makes it
unusable. When you have finished setting the screen resolution, click Close.

Ubuntu is not working properly on my Apple MacBook or MacBook Pro

When installed on notebook computers from Apple—such as the MacBook
or MacBook Pro—Ubuntu does not always enable all of the computer’s
built-in components, including the iSight camera and the Airport wireless
Internet adapter. Luckily, the Ubuntu community offers documentation

on fixing these and other problems. If you are having trouble installing or
using Ubuntu on your Apple notebook computer, please follow the instruc-
tions at https://help.ubuntu.com/community/MacBook. You can select the
appropriate guide after identifying your computer’s model number. For
instructions on doing this, visit the web page above.

Ubuntu is not working properly on my Asus EeePC

When installed on netbook computers from Asus—such as the EeePC—
Ubuntu does not always enable all of the computer’s built-in components,
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including the keyboard shortcut keys and the wireless Internet adapter.
The Ubuntu community offers documentation on enabling these com-
ponents and fixing other problems. If you are having trouble installing
or using Ubuntu on your Asus EeePC, please follow the instructions at
https://help.ubuntu.com/community/EeePC. This documentation page con-
tains information pertaining specifically to EeePC netbooks.

To enable many of the features and Function Keys, a quick fix is to add
‘acpi_osi=Linux’ to your grub configuration. From the Terminal

$ gksudo gedit /etc/default/grub
and very carefully change the line
GRUB_CMDLINE LINUX DEFAULT="quiet splash"
to
GRUB_CMDLINE_LINUX DEFAULT="quiet splash acpi_osi=Linux"
Save and close the file. Then, from the terminal:
sudo update-grub

After the command finishes, and you restart the computer, you will be able
to use the Fn Keys normally.

My hardware is not working properly

Ubuntu occasionally has difficulties running on certain computers, gen-
erally when hardware manufacturers use non-standard or proprietary
components. The Ubuntu community offers documentation to help you
troubleshoot many common issues that may arise from this situation, in-
cluding problems with wireless cards, scanners, mouse and printers. You
can find the complete hardware troubleshooting guide on Ubuntu’s sup-
port wiki, accessible at https://wiki.ubuntu.com/HardwareSupport. If your
hardware problems persist, please see Getting more help for more trou-
bleshooting options or information on obtaining support or assistance from
an Ubuntu user.

Getting more help

This guide does not cover every possible workflow, task or issue in Ubuntu.
If you require assistance beyond the information in the manual, you can
find a variety of support opportunities online.

More details about many support options available to you can be found
at Finding additional help and support later in this book.
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8 Learning More

What else can | do with Ubuntu?

By now, you should be able to use Ubuntu for most of your daily activities

—such as browsing the web, sending email, and creating documents. But
you may be interested in learning about other versions of Ubuntu you
can integrate into your digital lifestyle. In this chapter, we’ll introduce
you to additional versions of Ubuntu specialized for certain tasks. We’ll
also provide you with resources for answering any remaining questions
you may have, and tell you how you can get involved in the worldwide
community of Ubuntu users. But first, we’ll discuss the technologies that
make Ubuntu a powerful collection of software.

Open source software

Ubuntu is open source software. Open source software differs from pro-
prietary software—software whose source code is not freely available for
modification or distribution by anyone but the rightsholder. Microsoft
Windows and Adobe Photoshop are examples of proprietary software.

Unlike proprietary software applications, the software included with
Ubuntu is specifically licensed to promote sharing and collaboration. The
legal rules governing Ubuntu’s production and distribution ensure that
anyone can obtain, run, or share it for any purpose she or he wishes.
Computer users can modify open source software like Ubuntu to suit
their individual needs, to share it, to improve it, or to translate it into
other languages—provided they release the source code for these mod-
ifications so others can do the same. In fact, the terms of many open
source licensing agreements actually make it illegal not to do so. For
more information regarding Ubuntu’s software licensing standards, see
http://www.ubuntu.com/project/about-ubuntu/licensing.

Because open source software is developed by large communities of
programmers distributed throughout the globe, it benefits from rapid de-
velopment cycles and speedy security releases (in the event that someone
discovers bugs in the software). In other words, open source software is
updated, enhanced, and made more secure every day as programmers all
over the world continue to improve it.

Aside from these technical advantages, open source software also has

economic benefits. While users must adhere to the terms of an open source

licensing agreement when installing and using Ubuntu, they needn’t pay
to obtain this license. And while not all open source software is free of
monetary costs, much is.

To learn more about open source software, see the Open Source Initia-

tive’s open source definition, available at http://www.opensource.org/docs/

definition.php.

Distribution families

Ubuntu is one of several popular operating systems based on Linux (an
open source operating system). These Linux-based operating systems—

The source code of a program is the collection
of files that have been written in a computer
language to make the program.

Proprietary software is software that cannot be
copied, modified, or distributed freely.
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called Linux “distributions,”—may look different from Ubuntu at first glance,
but they share similar characteristics because of their common roots.

Linux distributions can be divided into two broad families: the Debian
family and the Red Hat family. Each family is named for a distribution on
which subsequent distributions are based. For example, “Debian” refers
to both the name of a Linux distribution as well as the family of distribu-
tions derived from Debian. Ubuntu is part of this family. When describing
relationships between various open source projects, software developers
often use the metaphor of tributaries connecting to a common body of
water. For this reason, you may hear someone say that Ubuntu is located
“downstream” from Debian, because alterations to Debian flow into new
versions of Ubuntu. Additionally, improvements to Ubuntu usually trickle
“upstream”—back to Debian and its family members. Other distributions
in the Debian family include Linux Mint, Xandros, and CrunchBang Linux.
Distributions in the Red Hat family include Fedora, openSUSE, and Man-
driva.

The most significant difference between Debian-based and Red Hat-
based distributions is the system each uses for installing and updating
software. These systems are called “package management systems” Debian
software packages are DEB files, while Red Hat software packages are RPM
files. The two systems are generally incompatible. For more information
about package management, see Chapter 5: Software Management.

You will also find Linux distributions that have been specialized for
certain tasks. Next, we’ll describe these versions of Ubuntu and explain the
uses for which each has been developed.

Choosing amongst Ubuntu and its derivatives

Just as Ubuntu is based on Debian, several distributions are subsequently
based on Ubuntu. Each differs with respect to the software included as part
of the distribution. Some are developed for general use, while others are
designed for accomplishing a more narrow set of tasks.

Alternative interfaces

Ubuntu features a graphical user interface (Gur) based on the open source
GNOME desktop. As we explained in Chapter 2: The Ubuntu Desktop, a
“user interface” is a collection of software elements—icons, colors, windows,
themes, and menus—that determines how someone may interact with a
computer. Some users prefer using alternatives to GNOME, so they have
created Ubuntu distributions featuring different user interfaces. These
include:

» Kubuntu, which uses the kDE graphical environment instead of the
GNOME environment found in Ubuntu;

» Lubuntu, which uses the LXDE graphical environment instead of the
GNOME environment found in Ubuntu; and

» Xubuntu, which uses the XFcE graphical environment instead of the
GNOME environment found in Ubuntu.

Additionally, each of these distributions may contain default applications
different from those featured in Ubuntu. For instance, the default music
player in Ubuntu is Banshee, but in Lubuntu the default music player is
Aqualung, and in Kubuntu the default is Amarok. Be sure to investigate

A distribution, or “distro,” is an operating
system made from open source applications,
which are bundled together to make them
easier to install and use.

Package management systems are the means by
which users can install, remove, and organize
software installed on computers with open
source operating systems like Ubuntu.



these differences if you are considering installing an Ubuntu distribution
with an alternative desktop environment.

For more information about these and other derivative distributions, see
http://www.ubuntu.com/project/derivatives.

Task-specific distributions

Other Ubuntu distributions have been created to accomplish specific tasks
or run in specialized settings.

Ubuntu Server Edition

The Ubuntu Server Edition is an operating system optimized to perform
multi-user tasks when installed on servers. Such tasks include file shar-
ing and website or email hosting. If you are planning to use a computer
to perform tasks like these, you may wish to use this specialized server

distribution in conjunction with server hardware.

This manual does not explain the process of running a secure web server
or performing other tasks possible with Ubuntu Server Edition. For details
on using Ubuntu Server Edition, refer to the manual at http://www.ubuntu.
com/business/server/overview.

Edubuntu

Edubuntu is an Ubuntu derivative customized for use in schools and other
educational institutions. It contains software similar to that offered in
Ubuntu, but also features additional applications—like a collaborative text
editor and educational games.

For additional information regarding Edubuntu, visit http://www.
edubuntu.org/

Ubuntu Studio

This derivative of Ubuntu is designed specifically for people who use com-
puters to create and edit multimedia projects. It features applications to
help users manipulate images, compose music, and edit video. While users
can install these applications on computers running the desktop version of
Ubuntu, Ubuntu Studio makes them all available immediately upon installa-
tion.

If you would like to learn more about Ubuntu Studio (or obtain a copy
for yourself), visit http://ubuntustudio.org/home.

Mythbuntu

Mythbuntu allows users to turn their computers into entertainment sys-
tems. It helps users organize and view various types of multimedia content
such as movies, television shows, and video podcasts. Users with Tv tuners
in their computers can also use Mythbuntu to record live video and televi-
sion shows.

To learn more about Mythbuntu, visit http://www.mythbuntu.org/.

Finding additional help and support

This guide cannot possibly contain everything you’ll ever need to know
about Ubuntu. Because Getting Started with Ubuntu 11.10 could never an-
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A server is a computer that’s been configured to
manage, or “serve,” files many people wish to
access.
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swer all your questions, we encourage you to take advantage of Ubuntu’s
vast community when seeking further information, troubleshooting tech-
nical issues, or asking questions about your computer. Next, we’ll discuss a
few of these resources so you can learn more about Ubuntu or other Linux
distributions.

Live chat

If you are familiar with Internet relay chat (1rc), you can use chat clients
such as XChat or Pidgin to join the channel #ubuntu on irc.freenode.net.
Here, hundreds of volunteer users can answer your questions or offer sup-
port in real time.

LoCo teams

Within the Ubuntu community are dozens of local user groups called “LoCo
teams”. Spread throughout the world, these teams offer support and advice,
answer questions and promote Ubuntu in their communities by hosting
regular events. To locate and contact the LoCo team nearest you, visit
http://loco.ubuntu.com/.

Official Ubuntu Documentation

The Ubuntu Documentation team maintains a series of official wiki pages In addition to official Ubuntu and community
designed to assist both new and experienced users wishing to learn more help, you will often find third-party help avail-
b Ubuntu. The Ubunt it d th d t hich able on the Internet. While these documents

about Ubuntu. The Ubuntu community endorses these documents, whic can often seem like great resources, some
serve as a reliable first point of reference for users seeking help online. You could be misleading or outdated. It's always
can access these at http://help.ubuntu.com. To get to the built-in Ubuntu best to verify information from third-party

sources before taking their advice. When possi-
ble, rely on official Ubuntu documentation for
assistance with Ubuntu.

Desktop Guide, press F1 on your desktop, or type yelp in the Dash.

The Ubuntu Forums

The Ubuntu Forums are the official forums of the Ubuntu community. Mil-
lions of Ubuntu users use them daily to seek help and support from one
another. You can create an Ubuntu Forums account in minutes. To create
an account and learn more about Ubuntu from community members, visit
http://ubuntuforums.org.

Launchpad Answers

Launchpad, an open source code repository and user community, provides a
question and answer service that allows anyone to ask questions about any
Ubuntu-related topic. Signing up for a Launchpad account requires only

a few minutes. Ask a question by visiting Launchpad at https://answers.
launchpad.net/ubuntu/+addquestion.

Ask Ubuntu

Ask Ubuntu is a free community driven Question and Answer website for
Ubuntu users and developers. It is part of the Stack Exchange network of
websites. This is one of the best Ubuntu support resources available for free.
Visit http://www.askubuntu.com to get started.
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Search Engines

Because Ubuntu is a popular open source operating system, many users
have written about it online. Therefore, using search engines to locate
answers to your questions about Ubuntu is often an effective means of
acquiring help. When using search engines to answer questions about
Ubuntu, ensure that your search queries are as specific as possible. In other
words, a search for “Unity interface” will return results that are less useful
than those associated with the query “how to use Ubuntu Unity interface”
or “how to customize Ubuntu Unity interface.”

Community support

If you’ve exhausted all these resources and still can’t find answers to your
questions, visit Community Support at http://www.ubuntu.com/support/
community.

The Ubuntu community

Surrounding Ubuntu is a global community of passionate users who want to
help others adopt, use, understand, and even modify or enhance Ubuntu. By
choosing to install and run Ubuntu, you’ve become part of this community.
As you learn more about Ubuntu, you may wish to collaborate with others
to make it better—to discuss the future of Ubuntu, to report software bugs
you discover, to promote Ubuntu to new users, to share Ubuntu advice,

or to answer other users’ questions. In this section, we’ll discuss a few
community projects that can connect you to other Ubuntu users.

Full Circle Magazine

Full Circle Magazine is “the independent magazine for the Ubuntu Linux
community.” Released every month, Full Circle Magazine contains reviews
of new software (including games) for Ubuntu, step-by-step tutorials for
projects you can undertake with Ubuntu, editorials discussing important
issues in the Ubuntu community, and Ubuntu tips from other users. You can
download issues of Full Circle Magazine at http://fullcirclemagazine.org/.

The Ubuntu UK Podcast

Produced by members of the UK’s Ubuntu LoCo team, this bi-weekly online
audio broadcast (or “podcast”) features lively discussion about Ubuntu, and
often includes interviews with Ubuntu community members who work to
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improve Ubuntu. Episodes are available at http://podcast.ubuntu-uk.org/. A podcast is a radio-style broadcast available as
an audio file for download to computers and

portable media players.

OMG! Ubuntu!

OMG! Ubuntu! is a weblog that aims to inform the Ubuntu community
about Ubuntu news, events, announcements, and updates in a timely fash-
ion. It also allows Ubuntu users to discuss ways they can promote or share
Ubuntu. You can read this blog or subscribe to it at http://www.omgubuntu.
co.uk/.
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Contributing to this manual

You can also participate in the Ubuntu community by contributing to this
manual. You might choose to write new content for it, edit its chapters

so they are easier for new Ubuntu users to understand and use, or trans-
late it in your own language. You may also provide the screenshots found
throughout the manual. To get involved in the Ubuntu Manual Project, visit
http://ubuntu-manual.org/getinvolved.


http://ubuntu-manual.org/getinvolved

A

License

Creative Commons Attribution-ShareAlike 3.0 Legal Code

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS
CREATIVE COMMONS PUBLIC LICENSE (“CCPL” OR “LICENSE”). THE WORK IS
PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF THE
WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE OR COPYRIGHT LAW
IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT
AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. TO THE EXTENT
THIS LICENSE MAY BE CONSIDERED TO BE A CONTRACT, THE LICENSOR GRANTS
YOU THE RIGHTS CONTAINED HERE IN CONSIDERATION OF YOUR ACCEPTANCE
OF SUCH TERMS AND CONDITIONS.

1. Definitions

(@)

(b)

(d)

“Adaptation” means a work based upon the Work, or upon the Work
and other pre-existing works, such as a translation, adaptation,
derivative work, arrangement of music or other alterations of a lit-
erary or artistic work, or phonogram or performance and includes
cinematographic adaptations or any other form in which the Work
may be recast, transformed, or adapted including in any form recog-
nizably derived from the original, except that a work that constitutes
a Collection will not be considered an Adaptation for the purpose of
this License. For the avoidance of doubt, where the Work is a musical
work, performance or phonogram, the synchronization of the Work in
timed-relation with a moving image (“synching”) will be considered
an Adaptation for the purpose of this License.

“Collection” means a collection of literary or artistic works, such

as encyclopedias and anthologies, or performances, phonograms

or broadcasts, or other works or subject matter other than works
listed in Section 1(f) below, which, by reason of the selection and
arrangement of their contents, constitute intellectual creations, in
which the Work is included in its entirety in unmodified form along
with one or more other contributions, each constituting separate and
independent works in themselves, which together are assembled into
a collective whole. A work that constitutes a Collection will not be
considered an Adaptation (as defined below) for the purposes of this
License.

“Creative Commons Compatible License” means a license that is
listed at http://creativecommons.org/compatiblelicenses that has been
approved by Creative Commons as being essentially equivalent to this
License, including, at a minimum, because that license: (i) contains
terms that have the same purpose, meaning and effect as the License
Elements of this License; and, (ii) explicitly permits the relicensing

of adaptations of works made available under that license under this
License or a Creative Commons jurisdiction license with the same
License Elements as this License.

“Distribute” means to make available to the public the original and
copies of the Work or Adaptation, as appropriate, through sale or
other transfer of ownership.


http://creativecommons.org/compatiblelicenses
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“License Elements” means the following high-level license attributes
as selected by Licensor and indicated in the title of this License: Attri-
bution, ShareAlike.

“Licensor” means the individual, individuals, entity or entities that
offer(s) the Work under the terms of this License.

“Original Author” means, in the case of a literary or artistic work, the
individual, individuals, entity or entities who created the Work or if
no individual or entity can be identified, the publisher; and in addition
(i) in the case of a performance the actors, singers, musicians, dancers,
and other persons who act, sing, deliver, declaim, play in, interpret or
otherwise perform literary or artistic works or expressions of folklore;
(ii) in the case of a phonogram the producer being the person or legal
entity who first fixes the sounds of a performance or other sounds;
and, (iii) in the case of broadcasts, the organization that transmits the
broadcast.

“Work” means the literary and/or artistic work offered under the
terms of this License including without limitation any production

in the literary, scientific and artistic domain, whatever may be the
mode or form of its expression including digital form, such as a book,
pamphlet and other writing; a lecture, address, sermon or other work
of the same nature; a dramatic or dramatico-musical work; a choreo-
graphic work or entertainment in dumb show; a musical composition
with or without words; a cinematographic work to which are assim-
ilated works expressed by a process analogous to cinematography;

a work of drawing, painting, architecture, sculpture, engraving or
lithography; a photographic work to which are assimilated works ex-
pressed by a process analogous to photography; a work of applied art;
an illustration, map, plan, sketch or three-dimensional work relative
to geography, topography, architecture or science; a performance; a
broadcast; a phonogram; a compilation of data to the extent it is pro-
tected as a copyrightable work; or a work performed by a variety or
circus performer to the extent it is not otherwise considered a literary
or artistic work.

“You” means an individual or entity exercising rights under this Li-
cense who has not previously violated the terms of this License with
respect to the Work, or who has received express permission from
the Licensor to exercise rights under this License despite a previous
violation.

“Publicly Perform” means to perform public recitations of the Work
and to communicate to the public those public recitations, by any
means or process, including by wire or wireless means or public
digital performances; to make available to the public Works in such a
way that members of the public may access these Works from a place
and at a place individually chosen by them; to perform the Work to
the public by any means or process and the communication to the
public of the performances of the Work, including by public digital
performance; to broadcast and rebroadcast the Work by any means
including signs, sounds or images.

“Reproduce” means to make copies of the Work by any means includ-
ing without limitation by sound or visual recordings and the right

of fixation and reproducing fixations of the Work, including storage
of a protected performance or phonogram in digital form or other
electronic medium.
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2. Fair Dealing Rights. Nothing in this License is intended to reduce, limit,
or restrict any uses free from copyright or rights arising from limitations
or exceptions that are provided for in connection with the copyright
protection under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licen-
sor hereby grants You a worldwide, royalty-free, non-exclusive, perpet-
ual (for the duration of the applicable copyright) license to exercise the
rights in the Work as stated below:

(@)

(b)

(©)

(d)
(e

to Reproduce the Work, to incorporate the Work into one or more

Collections, and to Reproduce the Work as incorporated in the Collec-

tions;

to create and Reproduce Adaptations provided that any such Adap-

tation, including any translation in any medium, takes reasonable

steps to clearly label, demarcate or otherwise identify that changes
were made to the original Work. For example, a translation could be
marked “The original work was translated from English to Spanish,”
or a modification could indicate “The original work has been modi-
fied”;

to Distribute and Publicly Perform the Work including as incorpo-

rated in Collections; and,

to Distribute and Publicly Perform Adaptations.

For the avoidance of doubt:

i. Non-waivable Compulsory License Schemes. In those jurisdictions
in which the right to collect royalties through any statutory or
compulsory licensing scheme cannot be waived, the Licensor re-
serves the exclusive right to collect such royalties for any exercise
by You of the rights granted under this License;

ii. Waivable Compulsory License Schemes. In those jurisdictions
in which the right to collect royalties through any statutory or
compulsory licensing scheme can be waived, the Licensor waives
the exclusive right to collect such royalties for any exercise by You
of the rights granted under this License; and,

iii. Voluntary License Schemes. The Licensor waives the right to col-
lect royalties, whether individually or, in the event that the Licen-
sor is a member of a collecting society that administers voluntary
licensing schemes, via that society, from any exercise by You of the
rights granted under this License.

The above rights may be exercised in all media and formats whether

now known or hereafter devised. The above rights include the right to

make such modifications as are technically necessary to exercise the
rights in other media and formats. Subject to Section &(f), all rights
not expressly granted by Licensor are hereby reserved.

4. Restrictions. The license granted in Section 3 above is expressly made
subject to and limited by the following restrictions:

(@)

You may Distribute or Publicly Perform the Work only under the
terms of this License. You must include a copy of, or the Uniform Re-
source Identifier (URI) for, this License with every copy of the Work
You Distribute or Publicly Perform. You may not offer or impose any
terms on the Work that restrict the terms of this License or the abil-
ity of the recipient of the Work to exercise the rights granted to that
recipient under the terms of the License. You may not sublicense the
Work. You must keep intact all notices that refer to this License and
to the disclaimer of warranties with every copy of the Work You Dis-
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(b)
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tribute or Publicly Perform. When You Distribute or Publicly Perform
the Work, You may not impose any effective technological measures
on the Work that restrict the ability of a recipient of the Work from
You to exercise the rights granted to that recipient under the terms

of the License. This Section 4(a) applies to the Work as incorporated
in a Collection, but this does not require the Collection apart from
the Work itself to be made subject to the terms of this License. If You
create a Collection, upon notice from any Licensor You must, to the
extent practicable, remove from the Collection any credit as required
by Section 4(c), as requested. If You create an Adaptation, upon notice
from any Licensor You must, to the extent practicable, remove from
the Adaptation any credit as required by Section 4(c), as requested.
You may Distribute or Publicly Perform an Adaptation only under the
terms of: (i) this License; (ii) a later version of this License with the
same License Elements as this License; (iii) a Creative Commons juris-
diction license (either this or a later license version) that contains the
same License Elements as this License (e.g., Attribution-ShareAlike
3.0 US)); (iv) a Creative Commons Compatible License. If you license
the Adaptation under one of the licenses mentioned in (iv), you must
comply with the terms of that license. If you license the Adaptation
under the terms of any of the licenses mentioned in (i), (ii) or (iii) (the
“Applicable License”), you must comply with the terms of the Ap-
plicable License generally and the following provisions: (I) You must
include a copy of, or the URI for, the Applicable License with every
copy of each Adaptation You Distribute or Publicly Perform; (II) You
may not offer or impose any terms on the Adaptation that restrict

the terms of the Applicable License or the ability of the recipient of
the Adaptation to exercise the rights granted to that recipient under
the terms of the Applicable License; (III) You must keep intact all
notices that refer to the Applicable License and to the disclaimer of
warranties with every copy of the Work as included in the Adapta-
tion You Distribute or Publicly Perform; (IV) when You Distribute or
Publicly Perform the Adaptation, You may not impose any effective
technological measures on the Adaptation that restrict the ability of a
recipient of the Adaptation from You to exercise the rights granted to
that recipient under the terms of the Applicable License. This Section
4(b) applies to the Adaptation as incorporated in a Collection, but this
does not require the Collection apart from the Adaptation itself to be
made subject to the terms of the Applicable License.

If You Distribute, or Publicly Perform the Work or any Adaptations
or Collections, You must, unless a request has been made pursuant

to Section 4(a), keep intact all copyright notices for the Work and
provide, reasonable to the medium or means You are utilizing: (i) the
name of the Original Author (or pseudonym, if applicable) if supplied,
and/or if the Original Author and/or Licensor designate another party
or parties (e.g., a sponsor institute, publishing entity, journal) for attri-
bution (“Attribution Parties”) in Licensor’s copyright notice, terms of
service or by other reasonable means, the name of such party or par-
ties; (ii) the title of the Work if supplied; (iii) to the extent reasonably
practicable, the URL, if any, that Licensor specifies to be associated
with the Work, unless such URI does not refer to the copyright no-
tice or licensing information for the Work; and (iv) , consistent with
Ssection 3(b), in the case of an Adaptation, a credit identifying the
use of the Work in the Adaptation (e.g., “French translation of the
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Work by Original Author,” or “Screenplay based on original Work

by Original Author”). The credit required by this Section 4(c) may be
implemented in any reasonable manner; provided, however, that in
the case of a Adaptation or Collection, at a minimum such credit will
appear, if a credit for all contributing authors of the Adaptation or
Collection appears, then as part of these credits and in a manner at
least as prominent as the credits for the other contributing authors.
For the avoidance of doubt, You may only use the credit required by
this Section for the purpose of attribution in the manner set out above
and, by exercising Your rights under this License, You may not im-
plicitly or explicitly assert or imply any connection with, sponsorship
or endorsement by the Original Author, Licensor and/or Attribution
Parties, as appropriate, of You or Your use of the Work, without the
separate, express prior written permission of the Original Author,
Licensor and/or Attribution Parties.

(d) Except as otherwise agreed in writing by the Licensor or as may be
otherwise permitted by applicable law, if You Reproduce, Distribute
or Publicly Perform the Work either by itself or as part of any Adap-
tations or Collections, You must not distort, mutilate, modify or take
other derogatory action in relation to the Work which would be prej-
udicial to the Original Author’s honor or reputation. Licensor agrees
that in those jurisdictions (e.g. Japan), in which any exercise of the
right granted in Section 3(b) of this License (the right to make Adap-
tations) would be deemed to be a distortion, mutilation, modification
or other derogatory action prejudicial to the Original Author’s honor
and reputation, the Licensor will waive or not assert, as appropriate,
this Section, to the fullest extent permitted by the applicable national
law, to enable You to reasonably exercise Your right under Section
3(b) of this License (right to make Adaptations) but not otherwise.

5. Representations, Warranties and Disclaimer
UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING,
LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND CONCERNING THE WORK, EXPRESS, IMPLIED,
STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WAR-
RANTIES OF TITLE, MERCHANTIBILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS, AC-
CURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR NOT
DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICA-
BLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL
THEORY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR
EXEMPLARY DAMAGES ARISING OUT OF THIS LICENSE OR THE USE OF THE
WORK, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

7. Termination

(a) This License and the rights granted hereunder will terminate automat-
ically upon any breach by You of the terms of this License. Individuals
or entities who have received Adaptations or Collections from You
under this License, however, will not have their licenses terminated
provided such individuals or entities remain in full compliance with
those licenses. Sections 1, 2, 5, 6, 7, and 8 will survive any termination
of this License.
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Subject to the above terms and conditions, the license granted here is
perpetual (for the duration of the applicable copyright in the Work).
Notwithstanding the above, Licensor reserves the right to release

the Work under different license terms or to stop distributing the
Work at any time; provided, however that any such election will not
serve to withdraw this License (or any other license that has been, or
is required to be, granted under the terms of this License), and this
License will continue in full force and effect unless terminated as
stated above.

8. Miscellaneous

(@)

(b)

(d)

(e)

(f)

Each time You Distribute or Publicly Perform the Work or a Collec-
tion, the Licensor offers to the recipient a license to the Work on the
same terms and conditions as the license granted to You under this
License.

Each time You Distribute or Publicly Perform an Adaptation, Licensor
offers to the recipient a license to the original Work on the same
terms and conditions as the license granted to You under this License.
If any provision of this License is invalid or unenforceable under
applicable law, it shall not affect the validity or enforceability of the
remainder of the terms of this License, and without further action

by the parties to this agreement, such provision shall be reformed

to the minimum extent necessary to make such provision valid and
enforceable.

No term or provision of this License shall be deemed waived and no
breach consented to unless such waiver or consent shall be in writing
and signed by the party to be charged with such waiver or consent.
This License constitutes the entire agreement between the parties
with respect to the Work licensed here. There are no understandings,
agreements or representations with respect to the Work not specified
here. Licensor shall not be bound by any additional provisions that
may appear in any communication from You. This License may not be
modified without the mutual written agreement of the Licensor and
You.

The rights granted under, and the subject matter referenced, in this
License were drafted utilizing the terminology of the Berne Conven-
tion for the Protection of Literary and Artistic Works (as amended on
September 28, 1979), the Rome Convention of 1961, the WIPO Copy-
right Treaty of 1996, the WIPO Performances and Phonograms Treaty
of 1996 and the Universal Copyright Convention (as revised on July
24, 1971). These rights and subject matter take effect in the relevant
jurisdiction in which the License terms are sought to be enforced
according to the corresponding provisions of the implementation of
those treaty provisions in the applicable national law. If the standard
suite of rights granted under applicable copyright law includes addi-
tional rights not granted under this License, such additional rights are
deemed to be included in the License; this License is not intended to
restrict the license of any rights under applicable law.

Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty
whatsoever in connection with the Work. Creative Commons will not be
liable to You or any party on any legal theory for any damages whatsoever,



including without limitation any general, special, incidental or consequen-
tial damages arising in connection to this license. Notwithstanding the
foregoing two (2) sentences, if Creative Commons has expressly identified
itself as the Licensor hereunder, it shall have all rights and obligations of
Licensor.

Except for the limited purpose of indicating to the public that the Work
is licensed under the CCPL, Creative Commons does not authorize the use
by either party of the trademark “Creative Commons” or any related trade-
mark or logo of Creative Commons without the prior written consent of
Creative Commons. Any permitted use will be in compliance with Creative
Commons’ then-current trademark usage guidelines, as may be published
on its website or otherwise made available upon request from time to time.
For the avoidance of doubt, this trademark restriction does not form part of
the License.

Creative Commons may be contacted at http://creativecommons.org/.
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Canonical Canonical, the financial backer of Ubuntu, provides support for
the core Ubuntu system. It has over 310 paid staff members worldwide
who ensure that the foundation of the operating system is stable, as well
as checking all the work submitted by volunteer contributors. To learn
more about Canonical, go to http://www.canonical.com.

cursor The (usually) blinking square or vertical line used to show you
where text will appear when you start typing. You can move it around
with the arrow keys on your keyboard prompt in a terminal or other
text-input application.

decrypted When you decrypt an encrypted file it becomes decrypted, and
viewable. Encrypted files on Ubuntu are not recognizable in any lan-
guage, they are just a string of random numbers and letters until they are
decrypted using a password.

desktop environment A generic term to describe a Gut interface for humans
to interact with computers. There are many desktop environments such
as GNOME, KDE, XFCE and LXDE just to name a few.

pHCP DHCP stands for Dynamic Host Configuration Protocol, it is used by a
DHCP server to assign computers on a network an 1p address automati-
cally.

dialup connection A dialup connection is when your computer uses a mo-
dem to connect to an 1sp through your telephone line.

distribution A distribution is a collection of software that is already com-
piled and configured ready to be installed. Ubuntu is an example of a
distribution.

dual-booting dual-booting is the process of being able to choose one of two
different operating systems currently installed on a computer from the
boot menu. Once selected your computer will then boot into whichever
operating system you chose at the boot menu. Dual booting is often used
generically, and may refer to booting among more than two operating
systems.

Ethernet port An Ethernet port is what an Ethernet cable is plugged into
when you are using a wired connection.

GNOME GNOME (which once stood for NU Network Object Model Environ-
ment) is the default desktop environment used in Ubuntu.

cur The Ggul (which stands for Graphical User Interface) is a type of user in-
terface that allows humans to interact with the computer using graphics
and images rather than just text.

1sp 1sp stands for Internet Service Provider, an 1sP is a company that provides
you with your Internet connection.

kernel A kernel is the central portion of a Unix-based operating system,
responsible for running applications, processes, and providing security
for the core components.
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maximize When you maximize an application in Ubuntu it will fill the
whole desktop, excluding the panels.

MeMenu The MeMenu in Ubuntu 11.10 allows you to manage your pres-
ence on social networking services. It also allows you to publish status
messages to all of your accounts by entering updates into a text field.

output The output of a command is any text it displays on the next line
after typing a command and pressing enter, e.g., if you type pwd into a
terminal and press Enter, the directory name it displays on the next line
is the output.

package Packages contain software in a ready-to-install format. Most of
the time you can use the Software Center instead of manually installing
packages. Packages have a .deb extension in Ubuntu.

parameter Parameters are special options that you can use with other
commands in the terminal to make that command behave differently, this
can make a lot of commands far more useful.

partition A partition is an area of allocated space on a hard drive where
you can put data.

partitioning partitioning is the process of creating a partition.

prompt The prompt displays some useful information about your computer,
it can be customized to display in different colors as well as being able to
display the time, date and current directory as well as almost anything
else you like.

proprietary Software made by companies that don’t release their source
code under an open source license.

router A router is a specially designed computer that using its software and
hardware, routes information from the Internet to a network. It is also
sometimes called a gateway.

server A server is a computer that runs a specialized operating system and
provides services to computers that connect to it and make a request.

shell The terminal gives access to the shell, when you type a command into
the terminal and press enter the shell takes that command and performs
the relevant action.

Software Center The Software Center is where you can easily manage soft-
ware installation and removal as well as the ability to manage software
installed via Personal Package Archives.

terminal The terminal is Ubuntu’s text only interface, it is a method of
controlling some aspects of the operating system using only commands
entered via the keyboard.

USB Universal Serial Bus is a standard interface specification for connect-
ing peripheral hardware devices to computers. USB devices range from
external hard drives to scanners and printers.

wired connection A wired connection is when your computer is physically
connected to a router or Ethernet port with a cable, this is the most
common connection for desktop computers.

wireless connection A network connection that uses a wireless signal to
communicate with either a router, access point, or computer.
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removing temporary files, 115

definition of, 7
derivatives, 120
downloading, 11
history of, 8
philosophy of, 7
server, 121
Ubuntu Promise, 8
Unity
overview, 22
Unix, 8, 9
USB, 94
users, see also groups
adding, 110
deleting, 110
modifying, 110

video
will not play, 116

volume, see sound

webcam, 93



COLOPHON
This book was typeset with XgiTEX.

The book design is based on the Tufte-ETEX document classes available at http://code.google.com/p/tufte-latex/.

The text face is Linux Libertine, designed by Philipp H. Poll. It is an open font available at http://linuxlibertine.sf.net/.

The captions and margin notes are set in Ubuntu, a font commissioned by Canonical and designed by Dalton Maag. It is freely
available for download at http://font.ubuntu.com/.

The terminal text and keystrokes are set in Bera Mono, originally developed by Bitstream, Inc. as Bitstream Vera.
The screenshots were captured using Quickshot, available at http://ubuntu-manual.org/quickshot.
The cover and title page pictograms contain shapes taken from the Humanity icon set, available at https://launchpad.net/humanity.

The title page and cover were designed using Inkscape, available at http://inkscape.org/.


http://code.google.com/p/tufte-latex/
http://linuxlibertine.sf.net/
http://font.ubuntu.com/
http://ubuntu-manual.org/quickshot
https://launchpad.net/humanity
http://inkscape.org/

	Title page
	Contents
	Prologue
	Welcome
	Ubuntu Philosophy
	A brief history of Ubuntu
	Is Ubuntu right for you?
	Contact details
	About the team
	Conventions used in this book

	Installation
	Getting Ubuntu
	The Live CD/USB stick
	Installing Ubuntu
	Ubuntu installer for Windows

	The Ubuntu Desktop
	Understanding the Ubuntu desktop
	Unity
	The Dash
	Browsing files on your computer
	Using Launcher
	Workspaces
	Managing windows
	Nautilus file manager
	Searching for files and folders on your computer
	Customizing your desktop
	Accessibility
	Session options
	Getting help

	Working with Ubuntu
	All the applications you need
	Getting online
	Browsing the web
	Reading and composing email
	Using instant messaging
	Microblogging
	Viewing and editing photos
	Watching videos and movies
	Listening to audio and music
	Burning CDs and DVDs
	Working with documents, spreadsheets, and presentations
	Ubuntu One
	Getting started with Ubuntu One
	Using Ubuntu One

	Hardware
	Using your devices
	Hardware identification
	Displays
	Connecting and using your printer
	Sound
	Using a webcam
	Scanning text and images
	Other devices

	Software Management
	Software management in Ubuntu
	Using the Ubuntu Software Center
	Managing additional software
	Manual software installation
	Updates and upgrades

	Advanced Topics
	Ubuntu for advanced users
	Introduction to the terminal
	Ubuntu file system structure
	Securing Ubuntu
	Why Ubuntu is safe
	Basic security concepts
	Users and groups
	System updates
	Firewall
	Encryption

	Troubleshooting
	Resolving problems
	Troubleshooting guide
	Getting more help

	Learning More
	What else can I do with Ubuntu?
	Open source software
	Distribution families
	Choosing amongst Ubuntu and its derivatives
	Finding additional help and support
	The Ubuntu community
	Contributing to this manual

	License
	Creative Commons Attribution–ShareAlike 3.0 Legal Code
	Creative Commons Notice

	Glossary
	Credits
	Team leads
	Authors
	Editors
	Designers
	Developers
	Translation editors
	Special thanks
	Past contributors

	Index
	Colophon

